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Foreword

The need: Trade policy and changes in trade policy be they unilateral, regional, or
multilateral through the World Trade Organisation are a key policy priority of
almost all governments. There are currently over 400 trade agreements between
countries and groups of countries notified to the WTO, and another 150-200 in the
process of being negotiated. 

Policy makers, analysts, academics, international organisations and journalists
need appropriate tools for analysing such changes in trade policy. Economists
have  sophisticated tools (computable general equilibrium modelling,
econometrics) for analysing the potential impact of such agreements, but these
tools are typically expensive, require highly skilled people to undertake the
analysis, work at a fairly aggregate level, and often make very heroic assumptions
of the underlying data. They are often unaffordable in cash terms and require very
highly expert ‘intelligent customers’ who are often in even shorter supply than
cash particularly, but not only, in developing countries.

The product has been developed with (hard pressed) desk officers in mind, is
much easier to use than existing tools, and has the additional tremendous
advantage in that it can be applied at a very detailed level of disaggregation. 

TradeSift is based on the intelligent use of diagnostic statistics / indicators of
trade, and trade related data (e.g., production, tariffs, non-tariff barriers, macro
data) which are firmly based on underlying economic theory). The diagnostics
feed into a wider framework of checklists of issues and ‘rules of thumb’ which
allow the relatively, rapid and consistent cost-benefit assessments of trade policy
options. It can be used ex ante to analyse and assess policy proposals and ex post
to examine how to maximise the gains and minimise the losses of any agreed
policy. 

The underlying economic ideas that are behind the TradeSift programme have
been presented at the World Bank, the WTO, the IMF, the OECD, UNCTAD, the
European Commission, DBIS and DFID. TradeSift also formed an integral part of a
recent World Bank training course on Regional Trading Agreements. 
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1 Introduction

This chapter gives you a quick overview of TradeSift, and explains how to use the Help.  There is

also a Quick Start Guide to explain the general concepts and workflow when using TradeSift.

 Introduction

TradeSift Overview

Using TradeSift Help

Quick Start Guide
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1.1 TradeSift Overview

Introduction

TradeSift is software, developed in part with UK government funding, which is designed to provide

analysis of trade, and trade policy, such as regional or bilateral trade agreements without requiring

sophisticated modelling or highly technically qualified economists. The ideas behind TradeSift have

been developed by Michael Gasiorek, Peter Holmes and Jim Rollo, who between them have over

100 years of experience in trade policy analysis.

Trade policy and changes in trade policy be they unilateral, regional, or multilateral through the

World Trade Organisation are a key policy priority of almost all governments. There are currently

over 400 trade agreements between countries and groups of countries notified to the WTO, and

another 150-200 in the process of being negotiated. 

Policy makers, analysts, academics, international organisations and journalists need appropriate

tools for analysing such changes in trade policy. Economists have  sophisticated tools (computable

general equilibrium modelling, econometrics) for analysing the potential impact of such

agreements, but these tools are typically expensive, require highly skilled people to undertake the

analysis, work at a fairly aggregate level, and often make very heroic assumptions of the underlying

data. They are often unaffordable in cash terms and require very highly expert ‘intelligent

customers’ who are often in even shorter supply than cash particularly, but not only, in developing

countries.

The product has been developed with (hard pressed) desk officers in mind, is much easier to use

than existing tools, and has the additional tremendous advantage in that it can be applied at a very

detailed level of disaggregation. 

TradeSift is based on the intelligent use of diagnostic statistics / indicators of trade, and trade

related data (e.g., production, tariffs, non-tariff barriers, macro data) which are firmly based on

underlying economic theory. The diagnostics feed into a wider framework of checklists of issues

and ‘rules of thumb’ which allow the relatively, rapid and consistent cost-benefit assessments of

trade policy options. It can be used ex ante to analyse and assess policy proposals and ex post to

examine how to maximise the gains and minimise the losses of any agreed policy. 

The underlying economic ideas that are behind the TradeSift program have been presented at the

World Bank, the WTO, the IMF, the OECD, UNCTAD, the European Commission, DBIS and DFID.

TradeSift also formed an integral part of a recent World Bank training course on Regional Trading

Agreements.

TradeSift is an advanced software tool that quickly helps you in making trade policy decisions. 

TradeSift will save you time by enabling you to easily analyse data and produce charts, tables, and

full reports.  You can load various types of data, including trade data, tariff data, and GDP data,

and then view, pivot and analyse the data, calculate indicators, and produce reports with graphical

output.

TradeSift Highlights

Advanced Software

TradeSift is a powerful software tool

developed to aid you in your trade

policy analysis. Designed by economists

and developed by software specialists. 

Save Time

For Trade Policy Specialists, TradeSift is

designed to save time spent on complex

calculations and analysis. For non-

specialists, it enhances computational and
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analytical power, at a relative cost saving. 

Graphs and Tables

TradeSift allows you to quickly and

easily view and pivot your data. You can

evaluate and graph your data, and

produce tables and charts. 

Indicators

TradeSift includes a full set of detailed

indicator calculations, which can be

calculated at any digit-level. Indicators

include intra-industry trade, trade

concentration and trade specialisation, to

name a few. 

Reference Data

TradeSift comes with additional

reference data, for example GDP data,

country lists, currencies, nomenclatures,

product code lists, concordances, etc. 

Report Writer

TradeSift includes an integrated report

writer. You can write a full report without

ever leaving the program, and charts or

tables you have produced in TradeSift can

simply be dropped on to your report page.

The reports can be saved in all common

document formats. 

Developing Countries

We originally developed TradeSift with

developing countries in mind, to build

on their capacity to analyse and

negotiate trade policy agreements. We

therefore offer a discount to developing

country and public-sector clients. 

Training

We can train your organisation in the use

of TradeSift, and provide consultancy

services. 



TradeSift User Manual18

© InterAnalysis Ltd. 2012

1.2 Using TradeSift Help

Using TradeSift Help

TradeSift provides help in the form of two manuals, the TradeSift User Manual (this manual), and

the TradeSift Conceptual Manual.  The User Manual provides help on how to use the program,

and details of all the program's screens and functions.  The Conceptual Manual describes the

economic theory behind the data and the indicators, and offers guidelines on which TradeSift

functions are appropriate for your analyses.

You can access the two help manuals in a number of ways:

Within the program

Click on the Help menu on the Main Menu bar, or use the shortcuts in the program's

Toolbar or the Navigator.  The selected help manual will open in a new window inside

TradeSift.  If you open both manuals, one window will display the User Manual, and another

window will display the Conceptual Manual.  Inside each window, the help has a standard

navigation panel on the left, with a table of contents, an index, and options for searching.

Anywhere in the program where you would like context-sensitive help relevant to the screen

that you are using:

Press F1 to get help from the User Manual.

Press F2 to get help from the Conceptual Manual.

As Windows Help

To open either of the help manuals in a separate window, go to Start Menu > TradeSift >

Help, and select the manual you want to view.

Contact Information

TradeSift Website

www.tradesift.com

TradeSift Forums

www.tradesift.com/forum

TradeSift Support

support@tradesift.com
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1.3 Quick Start Guide

TradeSift Workflow

To get you started working with TradeSift, this section describes the typical workflow and sequence

when using the program.  The general procedure for working with projects and data in TradeSift is

as follows.

1. Create a Project
Create a new empty Project.  

See the section on Creating Projects.

2. Load Data
Load the data that you want to work with into your Project, for example Trade Data or Tariff

Data.  

See the section on Loading Data.

You can Load Data from Files that you have downloaded from public data sources, or if you

have a Comtrade subscription, you can use TradeSift’s advanced feature to Load Data from

Comtrade directly into your Project by connecting to Comtrade via the internet.

3. View and Analyse Data
Use the program screens for viewing and analysing the data loaded into your Project.  

See the section on Viewing Data.

With your loaded data visible in a data grid, you can make full use of TradeSift’s functions for

analysing and viewing the data in different ways, using sorting, filtering, pivoting, top n functions,

change over time functions, etc.  See the section on Display Options where these functions are

described in detail.

4. Calculate Indicators
Using TradeSift’s suite of Indicators, you can use the data you have loaded as the input for

many calculations, and produce Indicator results which you can use for your analysis.

See the section on Calculating Indicators.

With the results of any Indicator calculation, you can also make full use of TradeSift’s functions

for pivoting and analysing the data, and produce charts and tables in the same way as with the

basic loaded data.

5. Create Charts
From the data screens, once you have arranged the data according to your requirements, you

can create complex Charts of the data.  

See the section on creating Creating Charts.

In the chart screen, there are advanced options for many different types of chart and chart

settings, using the Chart Options dialog.

6. Create Tables
From the data screen, you can also create Tables, with the data from the grid arranged in a

neat tabular format. 

See the section on Creating Tables.

In the table screen, there are many options for changing the format and the display of the table,

using the Table Options dialog.

7. Save Results
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In all of the screens where you produce output, for example Data screens, Indicators, Charts,

Tables, you can save any results that you find interesting, to be recalled later.  Items saved in

this way will be added to the Project Explorer.

See the sections on Saving Project Items and the Project Explorer.

8. Create Reports
Create a Report using TradeSift’s built-in Document writer, which is a fully featured document

editor.  Any Charts or Tables you have saved can be dragged and dropped on to the

document page.  The report will be saved inside the TradeSift project, but when it is finished

you can also export it to common Office document formats.

See the section on the Report Writer.

9. View Reference Data
Use TradeSift’s Reference Data section, to view standard static data on Countries, Country

Groups, Nomenclatures, Products, etc.

See the section on Reference Data.

10.  Print and Export
In all of the Data screens, Reference Data screens, Indicator outputs, Charts, Tables,

Documents, etc, you have full options for printing and exporting to other formats, such as

Word, Excel, PDF, etc.

See the section on Exporting & Printing Data.

11.  Add to you Project
The above steps describe the typical workflow in TradeSift, however once you have created

your Project and loaded some data to get started, you can move freely between all of these

steps in any order.  You can always return to load more data at any time, create and save new

Data Selections, add further Charts and Tables, edit your Documents, and create as many

documents as you like.

12.  Backup and Share
When your analysis is complete, you can export your final documents for distribution, or print

them from Tradesift.  To make a safety backup of your Project, or to share it with another

TradeSift user, take advantage of the program’s Packed Project feature.

See the section on Packed Projects.
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1.4 New Features in V2.0

TradeSift V2.0 has a number of new and improved features.  This section give you a quick

overview of the new features, with links to help topics in the manual which describe the features

in more detail.  Click on the bullet-points to read the detailed help for each new item.

Data

 Services Data - TradeSift can now work with Services Data.  You can load and analyse the data,

produce charts and tables, and even use the Services Data as the basis for Indicator

calculations.

Loading Services Data

Services Data Screen

Indicators Source Data

 WDI Data - World Development Indicators from the World Bank can be loaded and viewed

in TradeSift.  You can produce charts and tables from the data, and include the output in your

reports

Loading WDI Data

WDI Data Screen

Data Loading

 Data Loading Dialog - The buttons and menu items for loading data on the menu, navigator

and toolbar, have been reduced to a single data loading button, which displays a new Data

Loading Dialog, where you choose which type of data you want to load.

Data Loading Dialog

 Loading of Zip Files - All the data loading functions can load zip files which may contain

multiple data files.  The zip files will be automatically unzipped, and the files in the zip archive will

be loaded. 

Loading Data from Files

 Loading of Folders - When adding data files to load, you can also add complete folders and

sub-folders.

Loading Folders

 Loading Aggregate Products - Data files containing trade figures for broad product categories

(for example Wits standard product groups) can be loaded in to your projects.

Aggregate Products

Product Groups

 Custom Product Groups - A new function allows you to load your own Product Group

definitions into TradeSift via an external Excel or CSV file.

Loading Product Groups

 Product Group Totals - When viewing data by Product Group, you can choose to view summed

totals only for each Product Group, without the product breakdown.

Industry Selection

Charts
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 Second Y-Axis - A second Y-Axis on the right-hand side of the chart can be added, to show a

different scale for a second data field that has been plotted on the chart.

Data Fields

Y-Axis Options

 Annotations - You can add any number of text Annotations to charts to mark a significant

point on the chart.

Chart Annotations

 Chart Templates - All chart options and settings can be stored in Chart Templates, so that you

can save your preferred settings, and easily recall them for any chart.

Chart Templates

 Sorting Options - There are new options for sorting chart series and chart data points, which

give you greater control of how chart elements are displayed.

Data Point (X-Axis) Sorting

Series Sorting

Tables

 Edit Column Headings - The column headings in tables can be freely edited.

Table Column Headings

 Improved Table Options - The Table Options Dialog has new options to make it easier to

adjust the width of several columns simultaneously, and to set the decimal precision of multiple

columns.

Table Options

 Table Templates -  All table options and settings can be stored in Table Templates, so that

you can save your preferred settings, and easily recall them for any table.

Table Templates

User Interface

Language - The user interface of TradeSift can be switched to French.  Product names can be

loaded in another language.

Language Settings

Loading Custom Product Names

Miscellaneous

 Packing/Unpacking Projects - There are two new dialog screens for packing and unpacking

projects, which offer more information and more options.  

Packing Projects

Unpacking Projects

 Country Groups - There is a new reference screen where you can view the standard Country

Groups and their member countries.

Country Groups

 Backups - TradeSift will make automatic backups of your projects and unsaved project items.

Project Backups
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Backup Settings

 Open in Excel - After exporting any data to Excel from TradeSift, there is an option for the

output to be immediately opened in Excel.

Exporting Data





Part

II
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2 Installation

This chapter describes the processes of installing, registering, starting, updating, and uninstalling 

TradeSift.

Topics covered in this chapter

 Installation Procedures

Installation

Registration

Program Updates

Uninstalling
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2.1 Installation

Installing TradeSift

This section describes how to install TradeSift.  Please follow the steps below.

Starting the Installation

TradeSift may have been distributed to you via an internet download, CD-ROM, or USB-stick. 

The setup file is called "TradeSift_Vn.n.n_Setup.exe", (where n.n.n is the current version

number).  Please locate the setup file and start the TradeSift installation by double-clicking on

the file.  This will run the setup, which will install TradeSift on your computer.  (During the

installation, it is possible that Windows may display some warning messages, please see this

section for details: Windows Warnings.)

After the initial setup welcome screen appears, click Next, and then  follow the steps in the

installer process as described below.

Licence Agreement

The installer will display the TradeSift Licence Agreement, please read the agreement and tick

that you accept the terms in the Licence Agreement, and then click Next.  (The licence

agreement will also be available via the program once installed, if you want to read it later.)
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 Folder Locations

In the subsequent step of the setup, you are given the option to choose various folder paths

that TradeSift will use.  Unless you have a particular need to change any of these folders, we

recommend that you accept the defaults, and click Next.  If you do need to change any of the

folders, the section below explains the purpose of each folder.
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Program Files Folder

The Program Files folder is where TradeSift’s application files will be installed to.  This defaults

to the standard Windows Program Files folder. The user must be able to run programs from

this folder.  

Data Files Folder

The Data Files location is a single folder shared by all users on the machine, where TradeSift

will store the database files that belong to each user project.  The user must have full read/write

access to this folder.  Depending on how much data the user loads in each of the projects, the

contents of this folder can potentially grow quite large, so it is best to choose a folder that

does not have any quotas or restrictions set up, and with plenty of space available.  This must

be a folder on the local machine, and it cannot be a network path.

User Projects Folder

The User Projects folder is where TradeSift will store the user’s TradeSift projects when they

start to create them.  This defaults to a folder called “TradeSift Projects” in the user’s

Documents folder.  The user must have full read/write access to this folder.  The files stored

here do not contain the actual database files, so they are not too large.

Installation Progress

After clicking Next for the remaining steps in the setup procedure, and then Install, the

installation will start.  The installer will copy files and set up the program, which will take a few

minutes.  Please wait, and do not interrupt the installation.
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Completing the Installation

When the installation has finished, the final step in the setup has a tick-box option to launch 

TradeSift right away.  Leave this ticked if you would like to start the program now, or untick if

you would like to come back to it later.  Click the Finish button to complete the installation.
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Windows Warnings

During installation, it is possible that Windows may alert you with some warning messages:

User Account Control

If you are installing on a PC using Windows Vista or Windows 7, you may get a User Account

Control warning, saying “Windows needs your permission...” or "Do you want to allow the

following program to make changes to this computer?".   The TradeSift installer is digitally

signed.  To verify that this is a valid installer for TradeSift, check that the "Verified publisher" in

the warning message box says "InterAnalyis Ltd".  If so, click "Yes" to proceed with the

installation.

Firewall

Windows may also pop up with a Firewall warning, if so, you need to click on “Unblock”.

Anti-Virus

If you have any anti-virus programs installed, it is possible that they may treat the installation

process as suspicious, however you will have to set the anti-virus program to allow the installer

to run, otherwise TradeSift will not be installed.
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2.2 Registration

After TradeSift has installed, you may use it for up to 7 days unregistered.  You must register your

TradeSift licence within 7 days of installation, (this also applies to trial versions).  Each time

TradeSift starts, you will be reminded to register, until you have done so.  The bottom right hand

corner of your TradeSift screen will either state 'Registered' or 'Unregistered'.  If you do not

register within 7 days, the software will no longer run until you register.  Apart from the reminder

each time TradeSift starts, you can also register any time via the Register menu option on the

Help menu, or by clicking on the button in the status bar, in the bottom right-hand corner of the

main TradeSift screen.

When the registration reminder pops up, or you select the Register menu option, you will be

presented with a Registration Wizard.  There are 3 ways you can register, depending on whether

you have an internet connection available.  The recommended option is to Register Online, which

requires an internet connection.  The other registration methods are provided in case you do not

have an internet connection.

Register Online

This is the recommended method of registering TradeSift.  It requires a working Internet connection

that is not restricted, on the computer on which you are registering. The registration process

contacts the TradeSift Web Server directly, and validates your licence. 

Register via Website

You can use this method to register via a special web-page on our website, if:

You do not have internet access on the computer on which you have installed TradeSift but you

can access the web on another computer.

On the computer on which you have installed TradeSift the connection is limited by a proxy

server or other means, but you are able to use a web browser.

Register by Email/Phone.

If you do not currently have any internet access, you can register by sending us an email, or by

telephone.

The procedure for each of the three methods is described in detail in the sections below.

Register Online

1. On the first page of the Registration Wizard select the option Register Online and click the

Next button.
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2. On the second page of the Registration Wizard enter your Username, Company and the

supplied Licence Key and then click the Next button.  Unless you have a site licence, the

Company name is optional.
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3. The registration process will connect online to our web server to validate your licence details,

there may be a short pause while this is happening. 

 



Installation 35

© InterAnalysis Ltd. 2012

4. You will get a message that TradeSift is registered, after clicking on OK you can click the

Finish button on the Registration Wizard.

Register via Website

1. On the first page of the Registration Wizard select the option Register via Website and

click the Next button.
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2. On the second page of the Registration Wizard enter your Username, Company name if

applicable, and the supplied Licence Key, then click the Next button.
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3. On the third page you will be shown a Registration Code and a URL to visit in a web

browser.  If you are able to access the Internet on the same computer that the Registration

Wizard is running on you can click on the Registration Page link which will open a web

browser at the TradeSift registration page.  If you are using a different computer to access

the internet, write down the Registration Page URL and the Registration Code, leave the

Registration Wizard open on the third page, and go to the other computer, open a web

browser and type in the URL into the navigation field.

4. Once you have navigated to the Registration Page using the web browser, enter your

Username or Company name (the name the licence was issued against), the Licence Key and

the Registration Code being displayed on the third page of the Registration Wizard, and

then click Register.

5. Once the registration process has successfully completed the web browser will display a 
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Validation Code.  If you are on the same computer that the registration wizard is running on,

you can copy and paste this code between the web browser and the Registration Wizard.  If

you are using a different computer to access the internet, write down the Validation Code

and return to the computer running TradeSift.

6. Finally enter the Validation Code into the Registration Wizard and click the Next button. 

7. You will get a message that TradeSift is registered, after clicking on OK you can click the

Finish button on the Registration Wizard.
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Register by Email/Phone

1. On the first page of the Registration Wizard select the option Register by Email/Phone and

click the Next button.
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2. On the second page of the Registration Wizard enter your Username, Company name if

applicable, and the supplied Licence Key, and then click the Next button.
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3. On the third page you will be shown a Registration Code, along with the TradeSift support

email address and phone number.  Make a note of appropriate contact details and the 

Registration Code.  At this point you can either leave the Registration Wizard open, or

cancel the registration process and either continue to use TradeSift unregistered to close the

program.

4. If registering via Email, send an email to the support email address, with the subject

“TradeSift Licence Registration Request” and make sure you include your User or Company

name (the name the licence was issued against), the Licence Key and the Registration Code

from the Registration Wizard.

Send to: support@tradesift.com

    If registering via phone please make sure you have these details handy before calling.  

Call:       +44 (0)1273 234 641

5. Once your details have been processed by our systems we will give you a Validation Code

that needs to be entered via the TradeSift Registration Wizard.  If you have left the

Registration Wizard running enter the validation code against the Validation Code field.  If

TradeSift is not running, start the program and go through the first two steps of the

Registration Wizard again, on the third page, check that the Registration Code has not

changed and enter the Validation Code.  If you are using TradeSift you can complete the

registration by clicking on Help then selecting the Register menu option which will then start

the Registration Wizard.  Go through the first two steps of the Registration Wizard again,

then on the third page check that the Registration Code has not changed and enter the
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Validation Code.  Once the Validation Code has been entered click the Next button.

6. You will get a message that TradeSift is registered, after clicking on OK you can click the

Finish button on the Registration Wizard.
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2.3 Program Updates

When an updated version of TradeSift is available, the program can automatically update itself to

the latest version.  By default TradeSift will check for updates every time the program launches.  

This can be changed via the Configure Updates option.  You can also manually check for updates

from within TradeSift, on the Main Menu select Tools > Check for Updates.

Updating Automatically

1. If TradeSift is configured to automatically check for updates and a new version is available,

when you launch the program you will be informed that updates are available, and you will

be given the option do download and install the updates.

View update details -  this will show the version number, release date and the download file

size.

Ignore for now - this will close the update dialog and you can then continue working with

TradeSift.

Download and install updates - this will close TradeSift and start the update process.  

 If you have a project open you will be asked to close the project.  
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If you want to continue with the update, click the Yes button, the project will be closed and the

update process will continue.  If you had a project open the updater may have failed to close 

TradeSift before starting the update process.  If this happens you may see a dialog box saying

"The following applications must be closed before continuing the install".  You should then

switch to the running copy of TradeSift, manually close the program and then switch back to

the installer and click the Retry button. 

2. Once you have selected to download and install updates the updater will be run and will

display the available updates for TradeSift.

3. Normally only one version will be shown and it will be preselected.  Clicking the Next button

will start the download.  
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4. Once the download has completed provided that you have selected to automatically install

the updates the Upgrade Wizard will be launched.  
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The wizard will then take you through the steps to uninstall the current version of TradeSift and

then install the new version.  The installation procedure from this point will the same as the

standard installation, as described in the section on Installation.

Manually Checking for Updates

You can manually check for updates from within TradeSift by clicking on the Tools menu and

then selecting Check for Updates.  If updates are found, and you have a project open you will

first asked to close it before the updater runs.

Configuring the Updates Check

You can configure various aspects of the updates check by clicking on the Tools menu and then

selecting Configure Updates.
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From the Update Options dialog you can change whether to automatically check for updates or

not and to also change the frequency of checks.

It is not recommended to change the type of updates to check for or the location of the

downloads folder.
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2.4 Uninstalling

This section describes how to uninstall TradeSift and remove it from your computer.  The program

will be removed, but all your Projects and Data will be left intact.  Uninstalling TradeSift involves

two steps.

1. Uninstalling TradeSift from your computer.

2. De-authorising TradeSift by removing the licence registration details from our licence server

for your computer.

You can uninstall either via a shortcut in the Start Menu, or by using the Windows Control Panel.

 Uninstalling via Start Menu

Click the Windows Start button, All Programs and then navigate to the TradeSift folder, under

Uninstall you should see the option “Uninstall TradeSift”.

Click on Uninstall TradeSift, select Yes to the Windows Installer message asking if you want to

uninstall this product.  If the User Account Control asks you to allow the program to make

changes to your computer select Yes.

Uninstalling via Control Panel
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You can also start the uninstall process by clicking on Control Panel, and then clicking on

Uninstall a Program.  Select TradeSift from the program list and click on Uninstall.

 Tip:

If the Uninstall a Program option is not visible when you first open the Control Panel, type

“uninstall” into the Search box.

 De-authorising TradeSift

Once you have started the uninstall process you will then be presented with a dialog box to de-

authorise TradeSift.  This process normally requires an Internet connection.  Click on the Next

button, if the de-authorisation process is successful the following dialog will be displayed:
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Click on the OK button to continue uninstalling TradeSift from your computer.

If you do not have an Internet connection the following message will be displayed:

Click on OK and you will be presented several options :
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Manual – Will allow you to continue to uninstall TradeSift from your computer skipping the

licence de-authorisation step, see Manual De-authorisation.

Details – Will show the de-authorisation log details, if you don’t have a working Internet

connection the log will end with the text “De-authorising…”.

Retry – Will retry the automatic de-authorisation process.  Only select this if you believe that

you have a working Internet connection.

Cancel – Will cancel the uninstall process.  After clicking this button a blank message box may

briefly appear, this is normal.

Manual De-authorisation
If you select the manual option from the TradeSift Licence Information dialog the following

will be displayed:
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You should make a note of your Username, Licence, De-authorisation Code and the website

address.

Click on the OK button to continue uninstalling TradeSift from your computer.

Once the uninstall has completed you should proceed to de-authorise your licence details.  If

you did not make a note of the details you can find them in a text file named “TradeSift

Deauthorise” in the Documents folder.

Visit http://www.tradesift.com/licences/deauthorise.aspx and enter the details that were

displayed in the Manual De-authorise dialog box and click the De-authorise button.

Once the de-authorisation has completed you will get a message saying that TradeSift has

been de-authorised and how many licences you have remaining.





Part
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3 User Interface

This chapter describes TradeSift's user interface, and explains how to access all the program's

functions.

Topics covered in this chapter

 TradeSift User Interface

Starting TradeSift

Main Window

Window Modes

Appearance



User Interface 57

© InterAnalysis Ltd. 2012

3.1 Starting TradeSift

You can start TradeSift via the Windows Start button, by clicking on "All Programs", and looking for

"TradeSift".  Alternatively, the installation will have placed an icon for TradeSift on your desktop,

you can start the program by double-clicking on the icon.  While TradeSift is starting up, the

version number of the program and your licence key are displayed on the TradeSift splash-screen.

 Startup Dialog

When you first start TradeSift, a dialog box is displayed which asks you what you would like to

do, with the most common options listed below.  These give you a quick shortcut to common

tasks, like creating a new project, opening the last project you worked on or another recent

project, or accessing the help on how to get started.
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 Tip:

If you don't want the startup dialog to appear every time you start TradeSift, tick "Don't ask

me again" in the bottom left-hand corner of the dialog.  You can choose later if you want the

startup dialog or not by changing a preference in the Program Settings.

The Start Page

When TradeSift first starts up, there is a Start Page which opens up as the first tab window. 

This page is to guide you through the first steps in using TradeSift: creating and opening

projects, creating data, and then viewing your data. The contents of the Start Page will change

according to which stage you have reached in your project.  The links in the start page are just

shortcuts to common TradeSift functions, so for experienced users, all of these functions are

available via the Main Menu or the Navigator panel on the right.

The Start Page also lists your most recent project, so you can return to a previous project just

by clicking on the link for a project name.
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 Tip:

The Start Page is optional, if you don't need it you can close the page.  If you want to access

the page again, select Help > Start Page on the Main Menu.  You can set your preference

for whether you want TradeSift to show the Start Page, in Tools > Program Settings >

Options > Use Start Page.
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3.2 Main Window

TradeSift Main Window

TradeSift's main window is divided into five basic sections: the Main Menu, the Toolbar, the

Navigator, the Project Explorer, and the Status Bar.  

Each of these sections can be shown or hidden from view, depending on your preference or

available screen space, except for the Main Menu which is always visible and cannot be hidden. 

To show/hide the other 4 screen areas, you can tick/untick them on the View menu, or use the

special Panel Buttons in the top right-hand corner of the screen.

Program functions can be accessed in any one of three ways:  

By selecting a menu item on the program's Main Menu.

By clicking a button on the program's main Toolbar.

By clicking on a link in one of the panels in the Navigator.  

Main Menu

The Main Menu gives you direct access to all of TradeSift's functions.  It is split into menu

groups relating to areas of the program's functionality, and these groups correspond to similar

groups in the Toolbar and the Navigator panels.
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 Toolbar

Just below the main menu there is a Toolbar with buttons which provide quick shortcuts to the

program's most common functions.  

(Note that not every single program function has a toolbar button, only the ones that are likely

to be used most often.)  The Toolbar is divided up into a number of smaller bars, where each

one corresponds to a menu group.  You can choose which toolbars you would like to be visible

via the View > Toolbar menu.  

If the toolbars do not all fit across the screen width, you can grab any one of the toolbar

groups by grabbing it on the dotted "grip" to the left of the toolbar.  By dragging, you can re-

arrange the order of the toolbars, or drag them on to another line, so that you can have

toolbars on multiple lines.

Hovering the mouse over any Toolbar button will show a tooltip, with a short description of the

button's function.
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Navigator

The Navigator to the left of the main screen, provides panel groups for

each of the main areas of the program’s functionality, with sub-items in

each panel to access the specific screens or functions. The Navigator can

be shown or hidden using the View > Show Navigator menu option.  You

can also close the Navigator by clicking on the 'X' close button on the top

right of the Navigator.  

The Navigator has two modes: when it is “pinned”, it is always visible:

when it is “unpinned”, it will auto-hide when it is not in use.  You pin or

unpin the Navigator by using the pin icon in the title bar.  If the Navigator

is unpinned, and auto-hides, you can make it reappear simply by hovering

the mouse over the title of the Navigator, which will have narrowed to a

thin strip to the left of the screen.

Each of the panel groups in the Navigator can be expanded or collapsed

using the >> chevron in the header of each group, or by clicking anywhere

in the group header.  You can have any combination of expanded or

collapsed groups, screen space allowing.  To select an option from the 

Navigator groups, just click on a sub-item.

 Project Explorer

The Project Explorer is a panel on the right of the main screen,

which displays a hierarchical list of all the items that belong to

your project.  The list of items will grow as you work with your

project and create and save new items.  

The Project Explorer shows the following items:

Data Selections

Indicators

Charts

Tables

Documents

Images
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The Project Explorer is explained in more detail in the Projects

chapter: Project Explorer

Status Bar

The bottom of the main program window has a Status bar which displays information about the

current state of the program.  On the left it displays the name of the current project that is

open, and a status label indicating the current action that the program is carrying out.  On the

right, it shows the version number of the program, and a button which shows the state of your

licence.  Depending on the state of your licence, clicking on the licence button will take you to a

screen either with further details about your licence, or to register.
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3.3 Window Modes

There are two possible modes for displaying windows, normal floating windows, or tabbed

windows.  You select the window mode on the main menu bar under the Windows menu by ticking

or unticking Use Tabbed Windows.  You can dynamically flip back and forth between the two

window modes whenever you like, and the currently open windows will be re-arranged according

to the mode you have selected.  The differences between the two modes are explained below.

 Note:

You can set your preference for which windows mode you would like TradeSift to use, in Program

Settings, via the Tools menu.

Tabbed Windows

When the window mode is set to Tabbed Windows, each screen that you open will be

displayed as a tab page.  You can switch between all the windows that you have open by

clicking on the tab header. You can also "tear off" a screen from the tabbed windows, by

grabbing the tab header and dragging it away into the center of the screen.  That window will

then be displayed as a separate floating window.  To return the floating window back to tabbed

mode, grab the window title and drag the window back the tab headers.  The window will then

fix back into a tabbed position. 

 Floating Windows

If you switch off Use Tabbed Windows, then new screens will be opened as separate floating

windows, which means that you can tile them, overlap, resize and arrange them on the screen,

etc., which allows arranging the screen to view several windows at the same time if required. 

When in this mode, you can make use of the options under the Windows menu, for Cascade,

Tile Horizontally, Tile Vertically, etc.  
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By using the options for Tiling, you can make several windows visible at the same time, as show

in the image below.
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3.4 Appearance

Skins

TradeSift comes with a number of different colour schemes and appearances in the form of "skins".

 To change the current skin, use the View > Skins option on the Main Menu, and select the skin

you would like use.  Your choice will be saved and loaded automatically when you next open 

TradeSift.



Part
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4 Projects

This chapter describes TradeSift Projects, and the basic tasks you will use to work with Projects.

Topics covered in this chapter

 Projects

Project Concepts

Project Menu

Creating Projects

Opening Projects

Saving Projects

Packed Projects

Project Settings

Project Backups

Project Explorer
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4.1 Project Concepts

A Project is the basic file type that TradeSift works with.  A TradeSift Project groups together all

the external data that you import to work with for a given piece of analysis, all the calculations and

results that you produce, and miscellaneous documents, outputs, charts, tables, etc. that belong to

that project.  Projects allow you to work with multiple sets of data and calculations, with each

stored in a separate Project file.  

A Project groups together the following items:

Data - The Data you load in to your project.

Indicators - The results from any Indicator calculations you make.

Charts - Charts created from any of your project data or indicators.

Tables - Tables created from any of your project data or indicators.

Documents - Documents you create in TradeSift to make a report of you findings.

Images - External Images you have imported for use in documents and reports.

Project Files & Folders

A TradeSift Project file has the file extension ".tsp".  When you create a new Project, the

program will create a folder for that project with the same name as you chose for the project,

and inside that folder it will create a project file with the ".tsp" file extension.  Your projects will

be created in the folder you chose during the installation process (see Folder Locations), which

by default will be in your "My Documents" folder, under "TradeSift Projects\My Projects".  For

example, if you create a new Project called "United Kingdom", your project file will be "United

Kingdom.tsp".

It is very important to understand that the ".tsp" Project File does not contain all the data that

you load in to your Project, for example the basic trade data or tariff data.  The Project File

defines your project and parameters, and items that belong to it like Charts and Tables and

Documents, but the actual large volume of Data is stored separately in a special database

which belongs to your project.  For technical reasons, the Project Databases are stored in

special system folder.  This means that your project file (the ".tsp" file"), cannot be moved, and

you cannot just copy it to a flash drive or email it if you want to give the project to someone

else.  This would not include all the project data, and it would not be possible to open the

project.

If you need to distribute a TradeSift Project, the program has a special facility for this situation

to make a portable project file, which is called a Packed Project.  This is explained in detail in

the section on Packed Projects.

 Note:

Once you have designated a folder to store your TradeSift projects and you have created

some projects, please do not move your projects or the ".tsp" files.
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4.2 Project Menu

The program's File Menu on the Main Menu provides access to the common project file

operations, such as creating, opening, closing, deleting, etc.

The Project Menu on the Main Menu provide functions specific to the currently open Project. 

Most of these menu options are also available via the program's main Toolbar and the Navigator.

File

Men

u

Project

Menu

Navigat

or

ToolBar

The File Menu
 New Project - Create a New empty Project, ready for loading data into.  See Creating

Projects.

 Open Project - Open an existing Project.  See Opening Projects.

 Close Project - Close the currently open Project.

 Save Project - Save changes to the currently open Project.  See Saving Projects.

 Save Project As - Save a complete copy of the current Project under a different name.  This

creates a duplicate copy of the Project including all of the Project's loaded Data, so this

operation can take quite some time, particularly for a large Project.  See Saving Projects.

 Restore Backup - Open a Backup file of a Project and Restore the Project to an earlier state.

 See Project Backups.

 Delete Project - Delete the currently open Project.  The project file and it's folder will be

completely deleted, along with the database and all data that belongs to the project.  This action

cannot be undone.

 Pack Project - Pack the current Project and all its data into a single portable compressed

file, (similar to a zip archive).  See Packed Projects, and Packing Projects.

 Unpack Project - Unpack a Packed Project archive, to create a new Project from it.  See

Packed Projects, and Unpacking Projects.

 Recent Projects - Display a list of the most Recent Projects you opened, so that you can

quickly recall a Recent Project.

The Project Menu
 New Document - Create a New empty Document.  See Report Writer.

 Open Document - Open a previously saved Document.  See Report Writer.

 Open Chart - Open a previously saved Chart.  See Charts.

 Open Table - Open a previously saved Table.  See Tables.

 Project Settings - Open the Project Settings dialog, to change the settings and preferences

for your current Project.  See Project Settings.

 Project Log - View a time-stamped Log of Project events.
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4.3 Creating Projects

To get started using TradeSift, you must create a new empty project first.  On the File Menu click

New Project, or select the same option from the Navigator in the Projects panel.  A new Project

Wizard will open, where you can enter the details of your new project.  The only mandatory field is

the name to save the project as (this will be the actual filename saved to disk, with a ".tsp" file

extension).  

The project creation dialog is organized as a wizard style screen with several steps, but please note

that to quickly create a project, you only need to enter the project name, and then click "OK".  The

remaining pages of the wizard are for optional settings, which can help to define the purpose of

the project, and also allow you to set certain defaults for your project, such as preferred

nomenclatures and countries.  However, it is not essential to fill these in at this stage.  You can

return to this same screen at any time to modify the settings, by selecting Project > Project

Settings from the main menu.  

For a detailed explanation of the rest of the project settings, please see the section on Project

Settings.
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4.4 Opening Projects

To open a previously saved project, simply select the Open Project option on the File Menu or in

the Navigator, or use the Open Project toolbar button the project Toolbar.  You will be shown a

file open dialog, just browse to the project file you want to open.  Alternatively, the last 10 recent

projects used can be easily accessed via the File Menu > Recent Projects.  Your recent projects

also appear on the Start Page.

You can only have one project open at a time, so if you want to open another project, you will be

prompted to first save and close the project you currently have open.
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4.5 Saving Projects

Saving Projects

To save your project as you work, just click the Save button on the main Toolbar, or use the File >

Save Project menu option on the Main Menu.  This will save any recent changes to your project.  It

is a good idea to periodically click Save as you work.  You will be prompted to save your project

when exiting TradeSift if you have not already done so.  The option to Save Project As allows you

to save another copy of the project under a different name. 

TradeSift projects have a hierarchical structure, which means that the project is like a container for

the project items, such as charts, tables, documents, etc.  It is important to understand that as you

make data selections and create charts and documents, these are just temporary unsaved "working

copies", and they do not yet form part of your project until you specifically choose to save them. 

(You can think of this as being similar to when you create a new blank Word document, it is not

saved until you click save and give it a name.)  If a chart or data selection is not listed in the Project

Explorer, saving your project will not save this particular item. 

The sections below describe in detail how to save sub-items of your main project.

 Saving Project Items

If you create a data selection or industry calculation, a chart or a table,  which you wish to keep

as part of your project, you must explicitly save it. All of these screens have a similar toolbar,

and one of the first buttons is a Save As button.

After clicking the button, you will be prompted to type in a name for the item.  In many cases a

name for the saved item will be suggested, which is a composite name made up of the part of

your data selection, such as the nomenclature, country, etc.  You can accept this name, or type

over it with any name that you prefer.  There is an optional comments box where you can insert

some comments or a description.  These additional comments will appear when you hover over

saved items in the Project Explorer.

When you click OK, the item will be saved and a confirmation message will be displayed.  If you

have the Project Explorer open, you will see the item appear in the Project Explorer in the

relevant group. 
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 Note:

The procedure for saving Data Selections, Indicator results, Charts, Tables, and Documents, is

the same as described above.  Click the Save button on the Toolbar, choose a name, and the

item will be saved and added to the Project Explorer.

Saving Country and Industry Selections

When looking at data and indicator results, it is possible to apply sorting and filtering to the

results, and other functions such as limiting the list to a "Top 10".  These functions are explained

in detail in the section about the Display Options Panel.  For example, you could limit the list of

products to see the top ten industries, or if you are viewing total trade, you could limit the list to

see the top ten trading partners.  It can then be useful to save these "Top 10" lists of industries

or countries, for use in future data selections.

When you are making use of the Limit function, and you have restricted the list to the top n

industries or countries, the Save Limited Items icon in the Display Options panel next to the

Limit control will become enabled.  

Clicking this button will display a Save dialog, where you can choose a name for this country or

industry selection, and when you click OK, the list of countries or industries currently visible in

the data grid will be saved under that name.  Recalling these saved selections is covered in the

section on Data Selections.
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4.6 Packed Projects

Packed Projects

A TradeSift project is made up of the basic project file and it's associated items, as well as all the

project data that you have loaded.  The underlying project data is stored separately from the

project files in a database in a special system folder, so it is not possible to transport a project

simply by backing up the project folder or copying the ".tsp" file, as this would not include the data.

 

In order to either make a complete restorable backup of your project, or to make a portable file

which you could move or share with another user, there is a special function to make a "Packed

Project".  A Packed Project is a single compressed portable archive file, with all your project data

and project items included.  You can think of this as similar to a zip archive.  

To handle Packed Projects, the File menu has two functions:

Pack Project - To create the Packed Project archive, from the currently open Project.

Unpack Project - To open a Packed Project archive, and create a Project from the archive.

These two operations are described in the following help topics:

Packing Projects

Unpacking Projects

4.6.1 Packing Projects

Packing a Project

To pack a project, first open the project you want to pack, then select File > Pack Project on the

Main Menu.  

The Pack Project feature will pack everything in your project into a single file, all your project items,

and all the data loaded in your project.  The file will be compressed to produce a compact

portable file, which will have a “.tzp” file extension, (TradeSift Zipped Project).  The file can then be

saved to a flash drive or emailed, etc.  

After selecting Pack Project on the File menu, the Pack Project dialog will be displayed.
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The dialog will suggest a file name and location for the Packed Project to be created.  The default

folder will be "\Documents\TradeSift Projects\Packed Projects" in your user folder, and the file

name will be the same as the project file name, but instead with a ".tzp" file extension.  You can

change the name of the Packed Project that you want to create by typing over the name in the

Packed Project box, or by using the Browse button next to it, to choose a new location or file

name.   Note that the name of the Packed Project file can be anything you want, and does not

determine the name of the project when you unpack it.  When you unpack, the project that will be

created will be given the same name as the project that you are packing, regardless of the name

you have chosen for the ".tzp" file.

The Project Size field shows you the current size of your project files and data, and the Packed

Size field shows you an estimation of the size of the Packed Project file that will be created when

you pack the current project.  (Generally the ratio is about 10:1, so the final ".tzp" Packed Project

file will be about 1/10 of the size of the original project and data.)

To pack the project into the archive file shown in the Packed Project field, click the Pack Project

button.

The process of compressing and packing the project will start, and a progress dialog will be

displayed while the project is being packed.  Please note that if your project contains a large

amount of data, the process of packing the project may take some time.  You  should not interrupt

the project packing once it has started, as this could produce an invalid archive.  When the project

packing has finished, a single ".tzp" Packed Project file will have been created in the folder that you

chose.  This Packed Project archive can be stored as a backup, or it can be given to other

TradeSift users so that they can unpack and work with the same project.  See Unpacking Projects.

4.6.2 Unpacking Projects

Unpacking a Project

The reverse of packing a project, is to unpack a project from the ".tzp" packed project archive.  To

unpack a project (“.tzp”), select File > Unpack Project on the Main Menu.  (If you currently have a

project open, this must be closed first - you will be prompted to do so if necessary.)  A Windows

file browser dialog will be displayed, browse to the Packed Project file (".tzp") that you wish to

open.  The Unpack Project dialog will be displayed.



Projects 77

© InterAnalysis Ltd. 2012

The Packed Project (".tzp") file that you selected will be shown in the Packed Project field.  You can

change your mind and open a different Packed Project by using the Browse button to the right.

The Project Name field will show you the original name of the project in the archive (which can be

different to the name of the .tzp file).  The name in the Project Name field will be the name of the

project that will be created when you unpack, so if you want a different project name to be created,

you can modify this field by typing over it.

The Project Info field will show you some basic info about the project in the Packed Project

archive, the version number and the data it was created and packed.  (Please note that this

information will not be available for any projects that were packed in a version of TradeSift earlier

than V2.0)

The Packed Size field shows you the size of the .tzp Packed Project file, and the Project Size field

shows you an estimation of how much disk-space will be required by the unpacked project and

data.

To unpack the project and create a new project from the Packed Project archive, click the Unpack

Project button.  TradeSift will unpack the project, restore the data, and recreate the project for you

in your default TradeSift projects folder.  After unpacking, the project will be opened, so that you

can continue to work with it.  Please note that if your project contains a large amount of data, the

process of unpacking the project may take some time.  You should not interrupt the unpacking

process, as this may leave you with an invalid project.

If a project with the same name as the project you are unpacking already exists, a dialog box will

be displayed giving you three choices:

Unpack and overwrite - This will unpack the project, and overwrite the existing project.  Note

that this will completely replace the existing project with the project you are unpacking, so you

should be very sure that this is what you want, as this action cannot be undone.

Unpack to a new name - This will unpack the project to a new project which will be created with

a different name.  You will be prompted to enter the name for the new project.

Cancel unpacking - This will cancel the unpacking, and take no further action.
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4.7 Project Settings

Project Settings Wizard

The Project Settings Wizard is accessed via the menu option Project > Project Settings, on the

Main Menu.  Note that this wizard screen is the same screen that appears when you create a new

project.  It is only necessary to fill in the first page of the wizard when creating a new project as the

other settings are optional, but you can return to this screen at any time to adjust your project

settings and defaults.

The Project Settings Wizard has three pages, which are explained in detail below.

Project

Defaults

Info

Project

The Project page of the wizard is where you choose the basic settings of the project.

Project Filename - The name you would like to save your project file as.

Save In Folder - The folder that your project will be saved in.  This will normally default to

"My Documents\TradeSift Projects\My Projects", and we recommend that you do not change

this or move projects after they have been created.

Full Project Title -An optional longer descriptive title for your project.
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Defaults

In the Defaults you can set preferences for default values for your data selections.  You can set

default values for the nomenclature, digit-level, reporter, partner, and the year range.  What this

means is that when you do a data selection or indicator calculation, if the data is available for

your default values, that values will automatically be selected.  For example, suppose you have

set H1 and 2-Digit as your default nomenclature and digit-level, and the UK as your default

reporter country.  When you make a data selection, if H1 2-Digit and UK are available, they will

automatically be selected.  This does not prevent you from changing or adding to your

selection, these are just the initial values.

 Info

The Info page  of the Project Settings shows you the following information about your project:

Project Version - The current TradeSift program version of this project.

Created in Version - The TradeSift program version that the project was originally created in.

Date Created - The date and time that the project was created.

Date Modified - The date and time that the project was last modified.
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4.8 Project Backups

TradeSift can be set to make automatic periodic backups of your project, and of any unsaved

project items, such as charts, tables, documents, etc.  To enable the automatic backups and to

modify the backup settings, use the Program Settings dialog.  The backup settings are descibed in

detail in this section: Program Settings, Options.

 Restore from a Project Backup

You can restore a whole project from the Restore Backup option which is found under the File

menu.

Clicking on Restore Backup will open the Restore Project Backup dialog which will list all the

backups in date descending order.  

Select a backup file and then click the Open Backup button.  A dialog will be displayed asking if

you are sure you want to revert to an earlier version of the project.  Click Yes to restore from

the backup or click No to cancel.

By default unsaved project items are not restored using this option.  If you also want to restore

any work that was open at the time the backup was made select the Recover auto saved items

option next to the project name.  Restored unsaved items will be prefixed by the word

Recovered in the Project Explorer.

 Recover From a Crash

Provided backups are enabled and run frequently, TradeSift should be able to detect if it was

not correctly shutdown. When you restart TradeSift the Getting Started dialog should offer the

following options:

Open most recent version (auto saved)

Open last user saved version
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Selecting to open the auto saved version will recover any unsaved project items.  Recovered

project items that had pending unsaved changes will be prefixed by the word Recovered in the 

Project Explorer.  Any previously saved version will also show in the Project Explorer as

normal.
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4.9 Project Explorer

The Project Explorer

On the right-hand side of the main TradeSift screen, there is a window called the Project Explorer.

 If the Project Explorer is not visible, you can display it by selecting View > Project Explorer on

the Main Menu, or by clicking the Panel Button in the top right-hand corner of the main window.

The Project Explorer is a hierarchical display of all the project items that belong to your project,

displayed in a tree-list style.  Each category of project item has a fixed group, which then contains

sub-items.  The explorer groups are:

Data - Data Selections that you have saved, for example trade, tariff, or GDP data.

Indicators - Results that you have saved from Indicator Calculations.

Charts - Charts that you created and saved.

Tables - Tables that you created and saved.

Documents - Documents or reports that you have created. 

Images - External Images that you have imported, to include in Documents.

The procedure for saving project items is explained in the section on saving work in the chapter on

Projects: Saving Project Items.  As you work with your project and save items, they will be added to

the Project Explorer, which  is a categorised list of all your saved project items.

Previewing Items

If you hover the mouse over any item in the Project Explorer, a tooltip will popup with more

information about the saved item.  A small image preview of the item will also be displayed at

the bottom of the explorer.  For example, if you hover over a chart item, the preview will show a

miniature image of the chart, or if you hover over a document, the preview will show an image

of the first page of the document.  This means that before you recall an item, you can get some

visual feedback to remind you what each item is, by looking at the tooltip info, and the preview

image.

 Recalling Project Items

The main purpose of the Project Explorer is to allow you to easily recall saved items.  Although

you can open saved items from inside any data or chart screen, by using the Open button on

the toolbar, the Project Explorer provides a quick way to directly recall an item, without the

need to first open the appropriate screen.  You open items from the Project Explorer simply by

double-clicking on the item name in the explorer's list. (You can also right-click the item in the

explorer, and select Open from the context menu that will be displayed.)

When you open an item from the Project Explorer, the program will open a new window for

that item, reload the data or chart depending on what kind of item you are opening, and

restore the item in the window exactly as if was when you saved it.  For example, if you double-

click on a saved Trade Data Selection, the program will open a new Trade Data Screen, and

display the exact data selection that you saved.  Any adjustments that you made in the Display

Options panel before you saved that selection, such as sorting, filtering, top n limits, etc. should

all be restored.  If you double-click a Chart in the Project Explorer, a new Chart window will be

opened, and the saved Chart will be recalled and displayed.  The same procedure applies to all

saved project items, and you can recall as many items as you like, a new window will be opened
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for each item.

 Importing Images

The Project Explorer allows you to import external Images, so that you can use them in your

Documents.  For example, the image could be a company logo, or a chart or graphic exported

from another program.  To import an Image, right-click on the Images group in the Project

Explorer, and select Import Image from the popup menu.  A standard Windows file browser

dialog will be displayed, use the file browser to locate the image file that you want to import.

The Image will be imported, and it will be added to the Project Explorer in the Images group. 

To remove it, right-click on the Image name in the Project Explorer, and select Delete from the

popup menu.  To insert an Image in to one of your Documents, you can just drag it from the

Project Explorer, and drop it on to the Document page.  The procedure is the same as for

Charts and Tables, see Inserting Charts & Tables into Documents.



Part

V
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5 Loading Data

This chapter describes how to load Data in to your Projects.

Topics covered in this chapter

 Loading Data

Loading Data from Files

Loading Data from Comtrade

Loading Custom Data

Data Files Guide

Checking Data Availability

 Data Loading Types

Loading Trade Data

Loading Services Data

Loading Tariff Data

Loading GDP Data

Loading WDI Data

Loading Product Names

Loading Product Groups
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5.1 Loading Data

TradeSift is a tool for analysing data, but it does not include any data other than master lists of

countries, nomenclatures, commodity codes, etc.  To use TradeSift to analyse data, you must first

load data in to your project, for example trade or tariff data.

There are two methods for loading external data in to your TradeSift project, via external files, or

in the case of Trade Data, directly online from Comtrade.  Both methods are accessed via the Data

menu in the Main Menu,  or in the Load Data panel in the Navigator.  (The direct download from

Comtrade option is dependent on you having a subscription to Comtrade.)  Although TradeSift

comes with GDP Data pre-loaded, you can load your own GDP data if you require.

You can access the data loading screens via the Main Menu, the Toolbar, or the Navigator.

Main

Menu

ToolBar Navigator

Data Loading Selector

After selecting Load Data via one of the above methods, a dialog will display asking you to choose

which type of data you want to load.  The files which TradeSift can load for different types of data

can have very similar column headings, so you must first choose which type of data you are

loading.  The dialog has a number of large buttons on the left, one for each type of data.  It is very

important that you choose the right option for the file that you want to load.  If you hover the

mouse pointer over one of the buttons, the help panel on the right will display more information

about the type of data.  There are 2 small link buttons below the help panel, which can give you

further help for the type of data shown in the help panel.  You can view an example of a typical file

for the data that you want to load, to see the required column headings, or you can jump to the

relevant help topic in the User Manual.

To proceed with loading data, just click one of the buttons on the left for the type of data you want

to load, which will take you straight to the data loading screen.  The procedure for loading data is

described in detail in the section on Loading Data from Files.
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Data Loading Topics

The following sections describe each of the data loading methods in detail:

Loading Data from Files

Loading Data from Comtrade

Loading GDP Data

Loading WDI Data

Once you have some data loaded in to your project, the following section describes how to view a

summary of the loaded data, and a log of the files loaded.

Viewing Data Availability

These topics explain how to load non-standard data, and a detailed guide on the required format

of files that can be loaded in to TradeSift.

Loading Custom Data

Data Files Guide

5.1.1 Loading Data from Files

The files that can be loaded in to TradeSift can be Excel files (.xls or .xlsx), Text Files (.txt), or

Comma Separated Value files (.csv),  or Compressed Files (zip), and usually come from

Comtrade, Wits, Trains or other data sources.  In order for TradeSift to be able to import these

files, the column headings must conform to the standard that TradeSift expects, if the correct

column headings are not found, the file will be rejected, and cannot be imported.  For more



Loading Data 89

© InterAnalysis Ltd. 2012

information on the format of the import files and other data related issues see the Data Files Guide.

When you download your data from WITS or Comtrade, it is important to remember that TradeSift

will not load any files that contain mixed digit levels, so a single file must contain for example only

total trade, or only 2-digit data, and so on.

If loading data from compressed files (zip files), the compressed files should only

contain other file types that TradeSift supports.  The compressed file should not contain

any sub-directories.  (For compressed files from WITS the file "[Content_Types].xml" is

automatically ignored.)

To load data in to TradeSift from files, select the Load Data option on the Data menu in the Main

Menu, or in the side Navigator in the Load Data group.  In the dialog that is displayed, select the

appropriate type of data to load (See Loading Data).

 Note:

It is very important that you select the correct data type from the data loading dialog, for the

type of file that you plan to load.  If you plan to load trade data, you must select "Load Trade

Data", and so on.  If you receive some warning message that the correct column headings were

not found, it is possible that you selected the wrong loading option for your file type.

The data loading screen for the type of data you selected will be displayed.  This screen allows you

to build up a list of all the files that you want to import, and then start the loading process to

process the list of files.  This means that you can queue up many files, and leave TradeSift to import

the data unattended.  Bear in mind that the import files often contain many thousands of product

lines, so if you add many files, the entire loading process could take a long time, and you will not

be able to use TradeSift for anything else during that time.

The screen has 4 large buttons at the top:

Add Files - This is to select the files you want to load.

Add Folder – This is to import files you want to load from a folder and all its sub

folders.
Info - This is to optionally enter any comments you want to attach to the data to be loaded.

Load - This is to start the data loading process.

To load your data, follow the three steps described below.
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 1.  Select Files

Selecting the Files
Click on the Add Files button which will open a file browser dialog or click on the

Add Folder button to open a folder browser dialog.

For the file browser, find the files that you want to import, and click OK to add them

to the file list. If you want to select multiple files in the browser-dialog, use Shift-

Click. 

For the folder browser, select a folder.  TradeSift will automatically select all the files

from the chosen folder and all its sub folders that have file extensions that are

supported by the data loader.

Once you have added a number of files to the list, you can repeatedly open either

the file or folder browser if you want to continue adding files to the list, which may

be in different folders. 

Validating the Files
TradeSift will make an initial pass through the list of files, checking that each file is a valid file

that can be loaded.  The files which pass this test will display "Ready to Load" in the Comments

column of the grid.  If any files are found to be invalid, these will display "Invalid File" in the

Comments column.  To see the reason why any of the files are invalid, you can click on the

Warnings tab to see a list of problems that were found during the validation step.  You can also

select a specific file in the file-list grid, and then click the "Show Errors" button under the grid. 

When you start the loading process, the invalid files will be automatically removed from the list,

and they will not be processed. 

Duplicate Files
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If any files are found which you have already loaded previously, TradeSift will display a message

box asking you whether you want to load the files again, or to remove the duplicate files from

the list.  Normally there is no reason to load a file again, unless you suspect that the data did

not load correctly.  Note that if you load any files a second time, data will not be duplicated, it

will just overwrite and update the data this is already loaded in your project.

Don't load the files again

Select this option to remove the files that have already been loaded from the file list, and to

not load them again.

The data already loaded for these files will not be affected.

Leave the files and load them again

Select this option to leave the files, and load them again in to your project.

Data will not be duplicated, this will just reload the data again.

Removing Files
You can remove any of the files from the list be clicking on a row in the grid, and clicking the

"Remove Selected" button underneath the grid.  If you want to clear the entire list of files

without processing them to start again, click the "Clear List" button under the grid.

 2. Enter Comments

You can attach comments to the data to be imported, and name the source of the data.

Click on the Info button, and enter the information in the popup dialog.  This step is entirely

optional, if you do not need to attach any comments, you can proceed straight to Step 3.
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 3. Load the Data

When you are ready to import all the files in the list, click the Load button.  TradeSift will load

the files one by one, displaying information about the progress of the import job.  You will not

be able to carry out any other function in TradeSift during the import process, until it has

finished.  The files being processed will be ticked off one by one, and any errors or problems

will be indicated with an error icon against the file name.  The progress dialog shows which file

is being processed, and the current file will be highlighted in orange in the list of files in the

data grid.

 Note:

If you are loading data files that came from Comtrade or Wits, please read the Comtrade & WITS

Notes,

5.1.1.1 Comtrade & WITS Notes

Data Limits

Access to Comtrade is free to all users, though is restricted to downloading 50,000 rows in any one

data file unless you have a subscription.  It is important therefore to ensure that the data you

request in any one query from either WITS or Comtrade constitutes less than 50,000 rows. 

As it is quite easy to reach 50,000 rows it is worth bearing the following in mind:

When requesting data at the 6-digit HS level for example, this contains 5053 products. Data for

one bilateral pair (e.g. China to the World), over 10 years is therefore slightly over 50,000 rows

for one trade flow. The resulting data file will therefore be truncated at 50,000 rows therefore not

reporting data for the final products given you have only selected one flow type. If you have

requested both exports and imports, this query will not be processed in its entirety, and the

result will be a truncated file with roughly half the data present. 

A few examples:

- at the HS 2007 4 digit level there are 1222 products; at the 2-digit level there are 97

products.

 - at the combined nomenclature (CN) 8-digit level (available from Eurostat) there are 17964

products; at the 6-digit level there are 7076 products.
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Aggregate Countries

It should be noted that Comtrade does not have World as a standard reporter (it is available as a

partner).  When downloading via the website World may be available in the reporters tab under My

Country Groups.  Im Comtrade,  "World" means one reporter with aggregated values whereas "All"

is just a shortcut to selecting all individual countries.

5.1.2 Loading directly from Comtrade

If you have a subscription to Comtrade, it is possible to load your data directly into TradeSift over

an internet connection, alleviating the need to access the UN Comtrade website.  Using this

method, you do not need to download any Excel or CSV files, TradeSift will contact the Comtrade

database directly, and load your selected data straight in to your project.

 Authorisation Code

Normal access to Comtrade is free to all users, athough it is restricted to downloading 50,000

rows in any one data file unless you have a subscription.  If you have a Comtrade subscription,

you need to set up your Comtrade authorisation code in TradeSift.  Access the Program

Settings dialog via the Tools menu, and select the Comtrade page.  Paste in your Comtrade

authorisation code in the box provided.  You only need to do this once, thereafter TradeSift will

use this code whenever you use the Comtrade direct download function.

Check Authorisation

To get your Comtrade authorisation code, click the link that says "Get Comtrade Authorisation
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Code".  This is a hyperlink to the following Comtrade web-page:

http://comtrade.un.org/ws/CheckRights.aspx

This page will check your IP address, and tell you whether or not you have access to Comtrade.

Get Authorisation Code

To check if you have authorised access to Comtrade, click the link that says "Check Comtrade

Access".  This is a hyperlink that will take you to the following Comtrade web-page:

http://comtrade.un.org/db/error.aspx

Note that this page will only work if you have a Comtrade subscription and your IP

address is recognised.  If not, the page will display what appears to be an error page.

Selecting Data to Load

To load data directly from Comtrade, select "Load Data from Comtrade" in the Data menu, or

from the "Load Data" panel group in the Navigator.  The screen is arranged in a similar manner

to all the data screens, and the process of selection is much the same as the selection process

for viewing data. 

Start by clicking on the first large button labelled "Nomen".  This will display the data selection

wizard dialog.  In the same manner as in all the standard data selection wizards (see more

detailed information in the section on Data Selection), make your selections in each page of the

wizard, and click the Next button to proceed to the next page.  
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After you have selected the nomenclature, digit-level, and the countries and years that you

would like to download, you will reach a panel which asks you to select the Flow Type. 

Comtrade trade data is available as Gross Imports and Gross Exports, or Re-Imports and Re-

Exports.  You can tick either one, or both.  Typically for normal trade data you would select

Gross.
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In the final 'Options' page, you can choose to split the file down by either reporter, partner or

year.  For large data requests this is recommended. Normally, this loading function will first

download CSV files to your computer, load the data directly in to your project, and then delete

the CSV files.  Once the data is loaded in to your project, you do not really need the CSV files,

however if you would like for the files to be kept and not deleted, the screen has an option to

keep these data files.  If this option is ticked, the will be saved in the following location: My

Documents\TradeSift Projects\My Projects\Project Name\Imported.
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When you reach the end of the data selection process, the final page in the data selection

wizard will show you a summary of your data selection.  At this point, you can still amend your

selection by using the Back/Next buttons, or by clicking on the options page you require in the

list on the left (for example Country, Partner, etc.)  When you are happy with your data selection,

click the Download button at the bottom of the wizard to start the data download from

Comtrade.

 Downloading the Data

When you have clicked the Download button as described in the previous step, the direct

download from Comtrade will begin.  This process first contacts Comtrade over your network

connection to download the data to your computer, and then the data is loaded in to your

project.  A dialog box is displayed to inform you of the progress of this process.  Keep in mind

that if you have requested a large volume of data, this stage could take some time.
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When the downloading and loading in to your project has finished, the progress dialog will

close, and the bottom of the main screen will show a number of tabs.  A log of the loading

process can be seen in the Log tab, you can check here for more information if any errors

occurred.  The Files tab shows a list of the intermediate files that were loaded in to your project.

 Perhaps the most important tab, is the Data Loaded tab, which shows you a summary of the

data that has been successfully loaded in to your project.

 Note: Country Groups

When downloading Comtrade data directly from within TradeSift, Comtrade will only support

queries on its standard countries and groups so you cannot use any of the reporter or partner

custom groupings shown under “My Country Groups” when using Comtrade's web-pages, even if

you have added those groupings into TradeSift with the appropriate codes as custom country

groups, (for example the World Aggregate group).  This is a technical limitation of the interface

that Comtrade provides - these groupings are simply not available via the direct download

method.  You can find a list of supported countries and groups at http://comtrade.un.org/db/mr/

rfReportersList.aspx where for example World is shown as being available as a partner only.
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5.1.3 Loading Custom Data

User Supplied Data

TradeSift is designed primarily for the use of trade data. Generally, data will come in a standard

format from sources such as Comtrade, WITS, TRAINS or Eurostat. It is also possible to use your

own trade data, provided that the nomenclature is a standard known nomenclature, and the column

headings conform to the standard column headings required by TradeSift.  Please see our Data

Files Guide for instructions on how to do this.

Tariff Revenue Data

TradeSift automatically calculates the implied tariff revenue from the standard tariff data loaded.

This is calculated as the tariff multiplied by the imports value, taken from the tariff data that you

loaded.   It is also possible to load your own tariff revenue figures. This can be done by simply

adding a column entitled 'TariffRevenue' to the tariff data file.  If you have loaded your own tariff

revenue data, TradeSift will display this where possible. If for some products/entries, you did not

load tariff revenue data, TradeSift will automatically fill this in with its implied revenue calculation

(imports value multiplied by the tariff).

Additional Data in Extra Columns

It is possible to load files in to you project which contain additional non-standard columns, and to

request that TradeSift loads the data in these extra columns along with the standard data in the file.

 For details, see the section on Loading Extra Columns.

5.1.3.1 Loading Extra Columns

Files with Extra Columns

When you load data from an external file, there is a minimum number of mandatory columns that

must be present in the file in order for TradeSift to be able to load the data.  The data columns are

described in the Data Files Guide.  However, if the data files contains any extra columns in addition

to the standard columns, you can choose if you would like these extra columns loaded.  The data in

the extra columns will appear in the data grids when you are viewing the data, and you can use

them for all the standard sorting, filtering, pivoting, top n, etc. functions.  The extra columns can

also appear in charts and tables. 

The following sections describe the procedure of loading extra columns in detail.

Choosing to Load Extra Columns

The data files should be loaded in the standard way as described in the section Loading Data

from Files.  If the file contains extra columns, the program will display a dialog box asking you if

you would like the data in the extra columns to be loaded or ignored.  
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Clicking on the More Info button will show the non-standard column names.

This dialog gives you three options:

Ignore all extra columns for all files – All the non-standard columns in all the files to be

imported will be ignored.

Load all extra columns for all files – All the non-standard columns in all the files to be

imported will be processed and loaded.

Ask me for each file – A further dialog will be displayed for each file that contains extra

columns, showing the extra columns, and allowing you to make a separate choice for each file

whether to load the columns.



Loading Data 101

© InterAnalysis Ltd. 2012

If you selected "Ask me for each file", the following dialog will be displayed:

This dialog gives you three options:

Ignore the extra columns for this file - The extra columns for this particular file will be

ignored and will not be loaded.

Load all extra columns for this file - The extra columns for this particular file will be

processed and will be loaded.

Select which extra columns to load for this file – Selecting this option will display a further

dialog where you can select which columns you want to import for the file.

 Selecting the Columns to Load

If you selected "Select which columns to load for this file", the following dialog will be displayed:
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In this dialog all the extra columns will be displayed in a list with a tick against each column. 

You can choose which columns you want to be loaded by ticking only the columns that you want

included.

Reviewing your Selections

You can determine which files have non-standard columns, and what those columns are by

looking at the File List.  The files with non-standard columns  will have “(Extra Columns)” in the

Comments field.  Selecting the file and clicking on the “Columns” button will display the Extra

Columns dialog for that file again, so that you can amend your choices.

 Viewing the Loaded Data

Once processed the extra columns will be visible in the data grid of the appropriate data

screen.  For example, if you loaded a trade data file with extra columns, the extra data will be

visible in the Trade Data screen.
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5.1.4 Data Files Guide

This section explains how external files must be formatted so that trade data can be loaded in to a 

TradeSift project.

File Formats

TradeSift can load data from external files, which can be either Excel (.xls, .xlsx), text files (.txt),

or comma-separated files (.csv).  Text files can either be tab-delimited, or comma-separated. 

All files must have column headings so that the columns can be identified. See the column

headings section below.

When using Excel files, only one worksheet can be loaded.  If your Excel file contains multiple

worksheets, the order in which they are found cannot be predicted, so we recommend that your

Excel files should only contain one worksheet, with your data in that single sheet.

 Data Sources

TradeSift can load extraction files from many data source, including the following:

Comtrade

WITS

TRAINS

BACI

Eurostat

Data from other sources can also be loaded, provided that the necessary column headings are

present.

Column Headings

In order for TradeSift to be able to recognize the data in the file to be loaded, the column

headings must conform to a standard.  Some columns are mandatory, and others are optional.

 As a minimum to be able to load the data, TradeSift must be able to recognize the

nomenclature, the reporter and partner countries, the year or time period, the product code,

the flow (imports or exports), and the trade value.

Since the column names from different data sources are not always exactly the same, the
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program will recognize variations in the column names to cope with files from the most

common source, (eg. Comtrade, WITS, etc.). However, we recommend that you use standard

column headings as shown in the table below.

Column Mandatory Optional Also Recognized

Nomenclature *   Nomen, Classification

ReporterCode

At least 1 of these

3

  Reporter

ReporterISO3    

ReporterName   ReporterDescription

PartnerCode

At least 1 of these

3

  Partner

PartnerISO3    

PartnerName   PartnerDescription

Year *   Period

ProductCode *  

Product, Commodity,

CommodityCode

ProductDescription   * ProductName

TradeFlow *    

TradeFlowName   * Trade Flow Description

TradeValue in 1000 USD *   Trade Value ($ '000)

Netweight (kg)   * Netweight

QuantityUnitCode   * QtyUnitCode

QuantityUnitDescription   * Unit, ShortName

Quantity   *

Trade Quantity, Supplementary

Quantity

Estimation Code   * Flag

Currency   *  

Units   *  

To load a file with tariff data, the same rules apply for the basic columns, (Nomenclature

through to Product in the table above), and in addition the following columns are recognized:

Column Mandatory Optional Also Recognised

DutyType *    

Simple Average At least 1 of these

2
   

Weighted Average    
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Imports Value   * Imports Value ($ '000)

Standard Deviation   *  

Minimum Rate   *  

Maximum Rate   *  

Nbr of Total Lines   *  

Nbr of DomesticPeaks   *  

Nbr of

InternationalPeaks   *  

Binding Coverage in %   *  

In all files, spaces and capitalization in column headings are ignored, so for example 

“ReporterCode” will be treated the same as “Reporter Code”  or  “reporter code”.  The order in

which the columns appear in the data file is not significant, they are matched up by the column

headings.  If the data file contains any extra columns that do not match any of the standard

headings, they will simply be ignored.

Country Codes

TradeSift uses 3-digit numerical codes to identify countries, (eg. the UK = 826) in accordance

with the standard codes that Comtrade uses.  The data loading routine can also recognise the

standard 3-character ISO3 country codes, (eg. the UK = “GBR”).  Ideally your data file should

contain columns called ReporterCode and PartnerCode containing the numerical codes for the

countries, or ReporterISO3 and PartnerISO3 containing the ISO3 codes.  When downloading

data from one of the standard sources, if you have the option to request country codes in the

output, it is always best to select this option.

If the file does not contain any country codes, but contains country names (in the Reporter and

Partner columns), TradeSift will attempt to look up the country name and translate it back to the

correct country code, which will then be assigned to that country data in your project.  Note that

because of possible differences in spellings of country names, this method is less reliable, and

using country codes is recommended.  

In the event that TradeSift cannot recognise the country code nor the country name, a new

internal code starting from the number 1000 will be assigned to whatever country name is in the

file, and that code will be used in your project.  Any codes assigned in this way can be viewed in

TradeSift in the “Custom Countries” screen, under the “Custom Data” section.  Note that custom

countries are specific to a project, depending on the data that you have loaded in that project.

You can view the standard lists of country codes in TradeSift using the “Countries” screen under

the “Reference Data” section, or you can find them online here:

http://unstats.un.org/unsd/tradekb/Knowledgebase/Comtrade-Country-Code-and-Name

Periodic Data

For data which is annual, the file must contain a column called “Year” or “Period”, containing the



TradeSift User Manual106

© InterAnalysis Ltd. 2012

year.  If you have any data which is for smaller time periods, the file must contain 2 columns,

one called “Year”, and another indicating the type of period, for example “Month”.  Allowable

column names for the period are:

Quarter

Month

Week

Day

The values in the second column must indicate the period, so for example for monthly data, the

“Month” column must contain numbers in the range 1-12,  for “Quarter” it would be 1-4, etc.

Nomenclature and Digit-Level

The data file should contain data for only one nomenclature.  If you need to load data for

different nomenclatures, split the data up in to different files.  The file should also contain data

for only one digit-level.  A file containing for example, HS 2-digit and 4-digit data, will be

rejected and cannot be loaded.

The product codes should all be the same length, and ideally should be padded with leading

zeros, to avoid any confusion over digit-levels.  For example, a file containing HS 6-digit data,

should contain product codes that are all 6 characters long, and the lower numbered products

which have 5 digits (like “10110”), should have a leading zero, (eg. “010110”).

Currencies and Units

The column heading of the trade value column usually describes the currency and units, for

example both “TradeValue in 1000 USD” and “Trade Value ($ '000)” will be recognised by

TradeSift, and the currency and units will be deduced from the column heading.  If the column

heading does not describe the currency and units, (for example “Trade Value”),  TradeSift will

assume that the currency is US Dollars, and that the units are in single units.  A warning

message will be displayed in the Warnings tab of the loading screen, to inform you that this

assumption has been made.  Units will always be converted to Thousands, which is how

TradeSift holds the trade values internally.

If you have a file where you want to specify the exact currency and units, you could add 2

columns with the headings “Currency” and “Units”, and populate every row with a value.  The

Currency column should contain a standard 3-character currency code, like “USD”, “GBP”, “EUR”,

etc.  The Units column should contain a number which indicates “how many zeros”.  So a value

of 3 for example, means 3 zeros, which means “Thousands”.  You can set the Units column

according to this table:

Description Units

Tens 1

Hundreds 2

Thousands 3

Tens of Thousands 4
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Hundreds of Thousands 5

Millions 6

Billions 7

 Files Sizes / Number of Rows

If you have a very large amount of data that you need to load, it is better to split the data up in

to a number of smaller files, and load them into TradeSift in a batch, rather than trying to have

all your data in one huge file, which will be slower to load.

Data Sorting

TradeSift loads the data by country first, then by year, and then by product.  In order to avoid

extra sorting in the program, which will slow down the loading routine, it is recommended that

your data file should be sorted by the following columns, in this sequence:

Nomenclature

Reporter

Partner

Year

Product

If your file is sorted in a different way, for example by product code first, then containing many

rows for all the countries for that product, be aware that this will be much slower to load in to

TradeSift, particularly for large sets of data.  When downloading data from your data source, if

you have any options for sorting, it is recommended that you sort the output in the order

specified above, before loading the file in to TradeSift.

Non-standard Data

TradeSift can load files for non-standard data, for example 8-digit data, provided that certain

conditions are met:

The column headings must conform to the standards already described

The general rules about not mixing digit-levels, product code lengths, etc. are all adhered to.

The nomenclature must be from a standard classification, eg. HS, SITC, BEC, etc.  (For a list of

the nomenclatures that TradeSift can load, please see the “Nomenclatures” screen under the

“Reference Data” section.)

If you load data for non-standard products, TradeSift will not have any product descriptions

pre-loaded for that data.  If your data file only contains product codes, and no descriptions, the

data will still load, but the product descriptions will be blank when you view the data in the

program.  When loading non-standard data, always try to make sure that the file includes

product descriptions.

If you load a file that does contain full product descriptions, these descriptions will be loaded

and added to a special table, which can be viewed in the “Custom Products” screen, under the
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“Custom Data” section.

Additional Data Columns

If the minimum requirements for the columns that must be present in a file are met, it is

possible to also add additional columns to the input file, and request that TradeSift loads these

extra columns.  When the data file is loaded, the loading process will recognize the extra non-

standard columns, and a message will be displayed to the user, asking for confirmation whether

you would like the extra columns to be loaded.  You can even choose individually for a

particular file, which columns to load and which to ignore.

If for example a file with trade data contained 3 additional columns, you could choose for these

columns and the data in them to be loaded.  When you then view trade data in the normal trade

data screen, the extra columns and data would be displayed side by side with the normal data. 

These extra columns can be shown or hidden using the usual method, and they can also be

used for all the standard data functions, such as pivoting, filtering, sorting, etc., and they can be

used as the basis for charts and tables.

The exact process for loading extra columns is described in the section on Loading Data

Requirements Summary

The following is a summary of the requirements for a data file to be able to load in to TradeSift:

Excel, TXT, or CSV. 

If Excel, only one worksheet.

As a minimum the mandatory column headers must be present in the file.

Column headers must conform to the standard names.

Do not mix nomenclatures in a single file.

Do not mix digit-levels in a single file.

Include country codes if possible as a preference over country names.

Keep the file sizes small, split large sets of data in to multiple files.

Sort the file by Nomenclature, Reporter, Partner, Year, Product.

If non-standard data, include product descriptions.
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5.2 Data Loading Types

TradeSift can load and process the following types of data:

 Trade Data - Trade in goods data.

 Services Data - Trade in services data.

 Tariff Data - Tariffs data.

 GDP Data - Gross Domestic Product data.

 WDI Data - World Development Indicators from the World Bank.

One important difference between the types of data, is that the first three in the above list are

stored in your project, and will only be available in that particular project, while the last two are

stored centrally, and once loaded will be available to all projects.

Trade, Services, Tariffs - Stored per-project.

GDP, WDI - Stored centrally as common data, available to all projects.

The general procedure for loading data from data files is the same for all data types - see Loading

Data from Files.

The remaining topics in this section describe any details which are specific to loading data for each

of the data types.

Loading Trade Data

Loading Services Data

Loading Tariff Data

Loading GDP Data

Loading WDI Data

Loading Product Names

Loading Product Groups

5.2.1 Loading Trade Data

The following topics describe how to load Trade Data in to your Project.

(For topics specific to Tariff Data, see Loading Tariff Data.)

 Loading Trade Data

To load Trade Data, select the Load Data option from the main menu, toolbar, or navigator. 

When the Data Loading Dialog dialog is displayed, click the Load Trade/Tariff Data from Files

button.

If you have a subscription to Comtrade, you can also load data directly in to your project by

accessing Comtrade online.  See Loading directly from Comtrade.

If you want to see an example data file with the required column headings for loading Trade

Data, first hover over the Load Trade/Tariff Data button so that the Help Info panel on the

right displays help information about Trade/Tariff Data, then click the View a file example

link-label at the bottom.
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After clicking the Load Trade/Tariff Data from Files button, the main File Loading screen will

be shown.

Trade Data can be loaded from external files (Excel, CSV, etc), following the same basic

procedure as described in the section Loading Data from Files.

See the following section for a description of the required file format of the data file.

 Trade Data File Format

To load Trade Data from external files, the data files must contain specific column headings, so

that TradeSift can recognise the data.

See the Data Files Guide help topic for a more detailed explanation of the required file format

and column headings.

TradeSift can load Trade Data that has already been aggregated into broader product

groups, (for example the Standard Product Groups available from Wits).  See the topic about 

Aggregate Products for more information.

5.2.2 Loading Services Data

The following topics describe how to load Services Data in to your Project.

 Loading Services Data

To load Services Data, select the Load Data option from the main menu, toolbar, or navigator.

 

When the Data Loading Dialog dialog is displayed, click the Load Services Data button.

If you want to see an example data file with the required column headings for loading Services

Data, first hover over the Load Services Data button so that the Help Info panel on the right
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displays help information about Services Data, then click the View a file example link-label at

the bottom.

After clicking the Load Services Data button, the main File Loading screen will be shown.

Services Data can be loaded from external files (Excel, CSV, etc), following the same basic

procedure as described in the section Loading Data from Files.

See the following section for a description of the required file format of the data file.

 Services Data File Format

To load Services Data from external files, the data files must contain specific column headings,

so that TradeSift can recognise the data.

The data file must contain the following column headings:

Year - The year for which the services trade figures

(Accepted alternatives: "Period")

Reporter - The Reporting country, this can be a country code or the country name.

(Accepted alternatives: "Reporter Code", "Reporter Name", "Reporter ISO3")

Partner - The Partner country, this can be a country code or the country name.

(Accepted alternatives: "Partner Code", "Partner Name", "Partner ISO3")

Service Code - The Service Code for the service data.  This should be the 3-digit numerical

code, not the EBOPS Code.

(Accepted alternatives: "Product", "Product Code")

Description - (Optional) The descriptive name of the service code.

(Accepted alternatives: "Product Name")
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Trade Flow - To indicate the Trade Flow of the Trade Value.  This column should contain

"Import" or "Export".

(Accepted alternatives: If the file does not contain a column that indicates the Trade Flow of the

Value column, it can instead contain two columns with the headings "Imports" and "Exports", or

"Imports Value" and "Exports Value")

Trade Value - The services Trade Value figure. See notes below about Currencies and Units.

(Accepted alternatives: "Trade ValueNetWeight (kg)")

Currency and Units
If the data file is recognised to be from the UN as in the example below, the figures are in US

Dollars and in Single Units.  TradeSift will load the trade values and store them in Thousands.  If

you load a data file from another source, you must be careful to provide column headings that

will indicate the currency and units.  

To specify a Currency, either indicate the currency in the trade value column heading, by setting

the heading to this format: "Trade Value in USD".

Alternatively, add a new column with the heading "Currency" and fill it with an international

currency code, e.g. "USD". 

If no Currency is specifically indicated, US Dollars will be assumed.

To specify the Units, either indicate the units in the trade value column heading, by setting the

heading to this format "Trade Value in 1000 USD".

Alternatively, add a new column with the heading "Units", and fill it with a number which signifies

the number of zeros (e.g. 3 = Thousands).

See the Data Files Guide for further details.

If no Units are specifically indicated, Single Units will be assumed, but the figures will be

converted to Thousands.  TradeSift always stores trade values in Thousands.

The following is an example of a Services Data Excel file from the UN:
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5.2.3 Loading Tariff Data

The following topics describe how to load Tariff Data in to your Project.

 Loading Tariff Data

To load Tariff Data, select the Load Data option from the main menu, toolbar, or navigator. 

When the Data Loading Dialog dialog is displayed, click the Load Trade/Tariff Data from Files

button.

If you want to see an example data file with the required column headings for loading Tariff

Data, first hover over the Load Trade/Tariff Data button so that the Help Info panel on the

right displays help information about Trade/Tariff Data, then click the View a file example

link-label at the bottom.

After clicking the Load Trade/Tariff Data from Files button, the main File Loading screen will

be shown.

Trade Data can be loaded from external files (Excel, CSV, etc), following the same basic

procedure as described in the section Loading Data from Files.

See the following section for a description of the required file format of the data file.

 Tariff Data File Format

To load Tariff Data from external files, the data files must contain specific column headings, so

that TradeSift can recognise the data.

See the Data Files Guide help topic for a more detailed explanation of the required file format

and column headings.

TradeSift can load Tariff Data that has already been aggregated into broader product groups.
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 See the topic about Aggregate Products for more information.

5.2.4 Loading GDP Data

TradeSift comes with GDP Data preloaded (in US Dollars from the World Bank), but you can load

your own GDP Data if you require.  

The following topics describe how to load GDP Data.

 Loading GDP Data

To load GDP Data, select the Load Data option from the main menu, toolbar, or navigator.  

When the Data Loading Dialog dialog is displayed, click the Load GDP Data button.

If you want to see an example data file with the required column heading for loading GDP Data,

first hover over the Load GDP Data button so that the Help Info panel on the right displays

help information about GDP Data, then click the View a file example link-label at the bottom.

After clicking the Load GDP Data button, the main File Loading screen will be shown.

GDP Data can be loaded from an external file (Excel, CSV, etc), following the same basic

procedure as described in the section Loading Data from Files.

See the following section for a description of the required file format of the data file.

 GDP Data File Format

To load GDP Data from external files, the data files must contain specific column headings, so

that TradeSift can recognise the data.

The data file must contain the following column headings:

Country Code
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Country Name (optional)

Year

GDP Value

If the file does not contain a column called Year, it can contain the GDP values arranged in

columns, where the heading of each column is the year.  The following is an example of a GDP

Data Excel file from the World Bank:

 GDP Options

To load the GDP Data, the program must know Currency that the GDP Data is in, which Units

the numbers are in, and whether the data is for Current GDP or Constant GDP. Since the GDP

import files do not always contain all the necessary information, the Load GDP Data process

has to prompt you to supply the Currency, Units and GDP Type to be applied to the files

being loaded.  You have the option of entering these values individually for each file or to apply

entered values to all remaining files.

Once the selected files have been validated the Select GDP Options dialog will be displayed.
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Currency - Select the Currency that the GDP Data in your data file is in.

Units - Select the Number Units that the GDP Data in your data file is in.

GDP Type -Select the GDP Type, which can be either Constant or Current.

If you are loading more than one file the values that you select can be applied to the other

remaining files to be loaded by selecting the apply checkbox.  If you leave the apply option

unselected you will be prompted to enter the values for the next file after clicking the OK button.

 Once you have set the GDP options for each file you can review them before loading the file by

examining the “Comments” field for each file in the File List.  If you notice that a value is

incorrect, to amend it you must select the file and remove it from the File List and then re-add

the file again via the large Files button.

 Note:

Please note that it is extremely important that you enter the correct values for the GDP Type,

Currency, and Units before starting the data loading, otherwise the data you load may be

incorrect.  For GDP Data that has come from the World Bank, select US Dollars and Single

Units.  The World Bank files which contain "KD" in the name are "Constant GDP", and the

ones that contain "CD" in the name are "Current GDP".

5.2.5 Loading WDI Data

TradeSift allows you to load World Development Indicators which are freely available from the

World Bank. (http://data.worldbank.org/indicator).

There are many different types of indicators available, which come in Excel or CSV files.  You can

download the data that interests you from the World Bank website, and then load the files into

TradeSift.  The loaded data can then be viewed and analysed, giving you access to all of

TradeSift's data manipulation features, including creating Tables and Charts.  The produced output

can then be used in your documents in the Report Writer just like with all other data.

 Loading WDI Data

To load WDI Data, select the Load Data option from the main menu, toolbar, or navigator.  

When the Data Loading Dialog dialog is displayed, click the Load WDI Data button.

If you want to see an example data file with the required column heading for loading WDI Data,

first hover over the Load WDI Data button so that the Help Info panel on the right displays

help information about WDI Data, then click the View a file example link-label at the bottom.
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After clicking the Load WDI Data button, the main File Loading screen will be shown.

WDI Data can be loaded from an external file (Excel, CSV, etc), following the same basic

procedure as described in the section Loading Data from Files.

See the following section for a description of the required file format of the data file.

 WDI Data File Format

WDI Data can be loaded from an external file (Excel, CSV, etc), following the same basic

procedure as described in the section Loading Data from Files.

The WDI Data file must contain the following column headings:

Country Code

Country Name (optional)

Indicator Code (In the World Bank Excel files this is shown in the second sheet, in CSV files it

is a column).

Indicator Name (optional)

Year

Value

If the file does not contain a column called Year, it can contain the WDI Data values arranged in

columns, where the heading of each column is the year.  The following is an example of a WDI

Data Excel file from the World Bank:
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5.2.6 Loading Product Names

TradeSift comes pre-loaded with the product names of the most common nomenclatures.  When

you load trade data for a known nomenclature such as HS, even if the file only contains product

codes, when you view the data the associated product names will be displayed, because TradeSift

has the product names already loaded.  If you are using TradeSift in another language, the

product names will still appear in English.  It is possible to load product names in another language

if you want, and set TradeSift to use the product names that you loaded in another language.

The following topics describe how to load foreign language Product Names in to TradeSift.

 Loading Product Names

To load product names in another language, select the Load Data option from the main menu,

toolbar, or navigator.  

When the Data Loading Dialog dialog is displayed, click the Load Foreign Language Product

Descriptions button.
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After clicking the Load Foreign Language Product Descriptions button, the main File Loading

screen will be shown.

Product Names can be loaded from external files (Excel, CSV, etc), following the same basic

procedure as described in the section Loading Data from Files.

See the following section for a description of the required file format of the data file.

 Product Names File Format

You can load your product names from an Excel file, CSV or TXT file.  The file must contain the

following column headings:

Language - This column must contain a 2-character language code to indicate which

language the descriptions are in. (For example "fr" for French).  

   For a list of the standard language codes, see http://msdn.microsoft.com/en-us/library/

ee825488(v=cs.20).aspx. You should use the first two lower-case characters in the column

"Language Culture Name".

Nomen - This column must indicate the nomenclature of the product code names being

loaded.

Product - The product code that the product name is being loaded for.

Product Name - The full descriptive product name in the foreign language.

The following image shows an extract of an example file with French product names for S3.
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 Viewing Foreign Language Product Names

Once you have loaded product names in another language, you must change a program setting

for TradeSift to use the foreign language product names in all the data screens.

Select Program Settings from the Tools menu, and go to the Language options page.  Tick the

option Use Default Product Names.

See for Language Settings further details.  Note that after changing any settings for the user

interface language, or for the product names language, you must first restart TradeSift for the

new language settings to take effect.

After loading the product names and changing the program options language setting, the new

product names will be displayed in the data screens if they are available.  If you view data for

nomenclatures for which you have not loaded foreign language product names, the normal

English names will be shown.

5.2.7 Loading Product Groups

TradeSift comes pre-loaded with some standard Product Groups, for example the HS TDC

Sectors, and others.  You can load your own Product Group definitions into TradeSift, which you

can then use in your data selections to group products together, or to view figures summed up to 

Product Group totals.

TradeSift refers to the different sets of Product Group definitions loaded, as Product Group

Schemes.  For example, the HS TDC Sectors is one scheme of product groups.  Each Product
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Group Scheme contains multiple Product Groups, and each Product Group contains multiple

Products.

To see which Product Group Schemes are loaded, use the Product Groups screen in the Reference

Data section.

See the section about Industry Selections to learn how to use Product Groups when viewing data.

The following topics describe how to load your own Product Group definitions in to TradeSift.

 Loading Product Group Definitions

To load your own Product Group definitions, select the Load Data option from the main menu,

toolbar, or navigator.  

When the Data Loading Selector dialog is displayed, click the Load Product Group Definitions

button.

You can also load Product Group definitions directly from the Product Groups screen, by

clicking the Import button on the screen's toolbar.  

After clicking the Load Product Group Definitions button, the main File Loading screen will be

shown.

Product Groups can be loaded from external files (Excel, CSV, etc), following the same basic

procedure as described in the section Loading Data from Files.

See the following section for a description of the required file format of the data file.

 Product Group Definitions File Format

You can load your own Product Group definitions from an Excel file, CSV or TXT file.

The file must contain the following column headings:
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Group Scheme - The name of the Product Group Scheme.  You can use any name you like

here.  This name is what you will use to select this Product Group Scheme when making data

selections.

Nomen - The Nomenclature that the Product Group definitions are for.  When you make

data selections, this Product Group Scheme will only be available when viewing data for

products which belong to the nomenclature specified for this Product Group Scheme.

Digit Level - The Digit-Level that the Product Group definitions are for.  When you make

data selections, this Product Group Scheme will only be available when viewing data for

products with the Digit-Level specified for this Product Group Scheme.

Product - The Product Code for the specified Nomenclature and Digit-Level, which belongs

to a Product Group. Multiple Products can belong to the same Product Group.

Product Group - The Product Group Code that the Product belongs to.  You can define any

codes you like here for your Product Groups.

Group Name - Each Product Group has a code and an associated descriptive name.  The

previous column is the Code, (usually a short code), and this column is the descriptive name

of the Product Group.

The following image shows an example of a Product Group Scheme defintion file in Excel:

 Viewing Data with Product Groups

To see a list of all the loaded Product Group Schemes and to view the structure of the Product

Groups and their Products, use the Product Groups screen in the Reference Data section.

When making a data selection in any of the data or indicator screens, if you want to view

products grouped together by Product Group, use the Industry Selection panel in the Data

Selection Wizard, and select the option for Selected Product Groups.  See the section about

Industry Selections for further details.
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In the Product Group Selection dialog, you can select the Product Group Scheme you want to

use, and then either select to view all Products Groups, or only specific Product Groups.  After

selecting which Product Groups you want to view, you can either choose to see all Products

within each Product Group, or you can sum the values for every Product in a group, to

produce a single total figure for each Product Group.  To view only the Product Group totals,

tick the option for Product Group Totals Only in the Product Group Selection dialog.

This is how the data looks when Products are shown per Product Group:

This is how the data looks when you request Product Group Totals Only:
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5.3 Checking Data Availability

TradeSift provides two screens to check which data you have loaded in your project:

The Loaded Data Summary screen shows a hierarchical summary view of all the data loaded in

your project.

The Data Loading Log screen shows a chronological log of all the data files that you have loaded

in to your project.

5.3.1 Loaded Data Summary

You can check which data has been loaded in your project by using the Data Summary screen,

accessed via Data > Data Summary on the Main Menu, or in the Load Data panel group in the

Navigator. This screen allows you to review the data that you have already loaded into your

project.  When you first open the Data Summary it may take a few moments to populate the various

filters if you have a very large project. The sections below describe how to use the Data Summary

screen.

Data Type, Nomenclature, and Country Filters

All the dropdowns to the left of the horizontal bar filter the amount of data that will be loaded

into the grid.  You need to select at least one of these filters before you can load any data,

although it is recommended that you select the Data Type and at least the Nomen and either

a Reporter or Partner.

Selecting any option in the  dropdowns to the left of the horizontal bar will reload all the other

dropdown filters with options that are only valid for the selected item.  For example selecting a 

Reporter will repopulate the Data Type, Nomen, Partner, Digit-Level and Year filters with data

that is only associated with the selected Reporter.  You can use this feature to quickly check

whether you have loaded data for a particular Partner or Nomen for the reporter without

having to populate the pivot grid.

Once you have selected at least one filter option, but preferably at least the Nomen and either

a Reporter or Partner, the Get Data button will be enabled and will blink to signify that the

pivot grid is not displaying your current filter selection.  Click the Get Data button to load the

pivot grid. Once the grid has loaded the selections used to retrieve the data will be shown on
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the right-hand side of the filter panel.

Digit-Level and Year Filters

The filters to the right of the vertical bar only filter the data in the grid rather than filter what

data is loaded.  Selecting a specific Digit-Level or Year will immediately filter the displayed

data.  If you change the Nomen, Reporter or Partner filter the displayed data will not change

instead the Get Data button is re-enabled and will blink to signify that the filter selection does

not match the displayed data.

Expanding and Collapsing Columns

All columns can be either collapsed or expanded by clicking on the Collapse/Expand button

that is under the Reset button.  By clicking this button, the Collapse/Expand will be applied to

all columns and all levels in the hierarchy.  You can also choose to expand or collapse an

individual column by right-clicking in a column, and use the grid's built-in options for collapsing/

expanding that will be displayed in the popup menu.

Reset and Country Buttons

The Reset button will clear all the filters and close the pivot grid view.

The Country button  allows you to change the value’s displayed in the pivot grid for the

reporters and partners.  If you have a lot of data loaded into the grid it may take a moment or

two for the change to take effect.

5.3.2 Data Loading Log

The Loading Log screen shows a chronological listing of all the files that you loaded in your

project.  You can access this screen via Data > Loading Log on the Main Menu, or in the Load

Data panel group in the Navigator.  This is useful if you need to check what you have loaded, or if

you are unsure whether a certain file has been loaded yet or not.  For a more detailed and

hierarchical view of the actual data loaded in your project, use the Loaded Data Summary screen.
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6 Viewing Data

This chapter describes how to view and work with Data that you have loaded in to your Projects.

Topics covered in this chapter

 Viewing Data

Screen Layout

Data Selection

Pivoting Data

Display Options

 Data Screens

Trade Data

Services Data

Tariff Data

GDP Data

WDI Data

 Data Topics

Aggregation

Aggregate Products

Rest of World

 Exporting & Printing

Exporting & Printing Data
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6.1 Viewing Data

Once you have loaded some data in to your project, you can view your data and apply various

sorting, filtering, and pivoting functions to the data.  All of the screens in TradeSift which allow you

to view data, share a common approach for how to select the data, how to arrange or pivot the

results according to your requirements, and how to create graphs and charts.   

You can access the Data screens via the Main Menu, the Toolbar, or the Navigator.

Main

Menu

ToolBar Navigator

Project Data Topics

The following topics are explained in this chapter.

Screen Layout - An overview of the common layout of the project data screens.

Data Selection - The procedure for selecting and viewing data.

Pivoting Data - How to re-arrange the data grid and pivot data.

Display Options - A description of the display options panel and functions that can be applied to

the data.

This chapter is concerned with how to select and view the data in a data grid, and how to arrange

and pivot that data.  For information about creating Charts and Tables from this data, see these

topics:

Creating Charts

Creating Tables

6.1.1 Screen Layout

Any data which you have loaded can be viewed using dedicated screens which are in the Data

group.  Each type of data has its own screen, however although the specific columns and data

items which are displayed may vary between different types of data, the general layout of these

screens is the same for all types of project data, and the procedure for using these screens is the

same.  This common approach applies for example to Trade Data, Services Data, Tariff Data,

GDP Data, etc. and also to all Indicator screens.

This section gives you an overview of the layout of the project data screens.  

The exact procedure for selecting and displaying data is described in the section on Data Selection.

The details of how to re-arrange and apply various functions to the displayed data is described in
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the section on the Display Options.

 Data Screens Layout

The image below shows the general common layout of all the project data screens. The

following sections explain each of these screen areas in detail.

Toolbar

The small toolbar across the top of all data screens provides a row of buttons for common

operations, like saving and recalling data selections, exporting, printing, etc.  There are also 3

buttons to show/hide specific panels on the screen below.

 Open - Open a previously saved data selection or project item.

 Save - Save changes to an already saved project item.

 Save As - Save the current project item, supplying a name.

 Export - Export the data/item to a file.

 Print - Print the current data/item directly.

 Print Preview - Print the current data/item via a Print Preview dialog.

 Show/Hide Buttons - Toggle the display of the large data selection buttons on and off.

 Show/Hide Info Panel - Toggle the display of the Info Panel on and off.

 Show/Hide Display Options Panel - Toggle the display of the Display Options Panel on

and off.

The 3 Show/Hide panel buttons can be used to temporarily hide the large buttons and panels

at the top of the screen, to make more space for the data grid.  The image below shows which

button corresponds to which screen section.
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Data Selection Buttons

The 5 or 6 large buttons are to make your data selection, to choose which data you want to

display (or in the case of indicator calculations to choose the details of your calculation).  The

process of using these buttons to make your data selection is described in detail in the section

on Data Selections.

Info Panel

The Info Panel shows a summary of your data selection, the countries and years, and so on. 

The panel also shows the currency and units of the data, the source of the data, the method

used to aggregate the data values, and the number of rows.

Display Options Panel

The Display Options Panel contains a set of controls for changing the way the data is

displayed in the data grid.  It has options for selecting which columns are visible, and functions

for sorting, filtering, limiting, showing change and percentage change, and for showing column

and row totals.  The function of each control is explained in detail in the section about the 

Display Options Panel.

 Data, Log, and Help Tabs
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In the lower part of the data screens, there is a tab control with a number of tabs.  

Data - When the requested data has been fetched, it will be displayed in a grid in the first

tab, the Data tab, which will be labeled according to which data screen you are using, for

example "Trade Data".  

Log - The Log tab shows a list of logging messages from the process of fetching the data or

calculating the indicator.

Warnings - If any problems were encountered, messages with further details will be

displayed in the Warnings tab.

Help - The Help tab shows the relevant page from the User Manual which relates to the

current screen.

Concepts - In some cases there may be a Concepts tab which shows the relevant conceptual

help page from the Concepts Manual.

Data Grid

The Data Grid at the bottom of the screen (also called a Pivot Grid) is where the requested

data will be displayed in a grid, arranged in columns and rows.  The data can be re-arranged

by pivoting columns, which is described in the section on Pivoting Data.  The data can also be

sorted, filtered, limited, etc. using advanced options which are described in the section about

the Display Options Panel.

6.1.2 Data Selection

To start viewing data, select the relevant data screen from the Main Menu under Data, for

example Trade Data or Tariff Data, or select the same option in the Navigator in the Project

Data panel group.  The procedure for calculating indicators is very similar to the procedure

described here for viewing data, however this is covered in greater detail in the section on 

Indicators.

The following sections describe the data selection process in detail.

 Data Selection Buttons

When you open any of the data screens, you will see a row of 5 or 6 data selection buttons

across the top of the screen. Each of these buttons relates to a general area of the data

selection that you will make, the exact buttons will vary from screen to screen, but typically they
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include: Nomenclature, Country, Partner, Years, Industries.

The first time you make a data selection, these areas must be selected in the same sequence as

the buttons, so the first button will be enabled, and the others will initially be disabled. To get

started you should click the first button,  Nomen, and this will bring up a Data Selection

Wizard, which will take you step by step through the process of making your data selection.

Data Selection Wizard

The Data Selection Wizard has a number of steps on the left hand side, which correspond to

the main data selection buttons. The selection page for each step contains a header section with

a short descriptive text to help you.  You can progress through the steps either by using the

Next and Back buttons at the bottom of the wizard screen, or by clicking on the name of the

step on the left. Each step will display a panel on the right hand side with the fields that you

must fill in to make your data selection.  As you are making your selections, the data selection

buttons on the main screen will become highlighted in turn, to indicate the current step.
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The panel on the left which shows the names of the data selection steps, also has a small icon

to the right of the step name, to indicate the status of each step as follows:

 The step has not yet been completed.

 This is the current step, with its corresponding page displayed on the right.

 The step has been completed.

The first time you start the data selection process, only the first step will be enabled, and the

subsequent steps will become enabled one by one as you progress through the steps.  The

reason for this is that displayed values which you can choose from are based on the data that

you have loaded in your project, and on your selections in the previous steps.  For example,

when you start at the Nomen step, all nomenclatures for which you have loaded data in to your

project will be displayed.  If you then select "H1" and "6-Digit" and proceed to the second step,

Country, only reporter countries for which you have loaded H1 6-Digit data will be displayed.  If

you then select say "GBR" as the country and then proceed to the third step, Partner, only

partner countries for data that you have loaded for H1, 6-Digit, and GBR as reporter, will be

displayed.  This process continues in the same manner in all the steps.  The options that are

displayed are always based on your previous selections and what is available in your project.

Once the steps have become enabled, you can move freely backward and forwards between the
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steps to modify you selection by using the Back and Next buttons.  You can also jump directly to

a step by clicking on the name of the step in the left-hand panel.  You can continue to modify

your selection in this way until you have made the selection that you require.

All Data Selection Wizard dialogs always have the following buttons at the bottom of the dialog:

Help Button - Click this button to display context-sensitive Help about the current wizard

page.

Back Button - Go Back to the previous step in the data selection procedure.

Next Button - Move forward to the Next step in the data selection procedure.

Show Button - When the data selection is complete, the Show button will become enabled. 

Click this button to fetch and Show the requested data.  (When doing indicator calculations,

this button will say "Calculate" instead of "Show".)

Cancel Button - Cancel your current data selection losing any amendments you have made,

and close the Data Selection dialog.

 Info Panel

Below the Data Selection Buttons on the main screen, there is an Info Panel which displays a

summary of your data selection.  As you progress through the steps in the Data Selection

Wizard, the Info Panel will gradually fill up with information about your data selection.  This

means that as you are making your selection, you can keep an eye on the Info Panel to see a

quick summary of what you have selected so far.  

When you have finished your data selection and the data has been fetched and displayed, some

additional informational fields will be displayed in the Info Panel, to provide the following

information:

Currency - The currency of the monetary values.

Units - The number units of the monetary values.

Data Source - The source of the data.

Data Method - The aggregation method that was used to fetch the data, for example if it is a

2-Digit aggregate calculate from 6-Digit source data.

Total Rows - The number of rows being displayed in the grid.

Warning - Possible warning message.

You can collapse/expand the Info Panel by clicking on the small white triangle in the title bar of

the panel.  

When collapsed, the panel title shows an abbreviated one-line summary of the data selection.

You can completely hide Info Panel from view by clicking on the Show Info Panel button the

screens main toolbar.  

Clicking the button again will display the Info Panel again.
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 Nomenclature and Digit-Level

In the first step of the Data Selection Wizard, you choose the Nomenclature and Digit-Level

for the data that you want to view.  Only nomenclatures for which you have loaded data will be

selectable.  (For a more general explanation of Digit-Levels, see the topic about Aggregation.)

This page has the following controls:

Nomenclature - To select the Nomenclature for the data that you want to view.

Digit-Level - To select the Digit-Level at which the data should be shown.  If you select a

digit-level which is more aggregated than the actual data loaded, the program will

automatically aggregate the data values for you.  For example if you have loaded 6-Digit

data, and you request to view 2-Digit data, the program will aggregate the 6-Digit values

up, and show you summaries at the 2-Digit product level.  (See Aggregation.)  If you have

loaded data for Aggregate Products, instead of a Digit-Level you will be offered the option

to select "Aggregate Products".  (See Aggregate Products.)

Sample - The Sample box will show the first few products and descriptions of the selected

nomenclature and digit-level, to give you a quick idea of the kind of product code you will

see.  If you make a single click on the selected nomenclature but without changing the

selection, the Sample box will change to a description of the currently selected nomenclature.

Flow Type

In many cases, the Flow Type data selection button and wizard step will not be shown.  Flow
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Type refers to the type of imports and exports, which distinguishes between the following three

types:

Net - Net Imports and Net Exports

Gross - Gross Imports and Gross Exports

Re - Re-Imports and Re-Exports

If you have consistently loaded Trade Data for only one Flow Type in your project (this is

recommended), then the Flow Type button and step will not even appear, as there is no choice

to be made.  The Flow Type selection will only appear if for the Nomenclature and Digit-Level

that you selected in the previous step, the program finds loaded data for more than one Flow

Type.  In that case, you will have to make a choice and select the Flow Type that you want the

data to be shown for.

This page has the following controls:

Flow Type - To select the Flow Type for the data that you want displayed.  More than one

can be ticked, to show several sets of data.

All Button - Clicking the All button will tick all the flow types that are displayed.

None Button - Clicking the None button will untick all the flow types.

Info Panel - Displays a scrollable explanation of the difference between the flow types.

 Reporter Country

In the Country step of the data selection, you select the main Reporter country.  You can select
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multiple reporters.  You can either select multiple reporters and one partner, or one reporter

and multiple partners, but you cannot select multiple reporters and multiple partners as this

could create a huge matrix of data.

This page has the following controls:

Country List - Displays the list of available Reporter countries.  Select the countries you want

by ticking them.

All Button - Clicking the All button will tick every country in the list.

None Button - Clicking the None button will untick all countries in the list, leaving none

selected.

World Button - If World is available as a reporter country, clicking this button will tick World

in the country list.

Home Button - If you have defined a Home country and it is available in the list, clicking this

button will tick that country.  To set a country as your Home country, tick it in the list of

countries first, then click the dropdown triangle on the Home button, and select "Save ticked

as my Home Country" from the context menu.

Favourites Button - If you have defined one or more lists of Favourite countries, clicking this

button will tick those countries in the country list if they are available.  To save a list of

countries as a list in favourites, tick the countries first, then click the dropdown triangle on the

Favourites button, and select "Save ticked as a country selection" from the context menu.

Find Button - Click the Find button to display a popup panel with advanced find options. 

This panel is explained below.

Quick Find - Type the first letter(s) of the country you want to find, and the first country in the

list that matched will be highlighted.
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Find Panel

When you click the Find button, a popup panel will be displayed with more advanced options

for finding a country than the Quick Find offers.

Find By Code - Enter a numerical country code or an ISO3 country code (for example 826 or

GBR), to find the corresponding country in the country list.

Find By Name - Enter part of the country name that you want to find.

Filter List - Enter a character or partial country name, to filter the list to show only the

countries that match.  For example if you enter "EU", only countries in the list that contain "EU"

somewhere in the name will be displayed.  The background colour of the country list changes

to a solid colour to indicate that the list is currently filtered and is not displaying all countries.

 The filter will stay in effect even if you close the Find popup panel, so to remove the filter,

click on the small x inside the Filter List box.

Show Selected - If the country list contains a very long list of countries, it is possible that the

ones which you have ticked are not all visible on the screen at the same time, and you would

have to scroll down the long list to find the ones that have been ticked.  If you click "Show

Selected" in the Find popup panel, the country list will temporarily change to show only the

countries which are currently ticked.  This provides you with a way to get a quick view of the

selected countries in a long list.

Close - Use this button to close the Find popup panel.

 Partner Country

The Partner step of the data selection is where you choose the Partner country for the data

that you want to see.  The layout of the selection page is the same as for the Reporter country. 

You can select multiple partners, provided that you have selected only one reporter in the

previous step.  You cannot select multiple reporters and multiple partners as this could create a

huge matrix of data.
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This page has the following controls:

Partner List - Displays the list of available Partner countries.  Select the countries you want

by ticking them.

All Button - Clicking the All button will tick every country in the list.

None Button - Clicking the None button will untick all countries in the list, leaving none

selected.

World Button - If World is available as a partner country, clicking this button will tick World

in the country list.

Home Button - If you have defined a Home country and it is available in the list, clicking this

button will tick that country.  To set a country as your Home country, tick it in the list of

countries first, then click the dropdown triangle on the Home button, and select "Save ticked

as my Home Country" from the context menu.

Favourites Button - If you have defined one or more lists of Favourite countries, clicking this

button will tick those countries in the country list if they are available.  To save a list of

countries as a list in favourites, tick the countries first, then click the dropdown triangle on the

Favourites button, and select "Save ticked as a country selection" from the context menu.

Find Button - Click the Find button to display a popup panel with advanced find options. 

This panel is explained in the section on selecting a Reporter: Find Panel.

Quick Find - Type the first letter(s) of the country you want to find, and the first country in the

list that matched will be highlighted.

Years

The Years step of the data selection allows you to select the range of years for which you would
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like data displayed.  All the years which are available in your loaded data for the nomenclature

and countries that you have selected in the previous steps will be shown in the list.

This page has the following controls:

Years List - Displays the list of available Years.  Select the years you want by ticking them.

All Button - Clicking the All button will tick every year in the list.

None Button - Clicking the None button will untick every year in the list, leaving none

selected.

Favourites Button - If you have defined one or more lists of Favourite countries, clicking this

button will tick those countries in the country list if they are available.  To save a list of

countries as a list in favourites, tick the countries first, then click the dropdown triangle on the

Favourites button, and select "Save ticked as a country selection" from the context menu.

 Industries

The Industries step allows you to optionally specify which industries (or product codes) you

would like included in the data that will be displayed.  By default, all industries will be displayed,

and this is indicated by the option button "All Industries" being selected in the options panel.  If

you want all industries/product codes to be displayed and you do not want to make a more

specific selection, you do not need to select anything on this page, just click the Next button to

proceed to the next step.
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This page has the following controls:

Industry Selection Mode - This options group has 4 options for different methods of

selecting which products should be included.  The process of making an industry selection is

explained in detail in the section on Industry Selections.

Industry Info Panel - The panel below the options group displays a summary of the type of

industry selection, and the number of products that have been selected.

Summary

The final step in the data selection process shows a Summary panel.  There are no selections to

be made here, this step just shows you a summary of all your choices in the previous steps. 

You can review the summary, and decide whether you would like to make any amendments, or if

you are ready to request the data.  If you would like to change any of your selections, use the 

Back button to go back to any of the previous steps, or go directly to the step that you want to

change by clicking on the name of the step in the left-hand panel.

If you are happy with your data selection, click on the button at the bottom of the dialog, which

will say Show for data screens, or Calculate for indicator screens. The wizard will then close,

and the requested data will be fetched, or the calculation will be carried out.  A progress box

will display in the meantime, and when the operation is complete, the results will be displayed in

a data grid below the Info Panel.
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Progress Display

After you have clicked on the Show button, the data you have requested will be fetched, or in

the case of an indicator calculation, the indicator results will be calculated.  Depending on the

amount of data that you requested (see the section on Data Volumes), this step could take a bit

of time, so a progress dialog is displayed to inform you of the progress of the task.  If you

need to cancel the operation, you can click the Cancel button.
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Modifying the Data Selection

After you have completed the Data Selection Wizard for the first time and data has been

displayed in the data grid, you may want to make some changes to your data selection, and

update the data display.  At this stage, all of the large Data Selection Buttons across the top

of the screen will be enabled, to indicate that a completed data selection has been made.  If you

want to modify only one area of the data selection, it is not necessary to repeat all of the steps

of the data selection process again in sequence.  You can jump straight to the area of the

selection that you want to change, by clicking on the relevant Data Selection Button.

For example, suppose that after fetching the initial data, you decide that you want to add

another year which you did not initially select.  Just click on the large Years button, and the Data

Selection Wizard will open up, displaying the Years step.  You can modify your years selection,

and then you do not need to click Next, the Show Data button should already be enabled, and

you can directly click on it to update the data.  The program will fetch the data again using your

modified data selection, and display the new data in the data grid.

You can jump straight to any of the data selection steps in this way, by clicking on the large

button in the main screen that corresponds to the area you want to change.  Once the Data

Selection Wizard is open, you can also modify other areas, and move freely between them

using the panel on the left or the Back/Next buttons, and then click Show Data when you have

modified your selection.
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Default Values

If you find yourself frequently selecting the same values every time you make a data selection, it

is possible to set up some default values in your project.  For example, say you are always

selecting GBR as the reporter country, and you are always working with the years 2000-2005. 

You could define those values as defaults, and then every time you make a data selection, those

value will be automatically selected for you.  This is subject to the data being available, so in the

example given, "GBR" would only be automatically selected in the list of reporters if it is actually

available in the loaded data.  The selection fields that you can set default values for are:

Nomen

Digit-Level

Reporter Country

Partner Country

Year Range

For details about how to define project defaults, see the topic on Project Settings.  

If you want the default values function switched off, there is a setting for this in the Program

Settings screen.

 Data Volumes

As you are making your data selection, keep in mind the volume of data that your selection may

return, and try to make selections that will not return an excessive number of rows.  For

example, the HS classifications contain around 5000 products at the 6-Digit level.  If you select

just one reporter, one partner, and one year, at the 6-Digit level, the data grid will be filled with

5000 rows.  If you were to select a period of 10 years, that will be 50,000 rows, which will
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probably be quite slow to fill the data grid, and subsequent operations to sort and manipulate

the data in the grid may also be slow.  When working with 6-Digit data it is best not to make

data selections for too many countries or years.  If you need to work with many countries and

years, consider using a more aggregated Digit-Level such as 2 or 4 digit, or a different

nomenclature, such as BEC.

The following is a guide to approximately how many product lines (rows) there are at different

digit-levels for the common classification systems:

BEC SITC HS CN ISIC

 Total Trade 1 1 1 1 1

 1-Digit 7 10

 2-Digit 14 66 96 99 32

 3-Digit 8 262 72

 4-Digit 1023 1255 1744 145

 5-Digit 2652

 6-Digit 5959 7324

 8-Digit 19072

When you get to the end of your data selection, the final Summary page in the data selection

wizard will show you the estimated number of rows that will be returned if you proceed.

If your data selection is likely to return a very large number of rows which could take a long

time, TradeSift may warn you before fetching the data, so that you have the possibility of

reducing the size of your data selection.  The number of rows that produces the warning is set

in the Max Selection Size field on the Options page of the Program Settings screen.   If you

want to completely disable this warning, set the limit to zero.
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6.1.2.1 Industry Selections

In the Industry Selection step of the Data Selection Wizard, it is possible to choose specifically

which industries or product codes you would like included in the data that will be displayed in the

data grid.  Making an industry selection in this step is optional, by default all industries for the

selected nomenclature will be included.  (Note that "all industries" refers to all the product codes

that you have actually loaded in to your project.  If you have loaded a sub-set of the total products,

obviously TradeSift cannot display the product lines that are not loaded.)  

The following sections describe how to make industry selections.

Industry Selection Mode

When you reach the Industry Selection step, the following options group is displayed:
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There are four options to choose from:

All Industries - The All option is the default, and means that all industries/products will be

included.

Selected Industries - The Industries option allows you to choose exactly which product

codes should be included.

Selected Product Groups - The Product Groups option allows you to choose products which

belong to predefined product groups, according to several different grouping system.

If you want all products to be included, you don't need to do anything, you can just leave the

default value of "All Industries" selected, and click on the Next button to proceed to the next

step.  If you click on any of the other options which allow you to choose specific products, a new

button will be displayed below the options group.  The button will be labelled according to the

option that you chose, for example "Selected Industries".
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Clicking on the wide Select Industries button will display the Industry Selection dialog.

 Selecting Industries

When you have chosen the Selected Industries option in the options group of the Industries

step in the Data Selection Wizard, and then clicked the Select Industries button below it, the

following Industry Selection Dialog will be displayed:
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The Industry Selection Dialog displays a hierarchical tree-list view of the products that belong

to the nomenclature that you selected in the first step of the data selection.  Each node of the

tree-list can be expanded or collapsed by clicking on the little +/- buttons to the left of each

product.  The products may initially be displayed with the higher-level product groups

collapsed, for example in the above screenshot, the 6-Digit level has been selected, but the

tree-list initially shows the list collapsed to the 2-Digit level.  Look at product "05" to see how it

can be expanded to show the 4-Digit level, and then further to the 6-Digit level.

Selecting Products
To select a product to be included in your data selection, just tick it to the left of the product

code.  If you select a product at a higher level of aggregation, all lower level products

belonging to that group will also be ticked/unticked.

 Click the All button to tick all the products in the list.

 Click the None button with the black cross to untick all the products in the list.

 To cancel the Find operation and clear the Find box, click on the Cancel button with the

blue cross.

Finding Products
To find a product, enter the name you want to search for in the Find box at the top of the

dialog.  Select a value from the In dropdown control, to specify whether you want to search in

the Product Code column of the tree-list, or the Product Name.  You can enter a partial
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product name, or a partial product number.  The first line in the list which matches what you

have typed, will be highlighted in the tree-list.  Use the Back/Next buttons to move between and

highlight products that match what you have searched for.

 Click the "Back" button to jump back to and highlight the previous product that matches

your search.

 Click the "Next" button to jump back to and highlight the previous product that matches

your search.

Filtering Products
When you are finding products, the tree-list always displays all product codes, but you can also

filter the list to display only products which match your search.  

 To filter the list, type in the text that you want to filter on in the Find box, and then click on

the Filter button with funnel icon.  The tree-list display will be filtered.

 When a filter is in operation and not all product codes are being shown, the Filter button

icon will turn orange.  To switch off the filter, just click the Filter button again.

 To cancel the Filter operation and clear the Find box, click on the Cancel button with the

blue cross.

The Filter can be useful to select all products that match a certain search criteria by using the

following method:

1. Click on the None button so that no products are ticked.

2. Enter the text that you want to match on in the Find box, for example "petrol".

3. When the list is filtered, click on the All button so that all the currently visible and filtered

products will be ticked.

4. Click the Filter button again to turn off the filter.  All products will be displayed again, but

only products that contain the word "petrol" will be ticked.

Selecting Product Groups

When you have chosen the Selected Product Groups option in the options group of the

Industries step in the Data Selection Wizard, and then clicked the Select Product Groups

button below it, the following Product Group Selection Dialog will be displayed:
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The tree-list displays higher-level groupings of products by Product Groups.  There are a

number of pre-defined product group schemes, so you must first select which scheme you want

to use from the dropdown at the top of the dialog.  Once you have selected a product group

scheme, the tree-list will display the product groups for that scheme, and the products that

belong to each group.

This dialog functions in exactly the same way as the Industry Selection Dialog.

The procedure for selecting product groups is the same as for selecting industries, and finding,

recalling, deleting and renaming selections works in the same way.

Product Group Totals Only - Below the list of Product Groups is an option labelled "Show

Totals per Product Group only in the data results".  When this option is not ticked (the

default), after fetching the data, the grid will show data for every Product, and show which

Product Group it belongs to.  If you tick this option, the values for every Product in each

Product Group will be summed, and the grid will show a single total figure for each Product

Group.
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 Applying the Industry Selection

When you have finished making your Industry Selection by ticking the products that you want

included, close the Industry Selection Dialog by clicking the OK button.  A small panel the in

the Industries page of the selection wizard will show some summary information about your

industry selection.  The Info Panel on the main screen will also tell you how many products are

selected, and if the number of products is small enough to display, it will also actually list the

selected product codes.

When you complete the data selection process and click on the Show button (as described in

the section on Data Selection), the data will be fetched, and only the selected products will be

displayed in the data grid.  (If you are doing an industry calculation, only the selected products

will be used as the input for the calculation.)
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Saving Industry Selections

After making an Industry Selection, you may want to save that list of product codes for future

use, so that you don't have to manually find the products again every time you want to use the

same selection.  

To save an Industry Selection, first tick the products that you want included in the Industry

Selection Dialog, as described in the section on Industry Selections.  Then click the Save button

at the bottom of the dialog.  Another smaller dialog will be displayed, prompting you to enter a

name for your industry selection, and some optional comments.  Click the Save button in this

dialog.  Your industry selection will be saved using the name you supplied, and a confirmation

message will be displayed to inform you.  

From this point on, you can re-use that saved industry selection in the future when you want to

do any data selections or calculations for only those particular products.  See the section on 

Recalling Industry Selections.
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 Recalling Industry Selections

There are two ways to recall an Industry Selection that you saved previously. 

1. In the Industry Selection step of the Data Selection Wizard, when you select one of the

modes in the options group (other than All Industries), the Select Industries button will become

visible.  You can click this button as before to open the Industry Selection Dialog, but if you want

to just quickly recall a saved selection without entering the dialog, click the little dropdown

triangle on the right-hand side of the button instead of clicking in the middle of the button.

When you click on the arrow on the button, a dropdown panel will display with a list of your

saved industry selections.
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To select one of the industry selections, click on the name of the selection and then click on the 

Open button, or just double-click on the name of the industry selection you want to use.  The

label on the button will change to show the name of the industry selection, and a panel will

below tell you how many products have been selected.  You can now proceed without needing

to open the Industry Selection Dialog at all, but if you want to see exactly which products have

been selected, you can click the button to open the Industry Selection Dialog, and the list of

products in the tree-list will tick the products that correspond to the industry selection you just

recalled.

2. The other way of opening a saved Industry Selection is from inside the Industry Selection

Dialog.  When the you have opened the Industry Selection Dialog by clicking the Select

Industries button, the bottom of the dialog has a wide button labeled Selections, which

functions in the same way as the Select Industries button described above.  Click on the little

triangle on the right of the button to display a dropdown panel with a list of your saved

selections.  To recall a selection, click on the name of the selection and then click the Open

button, or just double-click on the name of the selection you want to use.  The label on the

button will change to show the name of the industry selection, and the list of products in the

tree-list will tick the products that correspond to the industry selection you just recalled.

 Deleting and Renaming Industry Selections
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Once you have built up a collection of saved Industry Selections, you may sometimes want to

delete or rename them.  To delete or rename a saved selection, you must first recall it as

described in the section Recalling Industry Selections.  After recalling the selection, you can use

the Delete and Rename buttons at the bottom of the dialog.

Delete - A dialog will ask you to confirm that you really want to delete the saved selection. 

Click OK to delete it.

Rename - A popup dialog will prompt you to enter a new name for the selection.  Enter the

new name and click OK.

6.1.3 Pivoting Data

All of the main data screens in TradeSift where you view your project data or calculate indicator

results, display the data in the bottom section of the screen in a data grid.  These data grids are

referred to as a Pivot Grids.  Pivot Grids have many features for controlling how the data is

displayed, and for pivoting the data so that the arrangement of columns and rows can be changed

to give you a different view of the data.  Many of these features can by accessed via the grid itself,

by dragging and dropping, or by right-clicking in certain areas of the grid and accessing popup

context menus.  Some of these features can also be accessed via the Display Options Panel which

appears above the grid, and this panel also contains many more features which can only be

accessed from that panel.

This section explains the layout of the pivot grid, and how to organise and pivot data in the grid.

Other features of the grid and more advanced options for manipulating the data in the grid are

explained in the section on the Display Options Panel.

 Pivot Grid Layout

The following image shows the general layout of the pivot grid.

Layout
The grid is layed out in columns and rows, similar to a spreadsheet.  Each field has a Data
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Header corresponding to each field in the source data.  The width of any column or cell can be

adjusted by grabbing and dragging the vertical dividing line between columns.

Row Area
The Row Area fields to the left (with a pale blue background), are the key data fields which

define what the numerical values displayed in the cells to the right correspond to.  For example

if the numerical data values are showing values per product, per year, per partner, the Row

Area fields will show Partner, Year, Product, as in the example above.

Data Area
The Data Area is the cells to the right (with alternating yellow/pale blue backgrounds) which

contain the numerical data values that correspond to the Row Area fields on the left.  There can

be any number of columns in the Data Area.

Column Area
The Column Area at the top right, above the Data Area, is where Data Headers are displayed

for any fields which you have pivoted.  If the grid is not yet pivoted, there will be a single Data

Header, with the label "Data".  You can think of "Data" as meaning "All the fields in the Data

Area".

Data Headers
Every field that is displayed in the grid has a corresponding Data Header.  The Data Headers

are the rectangles with rounded corners containing the field name, at the top of the grid.  In

some cases the Data Header can also contain a triangle icon used for sorting, and a funnel icon

used for filtering.  Sorting and filtering are explained in the sections on Data Sorting and Data

Filtering.  Notice in the screenshot example above, that the 3 fields in the Data Area, Import

Value, Exports Value, and Trade Balance, have corresponding Data Headers in the top left

corner of the grid.  If the full name of the field in the Data Header is not visible because of lack

of space, hover the cursor over the Data Header, and the full field name will be displayed in a

popup tooltip.

 Moving Columns

A powerful feature of the Pivot Grids, is that you can re-arrange the layout of the grid and

pivot the data in many different ways.  As explained in the section on the Pivot Grid Layout,

every field in the grid has a Data Header, which are the rounded panels containing the field

names:

The key to re-arranging the pivot grid, is to grab the Data Header with the mouse pointer, and

drag it to the desired location.  For example, to change the order of the columns in the Row

Area, just grab the Data Header of the field you want to move, and drag it to the new location.

 In the image below, you can see the Year data header being dragged to the right to reposition

it.  As you drag it, two white arrows will appear to indicate where the column will be when you
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drop it, (in the example shown, it will be between the Product and Product Name columns).  If

instead of the white arrows, a black cross appears, that means you are hovering over an area

where the column cannot be dropped.

After moving the Year column, the grid appears as in the image below.  Notice that the fields in

the Row Area are hierarchical, so before moving the Year column, the grid showed every

Product listed as subordinate to every Year.  After repositing the Year column, the grid shows

every Year listed as subordinate to each Product.

 Collapsing and Expanding Columns

The layout of the fields in the Pivot Grid is hierarchical, with the columns in the Row Area

arranged from left to right in the order of the hierarchy.  You can collapse or expand columns

to reduce the number of rows in the grid, and to make the grid show summary or total values

for a particular value of a column in the Row Area.  Right-click inside a column in the Row Area,

and select either Collapse or Expand from the popup menu.  If you select just Collapse or

Expand, only the particular cell that you clicked in will be affected.  If you select Expand All or

Collapse All, all values in the column will be affected.  For example, in the image below, if you
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clicked on Collapse in the cell for 2001 in the Year column, only the Products that belong to the

value 2001 would be collapsed.  If you clicked on Collapse All, every single year in the Year

column would be collapsed.

In the image below, Collapse All has been selected for the Year column.  All the Row Area

fields which previously appeared to the right of the Year column (which means they are lower

down in the hierarchy) are no longer displayed, and each year has been collapsed down to just

one row.  The values in the cells in the Data Area are total values.  So the Imports Value for

2001, is now showing a sum of all the Products that have been collapsed down to one year.

You can collapse any of the columns in the Row Area.  In the image below, Collapse All has

been selected for the Partner column.  The grid has now collapsed down the values even

further, and only one row is showing per Partner.  The data values in the Data Area show the

total for each Partner.

By using Collapse or Expand instead of Collapse All or Expand All, you can choose
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individually exactly which cells you want collapsed or expanded.  In the image below, the 

Partner and Year columns have both been collapsed completely, but the cell for Partner "USA"

has been expanded on its own.

 Pivoting Columns

In the same way that you can re-order columns by dragging and dropping field Data Headers

(described in the section on Moving Columns), you can also re-arrange the way the data in the

grid is pivoted, by dragging the Data Headers.  To pivot the data by a particular field, you grab

and drag a Data Header from the Row Area, and drop it on the Column Area.  

To demonstrate how the pivoting works, it is easier to start with an example where only one

field is visible in the Data Area.  In the following image, only the Exports Value field is visible in

the Data Area.  (How to choose which columns are visible is explained separately in the section

on the Display Options: Column Visibility.)  In this example, there is data for the years 2000-

2005, although in the screenshot you can only see the first few products for the year 2000.  The

years 2000-2005 appear vertically in the Year column, followed by every product for each year.  

If you wanted to pivot the grid by Year, to see the Exports Value in columns with one column

per year, you would grab the data header for the Year field, and drag it over to the Column

Area above the data cells, and drop it on the text which says "Drop Column Fields Here".  The

white arrows will appear when you can drop the field.
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After dragging the Data Header for the Year field to the Column Area, the grid will now be

arranged with one column per year, with the Data Area cells showing the Exports Value for

each year, as shown in the image below.

The Column Headings of the cells in the Data Area change to a name made up of the pivoted

field (the year) and the data field in the cells of the Data Area (Exports Value), to indicate

exactly what each column is showing, for example "2000 Exports".  The Year column is no

longer in the Row Area because it has been moved to the Column Area, and there is now only

one row per Product.

 Pivoting with Multiple Data Area Columns

In the previous example there was only one field in the Data Area before the Year column was

pivoted.  However you can pivot fields in the normal way by dragging them to the Column

Area, even if the Data Area contains multiple columns.  In the image below, there are 3 fields in

the Data Area: Imports Value, Exports Value, and Trade Balance.
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To pivot by Year, drag the Data Header for the Year field from the Row Area, and drop it in

the Column Area, either before or after the Data Header labeled "Data".  This Data Header

refers to the 3 fields in the Data Area in the cells below.  Whether you drop the Year field

before or after the "Data" header will produce a different result.  In this first example, it is

dropped to the Left of the Data Header.

After dragging the Year column and dropping it to the left of the "Data" header in the Column

Area, the data in the pivot grid is pivoted as shown in the image below.  A new column or

group is made for each year, and then within each year, the 3 original Data Area columns are

shown.  The pivot grid now shows all 3 data fields for 2000, then the same 3 data fields again

for 2001, and so on.

When the Data Header for the Year field was dragged over to the Column Area, it could also

be dropped After the "Data" header instead of before.  

This produces a different result, and reverses the hierarchy of the fields.  When the data is

pivoted in this way, the 3 original data fields appear across the top in columns, and every

individual year appears repeated inside each of the data fields.
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Pivoting Multiple Columns

You can pivot the data by more than one field.  The procedure is the same as described in the

section Pivoting Columns.  Drag the Data Header for the first field that you want to pivot by,

and drop it in the Column Area.  Then drag the Data Header for the second column that you

want to pivot by, and drop it in the Column Area, deciding whether you want to position it

before or after the first field.  Changing the order of the Data Headers affects the order of the

data fields in the hierarchy of the grid.  In the image below, the Partner and Year fields have

been dragged and dropped in the Column Area.  The order of the 3 Data Headers is: Partner,

Year, Data, which is reflected in the way the data cells below are organised.

After pivoting the grid in this way, you can change the hierarchy of the columns by dragging the

Data Headers in the Column Area, and changing their relative positions.

In the image below, the order of the Data Headers for the Year and Partner fields has been

swapped.  Now the data cells show the Year first, then every Partner within each Year, and then

every data field within each Partner.
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6.1.4 Display Options

After making a Data Selection and displaying project data in a grid, there are many options for

manipulating the data and changing how it is displayed.  The data can be pivoted, sorted, filtered,

limited, totalled, and various other operations can be applied.  

The process of making a Data Selection is described in the section on Data Selections.

How to Pivot the data in the grid is described in the section on Pivoting Data.

Below the Info Panel in every project data screen, there is a Display Options Panel with a set of

controls which are used to make changes to the way the data in the grid is presented.  The Display

Options Panel is shown in the image below.  

The topics in this section explain all the controls in the Display Options Panel.  The following

topics are covered:

Choosing Columns

Formats: Countries, Units and Decimals

Data Sorting

Data Limiting

Data Filtering

Change and Percentage Fields

Summary Types

Row and Column Totals

Layout and Find Functions

6.1.4.1 Choosing Columns

When data is first displayed in the data grid after you have made your data selection, the program

initially displays the most important columns.  In many cases there are more data columns available

in the underlying data, and you can choose to show those columns.  You may also want hide any

columns that you do not need.  There are two ways to customise which columns are visible in the

grid:

From the Columns Panel in the Display Options panel.

Using a Popup Menu from the Data Grid itself.
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The following sections describe both methods.

Selecting Columns via the Columns Panel

Quick Column Buttons

The Columns Panel inside the Display Options Panel contains a number of pre-configured

"quick" buttons, to allow you to easily switch on and off the visibility of the most common

columns in the data grid.  The labels on these buttons will be different depending on which data

screen your are using, for example in the Trade Data screen, the buttons will be set up for the

most important data columns for trade data (as shown in the image below).  For Tariff Data,

GDP Data, Indicators, etc., the buttons will be set up differently, for the columns which are

appropriate for the type of data.

Each button has an "on" and "off" state.  The buttons can be turned on and off just by clicking

on them, and they will change state.  The buttons are blue when they are off, and they glow

orange when they are on. (If you have changed the colour scheme that the program is using,

these colours may be different.)  Each button may control the visibility of a single column or a

group of columns in the data grid.  For example in the Trade Data screen, The Balance button

controls only the Trade Balance column, but the Imports button controls the columns Imports

Value, Imports Rank, and Imports Share, and the Exports button controls the columns Exports

Value, Exports Rank, and Exports Share.  As soon as you click a button to switch the display of

its columns on or off, the data grid will immediately be update and show or hide the relevant

columns.

There a useful keyboard shortcut if you want to display only one columns in the data area of the

grid.  Suppose you want only the Exports column to be visible.  Instead of switching off all of

the other buttons, just hold down the Control key on your keyboard, and while still holding the

key down, click on the Exports button.  This will switch off all the other buttons, and select on the

Exports column.

Column Selection Popup

The Quick Column Buttons described above only control the visibility of the most common

columns, but there could be many more columns in the underlying data which you may want to

customise.  You can choose exactly which columns should be visible by using the Column

Selection Popup.  Click on the small down arrow in the box that says "Columns (n)".  The

number n in brackets indicates how many columns are currently visible.  When you click on the

arrow, the following popup panel will be displayed:
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This panel will display a complete list of every single data column in the underlying data.  The

columns which are currently visible in the data grid are ticked.  The columns which are not

ticked, represent data columns which are in the underlying data, but which are not currently

visible in the data grid.  To customise which columns should be shown in the data grid, simply

tick the columns that would like to be visible.  The data grid will not be updated until this popup

panel is closed.  

All - The All button ticks every column in the list.

None - The None button unticks every column in the list.

OK - The OK button closes the popup panel and updates the data grid, showing the columns

that you selected.

Cancel - The Cancel button cancels any changes you have made and closes the popup,

without updating the data grid.

Selecting Columns via the Data Grid

The visibility of columns in the Data Grid can also be controlled by using popup context menus

in the data grid itself.  To quickly hide a single column, right-click anywhere in the column that

you want to hide.  You can click on the Column Header, the Data Header, or in a Cell of the

column.  Click on Hide Column on the popup menu which appears, and the selected column

will be hidden from view.
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lf you want to change the display of more than one column, right-click in the dark blue area

above the data grid, and select Show Field List from the popup menu.

The following popup window will be displayed:

This dialog shows a list of columns in the top box, and then below it has four panels which

represent the areas of the grid that you can assign columns to.  To assign a column to an area

of the grid, grab and drag the column, and drop it on the panel that corresponds to the area of
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the grid where you want to position the column.  This means that this method allows you not

only to show or hide columns, but also to control how the grid is arranged and pivoted.

6.1.4.2 Countries, Units and Decimals

The Formats Panel in the Display Options has three buttons which are used to change the display

formats of certain fields in the data grid.

The three buttons each display a dropdown panel when clicked on, with a list of options for you to

choose from.  The option that is currently in effect appears as ticked.  To change the format, click

on the desired option to tick it, and the new option will be applied to the grid.  The function of each

of the buttons is explained in the following sections.

Country Display

The Country button controls the format for displaying countries.  When you click on the button,

a dropdown panel displays a list of the country formats you can choose from.  Not that if you

change this setting, the data will have to be reloaded before the new settings is used.  A

message will ask you if you want to reload the data immediately.

 Tip:

You can set your preference for the default Country Format that you want to be used, in the 

Program Settings dialog.  The Display Options Panel will automatically set the Country Format

to the setting in the Program Settings, however you can still override the setting by using the

Country button.

Number Units

The Units button controls the format for displaying numbers in the cells of the data grid, for

monetary values.  You can choose between Thousands, Millions, and Billions.  This setting

only affects columns which are monetary values, such as imports and exports for trade data, or
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trade balance, etc.  It has no affect on other numbers such as ranks, shares, tariffs, etc.

 Tip:

You can set your preference for the default Numbers Units that you want to be used, in the 

Program Settings dialog.  The Display Options Panel will automatically set the Number Units

to the setting in the Program Settings, however you can still override the setting by using the

Number Units button.

Decimal Precision

The Decimals button controls the number of decimal places shown for numbers in the cells of

the data grid.  This setting only affects columns which are monetary values, such as imports and

exports for trade data, or trade balance, etc.  It has no affect on other numbers such as ranks,

shares, tariffs, etc.  

To change the decimal precision of other columns, right-click on any cell in the Data Area of the

grid, and select Increase Precision or Decrease Precision from the popup menu.
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 Tip:

You can set your preference for the default number of Decimal Places that you want to be

used, in the Program Settings dialog.  The Display Options Panel will automatically set the

Decimal Places to the setting in the Program Settings, however you can still override the

setting by using the Decimal Places button.

6.1.4.3 Data Sorting

The data in the grid can be sorted either by using the sort controls in the Display Options panel,

or by using controls on the Data Grid itself.  

Both methods are described below.

Sorting from the Display Options Panel

The Sort Panel in the Display Options contains 3 controls:

Sort - The Sort field controls which Row Area field of the data grid should be sorted.

By - The By field controls which Data Area field of the data grid controls the sorting.

Order - The Order field controls whether the values should be sorted Ascending or

Descending.

For example, if you set Sort to Product, By to Exports, and Order to Ascending, the rows in the

data grid would sort the Product column by the numerical values in the Exports Value column in

ascending order.  

The column that you select for Sort is indicated in the grid by changing the label in its Data

Header to bold text. (See Product in the image below.)  

The column that you select for By is indicated in the grid by two triangles which are displayed

in the column header of the column whose values are used for the sorting. (See Exports Value

in the image below.)  

The option that you select for the sort Order, Ascending or Descending, is indicated in the
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grid by a triangle symbol displayed in the Data Header of the Sort column.  The Sort Order

is indicated by the direction of the triangle.  You can change the Sort Order either by

changing the Order control, or just by clicking on the triangle to reverse the order.

Sorting from the Data Grid

The Data Grid can also be sorted by using functions built into the grid itself.  Right-click on any

cell in the Data Area of the grid to display a popup menu with a number of sorting options, for

example "Sort 'Product' By This Column".  A Sort option will be displayed for each of the

columns that are currently present in the Row Area of the grid.  The column that you will be

sorting By is the column that you clicked on to display the context menu.  The column that will

be sorted, depends on the which option you select from the popup menu.

After you have chosen a column to sort from the popup menu, the Data Grid will be sorted. 

The Data Headers and Column Headers display symbols to indicate which columns are

controlling the sorting, as described in the section on Sorting from the Display Options Panel. 

The controls in the Sort Panel of the Display Options will also be updated to reflect the current
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sorting.

6.1.4.4 Data Limiting

The Display Options Panel has a powerful feature for limiting the number of rows displayed in the

data grid, so that you can home in on the top or bottom values.

The controls for this feature can be found in the Limits Panel:

The following sections explain how to use the Limits Panel.

 Limit Controls

The data grid will initially display all the rows for the data you requested (for example all

products or all countries).  The Limits Panel allows you to choose a data field that interests

you, and set the grid to display only the top or bottom values, where you can choose how many

rows the grid should be limited to.  To set up the data limiting, the panel has the following

controls:

Limit - The type of Limit to be applied, Top or Bottom.

N - The Number of rows to limit the data grid to.

Field - The data Field in the Row Area that the row limiting should be applied to. 

By - The data field in the Data Area that the data is limited By, and for which the top or

bottom values are evaluated.

For example, if the grid is showing 5000 product rows, and you would like to see what the top

10 exporting products are, you would set the limit fields as follows:

Limit: Top

N: 10

Field: Product

By: Exports

The following image shows the grid with the above settings applied, so that the grid is showing

the top 10 exporting products:
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The grid is limited to display only 10 rows, and the products are sorted in descending order of

the Exports Value column, with the highest value shown first.  The Info Panel displays some

information in the top right corner to show the limit that is being applied.

To remove the limit, set the Limit control back to None.

In the previous example the limiting was applied to the Product column, but the limiting can be

set on any column in the Row Area of the grid, depending on the data that you are viewing.  In

the following example, the Trade Data screen was showing the UK's exports in 2008 to over

200 partner countries.  The limiting was then set for the Partner column and on Exports Value,

so that the grid then shows the Top 10 Partner countries that the UK exported to in 2008.
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Quick Limit Buttons

The four Limit controls described in the section on Limit Controls allow you to set exactly how

the data limiting should be applied to the data grid.  The Limit Panel also has two Quick Limit

buttons which are a shortcut to quickly setting up a data limit for the most import data fields for

the data you are viewing.  These 2 buttons are pre-configured to always apply a Top 10, and

the 2 data columns that they apply the limit to will be different depending on the data screen. 

For example, in the Trade Data screen, they are set up to limit Imports and Exports.

When you click one of the Quick Limit Buttons, the Limit controls in the panel will be set up

and the limit will be immediately applied to the data grid.  In the Trade Data screen for

example, clicking the Top Exports button will immediately limit the data grid to the Top 10

Exports, and there is no need for you to manually set any of the limit controls.  When the Limit

is On, the Quick Limit Button will change its colour and glow orange, to indicate that the

limiting is switched on.  To switch the limiting off, just click the button again.

Limit Ranges

If the data in the grid has not been pivoted, and the values for the data column that you would

like to apply the limiting to appear in the grid in a single vertical column, then the limiting can

easily be applied to that column as described in the examples in the sections on the Limit

Controls and the Quick Limit Buttons.  However if the grid has been pivoted such that the same

value field appears in multiple columns side by side, the limiting becomes more complex,
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because the top or bottom values will be different for each column.  (See the topic on Pivoting

Data.)  For example, if the grid is showing products for 3 different Partner countries, and the

grid has been pivoted by the Partner column to show the Exports Value for every Product for

the 3 Partners, the grid will look like this:

There are 3 columns for the 3 Partner countries, and each column is showing the Exports Value

for each Partner.  There is only one row per Product.  Clearly, the Top 10 Export Products for

the World, will not be the same as for Canada or for the USA, so it is impossible for the grid to

show the Top 10 for all 3 Partner countries when the grid is pivoted in this way.  In this

situation, if you apply a Top 10 limit, there are 2 possibilities for how the limit can be applied. 

The limiting function can either sum the Exports Value of the 3 countries and display the Top

10 as an average across the 3 countries, or you can choose which of the 3 countries you want to

see the Top 10 for.

When the grid is pivoted in this way and there are multiple columns that the limiting could apply

to, the Limit Range Button becomes enabled in the Limit Panel:

The Limit Range Button allows you to decide how the Top or Bottom limit should be applied

to the pivoted data.  Click on the Limit Range Button to display a dropdown list of options. 

The list will allow you to choose either for the limit to be applied as an average across all

values, or to specify precisely which column (in this example, which Partner country) to apply the

limit to.  In this example, the dropdown would show the following options:

When the limit is first applied, the Limit Range setting defaults to calculating the limit Averaged

across the columns.  To change this so that the limit is applied to a specific column, select the

required column from the list.  In this example, if you select Top Exports World, the limit will be
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applied to the Exports Value only in the column for World, and the grid will show the Top 10

Products exported to the World.

 Saving Limit Selections

After you have applied a Limit to the data in the grid, you may want to save the list of Top or

Bottom items, so that you can use that list in future Data Selections.  For example, if you have

set up a limit which is showing a list of Top 10 Products, you can save that list of 10 products

codes.  That list could then be used as an Industry Selection when you are viewing data in

other screens.  (The procedure is explained in the section on Recalling Industry Selections). 

Note that a list of items saved in this way can be used in data screens which are for a different

type of data than the screen in which the selection was saved.  This means that you could for

example view Trade Data, limit to the Top 10 Products, save that list of 10 product codes, but

then use those 10 product codes as an Industry Selection when calculating an Indicator.

Since the limiting can be applied to any column in the Row Area, (not just on product codes),

this functionality can also be used on other columns such as Countries.  If the data limit is

limiting to the Top 5 Partners, saving the limit selection would save the 5 country codes for

those Partners.  This saved selection of Partner countries is saved as a Favourite list, and it can

then be used when making future Data Selections to recall those 5 countries.  The process of

recalling a saved selection  is explained in the section on Country Favourites.

To save a selection of the limited items, you must first apply the Limit either by using the Limit

Controls or one of the Quick Limit Buttons.  A button will then become enabled in the bottom

right corner of the Limit Panel, with an image showing a list and a green save icon.

Click the Save Limit button, and a dialog will prompt you to choose a name to describe the list

of limited items.  A name may be suggested based on the data that the limit is currently applied

to, but you can type over that and choose your own save name.

Click Save, and the list of items will be saved under the name you chose.
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6.1.4.5 Data Filtering

The data in the grid can be filtered to pick out only certain data values of interest, without needing

to change your Data Selection and fetch the data again.  Filtering is achieved by a combination of

controls in the grid itself, and the Filter Panel inside the Display Options Panel.

The following section explains how to work with Filters.

Applying a Filter

Setting up a Filter
Filters can be applied to columns in the data grid by making use of the Data Headers above

the Row Area columns.  Filters can only be applied to columns in the Row Area.  Each Data

Header has the name of the column, followed by a triangle symbol which indicates the direction

of the sorting, followed by a Filter Button, which is small button with a a funnel symbol.  

When you click on the Filter Button a dropdown panel is displayed, which lists all the unique

values for that column.  At the top of the panel is a Filter Type control, which has two possible

settings:

Show selected values

Hide selected values

You can change this setting depending on the number of items in the list, and whether it is

easier to choose the items that you want to include or exclude.  

If the Filter Type is set to Show selected values, every item in the list is initially ticked, and you

can untick the items that you do not want shown in the grid.

If the Filter Type is set to Hide selected values, every item in the list is initially unticked, and

you can then tick the items that you want to hide.
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After changing the ticked items in the filter dropdown panel to reflect how you would like the

data filtered, click on the OK button to close the panel and to apply the Filter.  The rows in the

data grid will be updated and the filter will be applied.  Any rows that have been filtered out by

the way you set up the filter, will be hidden from view.  If the data grid is showing any totals, the

totals will also be updated to show summaries of the rows that are actually visible in the grid.

Multiple Filters
You can set up Filters on more than one column, and the effect of the Filters will be combined.

 For example, you could set the Filter on the Year column to show the years 2000 to 2005, and

set another Filter on the Product column to exclude certain product codes, and then the grid

would only show rows for the years 2000 and 2005, but also excluding the specified product

codes.  You can set up combinations of Filters on any number of columns in the Row Area.

Removing Filters
To remove any filters that you have applied, you can click on the Filter Button again in the Data

Header of the column that has the Filter, and either manually tick/untick the items, or make use

of the first item in the list, which will be Show All or Hide All, depending on the Filter Type. 

There is also a quicker way to remove Filters by making use of the two buttons in the Filter

Panel inside the Display Options Panel.  These buttons are described in the next section.

Filter Panel Buttons

The Filter Panel inside the Display Options Panel contains three special buttons used for

controlling the filtering.

Filter - The Filter button is used to quickly turn the current filtering On and Off.

Clear - The Clear button is used to completely cancel and remove all filters that have been set

up.

Info - The Info button is used to display details of the current Filter.

Filter Button
It is important to note that these two buttons have no effect before any filters are in place, they
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only have any use if you have first applied some filtering to the data in the grid, as described in

the previous section on Applying a Filter.  After you have set up a filter, the Filter Button in the

Filter Panel will glow orange to indicate that the button is On, and that a Filter is in operation. 

If you want to temporarily disable the Filter but without destroying the filter setup, you can just

click the Filter Button to turn the Filter to Off.  The Filter will be disabled, all rows will be

shown again in the grid, and the button will no longer be orange to indicate that the Filter is

Off.  However the settings that you defined previously for the filter are not lost.  Clicking the

Filter Button again will switch the same Filter back On, without the need to set up the

individual filter values again, and the grid rows will be filtered as before.

The Filter Button is also used in conjunction with the Find Button, for details see the section on

the Find Function.

Clear Button
The difference between the Filter Button and the Clear Button, is that the switching off a filter

using the Filter Button only temporarily disables it, but does not clear the filter settings,

whereas the Clear Button completely removes all filters and all filter value settings.  If you want

to remove all filtering that is in effect, use the Clear Button.

Info Button
When a Filter or several filters are in operation, the Info Button provides a quick way to get a

information about which columns are being filtered and using which values.  Click the Info

Button, and a dropdown panel will be displayed with information about the current Filter.
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6.1.4.6 Change and Percentage Fields

The Change Panel inside the Display Options Panel provides controls for adding columns to the

grid which calculate Change or variation values, and percentage values.

The following sections describe how to work with Change Fields.

 Change and Percentage Functions

The Change Panel allows you to use special functions for calculating Change values between

columns or cells in the data grid.  There are two controls which are used to set up the Change

Fields:

Change Type - The Change Type is used to set the type of change or variation that should

be calculated.

Change Field - The Change Field is used to set which column in the data grid the change

values should be calculated from.

The Change Type setting has 6 possible modes that you can choose from:

Change Per Column

Percentage Change Per Column

Percentage of Column

Percentage of Row

Total Change

Total Percentage Change

To enable a Change Field, select one of the Change Types from the dropdown list, and select

the Change Field that you want the values to be calculated from.

When these two controls have been set, the new Change Field will be calculated and will be

displayed in the data grid.  To switch the Change function off, set the Change Type to None.  

The following sections show examples for each of the Change Types.

Change Per Column

The Change Per Column function can only be used if the data grid has been pivoted, so that
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the same underlying data field appears across multiple adjascent columns.  For example, if only

the Exports Value column is visible in the Data Area. and then the grid is pivoted by the Year

column, the grid will show a number of columns side by side, one for each Year, where the data

in all the columns and cells represents the Exports Value.   (See the topic on Pivoting Data.)   In

this situation, the Change Per Column function can be used to show the change in the Exports

Value from one Year to the next.

Percentage Change Per Column

The Percentage Change Per Column function works exactly the same as the Change Per

Column function, the only difference is that it calculates the change from one column to the next

as a Percentage, rather than an absolute value.

Percentage of Column

The Percentage of Column function calculates the percentage of each cell as a percentage of

the total of the column (the sum of all the cells in the column).  The percentages are displayed in

a new column next to the column that the percentages are calculated from.  To use this function,

set the Change Type to Percentage of Column, and set the Change Field to the field that you

want the percentages calculated from.  In the example below, the Percentage of Column

function shows what the percentage of each Exports Value is as a percentage of the total of

the Exports Value column total.
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Percentage of Row

The Percentage of Row function calculates the percentage of each cell in a row, as a

percentage of the total of the row (the sum of the all the cells in the row).  This function can be

used when the grid has been pivoted, so that the underlying data field in each column is the

same, for example if you have pivoted by year, and every column is showing the same field for

each year.  The calculated Percentage of Row values are displayed in a new column placed

after the each column that the values were calculated from.  To use this function, set the Change

Type to Percentage of Row, and set the Change Field to the field that you want the

percentages calculated from.  In the example below, the Percentage of Row function shows

what the percentage of each Exports Value is as a percentage of the total of the Exports Value

row total.

Total Change

The Total Change function calculates a single change value, showing the change between the

first and last columns in the data grid.  This function can only be used if the grid has been

pivoted, such that the columns contain the same underlying data field.  (See the topic on 

Pivoting Data.)  For example, if the grid is pivoted by the Year column, and the data cells are
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showing exports from 2000 to 2010, the Total Change function will calculate the change in

exports between the 2000 value and the 2010 value, and the result will be displayed in a single

final column in the grid.

 Total Percentage Change

The Total Percentage Change function calculates a single change value, showing the

percentage change between the first and last columns in the data grid.  This is the same as the 

Total Change function, except that it calculates the change as a Percentage rather than an

absolute value.  This function can only be used if the grid has been pivoted, such that the

columns contain the same underlying data field.  (See the topic on Pivoting Data.)    For

example, if the grid is pivoted by the Year column, and the data cells are showing Exports from

2000 to 2010, the Total Percentage Change function will calculate the percentage change in

Exports between the 2000 value and the 2010 value, and the result will be displayed in a single

final column in the grid.

6.1.4.7 Summary Types

The last control in the Change Panel inside the Display Options Panel allows you to set the

Summary Type that is used to calculate totals in the data grid.
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The following section describes how to work with Summary Types.

Summary Types

The default method for displaying numerical values in the Data Area of the grid is set to Sum,

which means that single cells show their actual original data value, and summary or total cells

show the sum of the values that make up that cell.  Cells may be showing summary values if you

have Collapsed any of the columns, or if you are using Column Totals or Row Totals.  (See the

topics on Collapsing Columns and Row and Column Totals.)  It is possible to change the

Summary Type, so that the summary values are calculated in a number of different ways.  The

following Summary Types are available:

Sum

Count

Minumum

Maximum

Average

StdDev

StdDevP

Var

VarP

To set a different method for the summary values, change the Sum Type inside the Change

Panel.  The image below shows an example where the Summary Type has been set to

Average.  The sub-totals for each year and the grand total show an average of the values,

instead of a total.

The following section lists all of the available Summary Types and explains how they calculate

their values.
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List of Summary Types

The following table explains the how each of the Summary Type calculates the summary values.

Name Description

Average The average of the values. 

Count The number of values (excluding Null values). 

Max The largest value. 

Min The smallest value. 

StdDev An estimate of the standard deviation of a population, where the sample is a

subset of the entire population. 

StdDevp The standard deviation of a population, where the population is all of the

data to be summarized. 

Sum The sum of the values. 

Var An estimate of the variance of a population, where the sample is a subset of

the entire population. 

Varp The variance of a population, where the population is all of the data to be

summarized. 

6.1.4.8 Row and Column Totals

The Totals Panel in the Display Options Panel allows you to display summary totals of data

values that are in the Data Area of the grid. 
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The panel contains four options that can be ticked:

Row Totals

Row Grand Totals

Column Totals

Column Grand Totals

The use of these four options is explained in the following sections.

Row Totals

Row Totals allow you to display totals of values by summing values in the Data Area of the

grid that go horizontally across the grid from left to right in a Row.  Switching on Row Totals is

done by using the following check boxes in the Totals Panel:

Row Totals - To display Row Totals of sub-groups of data in the Row.

Row Grand Totals - To display a single final Grand Total of the entire Row.

Summing can only be applied to the same underlying data column, so the Row Totals option

only applies if the grid has been pivoted in such a way that the cells in the Data Area contain

the same data column.  (See the topic on Pivoting Data.)  If only a single column has been

pivoted, ticking the Row Grand Totals option will display a new final column showing the sum

of the values in each row.  The Row Totals option in this case will have no effect.  If more than

one column has been pivoted, creating a hierarchy of nested levels in the data cells, ticking the

Row Totals option will display a total for each lower sub-group of columns, and ticking the

Row Grand Totals option will display a final total for the whole row.

In the following example, the grid has been pivoted by the Partner and Year columns so that

the Data Area columns are showing the Exports Value field for each Partner, over time by

Year.  The Row Totals option shows a total of all years for each Partner.  The Row Grand

Totals option shows a final total for all Partners and all Years.
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Column Totals

Column Totals allow you to display totals of values by summing values in the Data Area of the

grid, vertically from top to bottom in each Column.  Switching on Column Totals is done by

using the following check boxes in the Totals Panel:

Column Totals - To display Column Totals of sub-groups of data in the Column.

Column Grand Totals - To display a single final Grand Total of the entire Column.

In the following example, the grid is showing data for a number of Partners and Years.  (The

data has been reduced to only 3 years and 3 products to make it clearer.)  The Column Totals

option shows a total for each sub-group of data, in this case for each Year.  It also then shows

a sub-total for the next level up in the hierarchy, in this case for each Partner.  The Column

Grand Totals option shows a single final column total which is the sum of all the values, in other

words in this case for all Partners and all Years.

6.1.4.9 Layout and Find Function

The last panel inside the Display Options Panel contains three buttons for some special data grid

functions.

The three buttons provide the following functions:
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Best Fit - To apply the Best Fit function and automatically size the grid columns to the best

width.

Find - To Find occurrences of text in the data in the grid.

Layout - To save pivoted grid Layouts and recall them later.

The following sections explain these topics in detail.

 Best Fit

The Widths button is used to automatically resize the grid columns to the best width.  The

columns are resized taking into account the width of the column headers and the largest values

in the column to make sure that the columns are wide enough to show all the values.  Just click

the Widths button once to apply the Best Fit function to the grid.

It is also possible to apply the Best Fit function from the data grid itself, or to apply it just to a

single column.  Right-click on a cell in any column, and select Best Fit Column or Best Fit All

Columns from the popup menu.

Find Function

The Find button provides a way of searching for text in the data in the grid, for example a

product description or a product code.  Clicking the Find button displays a small dropdown

panel with the find controls.
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Enter the text you want to search for in the Find Text box.  You can enter only part of the text,

for example "oil" would be found in the product description "Animal, vegetable fats and oils". 

Click on the Find Button in the panel, and any matches in the data grid will be highlighted by

showing the rows in bold.  Information will be displayed underneath the Find Text box to show

how many matches were found.  The following image shows an example of finding the word

"oil".

Prev and Next Buttons
If several rows were found containing the text you searched for, there may be more lines that

match than can be displayed simultaneously in the grid.  The Find Panel contains two more

buttons, Prev and Next.  Use these buttons to jump forwards and backwards between the rows

in the grid that match your search.  As you move to the next matching row, the cells of the row

in the Data Area will be highlighted.

Act As Filter
After using the Find function, the data grid still displays all the rows that were originally in the

grid, but with the matching rows highlighted.  You may want to see only the matching rows, and

exclude the rows that do not match.  To do this, tick the Act As Filter option in the Find Panel. 

The grid will be filtered to display only the rows that match the text you searched for.  The Filter

Button in the Display Options Panel will become illuminated to indicate that the grid is being

Filtered.  If you close the Find Panel the filter will still be in effect.  To remove the filter, you can

open the Find Panel again and untick the Act As Filter option, but a quicker method is to just

click the glowing Filter Button to switch off the filter.  The filter is remembered, which means

that you can easily switch the same filter back on by clicking the Filter Button again, and you do

not need to search again in the Find Panel.  (For more general information about how the

Filter Button works, see the section on Data Filtering.)
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Leave Highlighted
The rows that match the text you searched for remain highlighted only as long as the Find

Panel is still open.  When you close the Find Panel the data grid returns to its previous state,

and no rows are highlighted in bold.  If you would like to close the Find Panel but leave the

matching rows highlighted, click the Leave Highlighted option in the Find Panel.  You can then

close the Find Panel, and the matching rows in the grid will still be shown in bold.  To remove

the highlighting, open the Find Panel again, and untick the Leave Highlighted option.

 Saving and Recalling Grid Layouts

Grid Layouts
All of the options for pivoting, sorting, column selection, totals, change fields, etc., all change

the way the pivot grid is arranged and displayed.  When you have made a Data Selection and

then made changes to the Display Options, if you then save the Data Selection, all of these

display settings are saved together with the basic Data Selection.  (See the topic on Saving

Project Items.)  When you recall the Data Selection, all the display settings will also be recalled

and restored.  However, those display setting were only saved for that particular data selection.

 Since there are many display settings and combinations of settings that you can set, you may

want to save a general Grid Layout and a collection of settings, which you could then use with

any data, and which would not be tied to a particular Data Selection.  The Layout Panel in the

Display Options Panel is designed for this purpose.  Click the Layout Button to show the

Layout Panel.

To give an example of how this feature can be used, suppose you have displayed some trade

data, and you have then selected that only the Exports Value column is visible, and you have

pivoted the grid by the Year column.  The grid will be showing exports over time, with each year

in a column.  This is a useful layout that you may want to be able to use with other trade data

selections, which may be for completely different countries or years.  You could save this grid

layout under a saved name, for example "Exports By Year".  When you then do other trade

data selections in the future, and you would like to arrange the grid to show only exports over

time, you could recall the saved Grid Layout called "Exports By Year".  This example only saved

and recalled the column selection and pivoting of the grid, but keep in mind that the function to
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save Grid Layouts can be used to store all aspects of the grid layout and all the display

settings in the Display Options panel.  

The distinction between saving a Grid Layout and saving a Data Selection, is that the Grid

Layout saves the arrangement of the grid independently of the actual data, and it can then be

re-used with different sets of data, whereas a Data Selection is saving a specific set of data.  

Saving a Grid Layout
Once you have set all the display options and the grid pivoting that you would like to save, click

the Layout Button.  In the panel that is displayed, enter a name in the Save Layout As box, and

then click the small Save Layout button to the right.  The Grid Layout will be saved under the

name you entered, and a confirmation message will be displayed.

Recalling a Grid Layout
To recall a Grid Layout that you saved previously, click the Layout Button, and then use the

Recall Layout dropdown to select the Grid Layout from the list.  All the Grid Layouts that have

been saved so far will be displayed.  When you select a layout from the list, the settings

associated with that saved layout will be recalled, and the grid and display options will be set

according to the saved settings.

Deleting a Grid Layout
To delete a saved Grid Layout, first recall the layout as described above.  The Delete Layout

button to the right of the layout name will become enabled.  Click the Delete Layout button,

and the Grid Layout will be deleted.
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6.2 Data Screens

TradeSift can load and process the following types of data:

 Trade Data - Trade in goods data.

 Services Data - Trade in services data.

 Tariff Data - Tariffs data.

 GDP Data - Gross Domestic Product data.

 WDI Data - World Development Indicators from the World Bank.

The procedure for loading data is the same for all data types - see Loading Data.

The general layout of all data screens is basically the same, so the procedure for viewing the data

is also the same across data types - see Viewing Data.

Once you have loaded data, all of TradeSift's features to analyse and work with this data are

available for all data types.  This includes viewing, pivoting, filtering, viewing top 10's, creating 

Charts and Tables, and inserting them into Documents in the Report Writer.  These topics are

described in other chapters and are common to all types of data, although there may be minor

differences.

Only the following data types can be used as the input to indicator calculations:

Trade in Goods Data

Trade in Services Data

You can access each of the data screens from the Data Menu on the Main Menu, from the

Toolbar, or from the Navigator panel.

Main

Menu

ToolBar Navigator

The following topics in this chapter describe the data screens for each of the specific types of data.

Trade Data

Services Data

Tariff Data

GDP Data

WDI Data
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6.2.1 Trade Data

The Trade Data screen allows you to view any trade data loaded in your project, and then to

create charts and tables from that data.

The procedure for selecting and viewing data is described in the chapter on Viewing Data.

Once the data selection has been made, to Pivot, Sort, Filter, Limit, Sum, and manipulate the data in

the grid, use the controls above the grid in the Display Options Panel.

For more information about the Trade Data screen and the meaning of the columns, see the

sections below.

 Trade Data Selection

The data selection process for Trade Data is the same as for all data screens, (see Viewing

Data).

Flow Types
If the Trade Data you have loaded in your project is for more than one flow-type, the data

selection procedure will show an extra panel, where you can choose the flow-type.

Exports of a country can be distinguished as Exports of domestic goods and Exports of

foreign goods. The second class is generally referred to as Re-Exports.

Re-Exports are exports of foreign goods in the same state as previously imported, and they

are included in the country exports.

Re-Imports are goods imported in the same state as previously exported, and they are

included in the country imports.

Net figures are Gross, with Re excluded.

Gross = Net + Re.

The following three flow-types may be available depending on the data you have loaded:

Net - Net Imports and Net Exports (excluding Re-Imports and Re-Exports).

Gross - Gross Imports and Gross Exports (Imports + Re-Imports and Exports + Re-Exports).

Re - Re-Imports and Re-Exports only.
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 Trade Data Columns

When the Trade Data is first shown, the most common columns will be shown in the data grid,

but there may be more columns available which are initially hidden.  To select which columns

are visible, use the Columns section of the Display Options Panel, as described in Choosing

Columns.  

You can either select the exact columns that you want to be visible from the full list of available

columns by clicking on the Column Selection drop-down control, or you can make use of the

Quick Column Buttons, for easy access to the most common columns.  See the next topic Trade

Data Column Buttons for a description of the buttons for Trade Data.

The following columns are available in the Trade Data screen.  Whether all columns will have

values or not, depends on the data you have loaded.

Reporter - The Reporting country.

Partner - The Partner country.

Year - The Year for which the Trade Data is shown.

Period - If the Trade Data is not annual, the Period or Month will be shown next to the Year.

Flow Type - The type of trade flow of the data, Net, Gross, or Re. (See Flow Types).

Product - The Product Code that the trade values are shown for.

Product Name - The full descriptive name of the product.

Imports Value - The Imports Value of the trade data (usually shown in thousands of US

Dollars).
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Imports Rank - The Rank of the Imports Value within the products shown, rank 1 being the

highest imports value.

Imports Share - The Share of the product's Imports Value out of the total imports of all

products for the country and year. 

Imports Qty - The Imported Quantity, if available.

Imports Weight - The Imported Weight, if available.

Exports Value - The Exports Value of the trade data (usually shown in thousands of US

Dollars).

Exports Rank - The Rank of the Exports Value within the products shown, rank 1 being the

highest imports value.

Exports Share - The Share of the product's Exports Value out of the total imports of all

products for the country and year. 

Exports Qty - The Exported Quantity, if available.

Exports Weight - The Exported Weight, if available.

Trade Balance - The Trade Balance is calculated as the Exports Value minus the Imports

Value.  

If the Imports Value is greater than the Exports Value, the Trade Balance will be negative and

will be shown in red.

Qty Unit Code - The Quantity Unit Code describes the type of unit that was used for the

Imports Quantity or Exports Quantity value.

Qty Unit Desc  - The Quantity Unit Description shows the descriptive name of the Quantity

Unit Code.  The values are:

1     No Quantity

2     Area in square metres                                           - m²

3     Electrical energy in thousands of kilowatt-hours - 1000 kWh

4     Length in metres                                                    - m

5     Number of items                                                    - u

6     Number of pairs                                                     - 2u

7     Volume in liters                                                      - l

8     Weight in kilograms                                               - kg

9     Thousands of items                                                - 1000u

10   Number of packages                                              - u  (jeu/pack)

11   Dozen of items                                                       - 12u

12   Volume in cubic meters                                          - m³

13   Weight in carats                                                     - carat

Qty Estim Code - The Quantity Estimation Code refers to the “quantity/net-weight

estimation”.  The values are:

0 = No Estimation

2 = Quantity

4 = Net Weight

6 = Both Quantity and Net Weight

 Note: Ranks and Shares

Usually Ranks and Shares are shown for each product, and are calculated out of the sum of

the products for the current Reporter/Partner/Year.   If the trade data being shown is for

total trade, or for a single product, the Ranks and Shares will be across countries, showing a

share out of the sum of all the countries shown.
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 Trade Data Column Buttons

The Quick Column Buttons provide an easy way to show or hide the most common columns in

the data grid.  Each button controls a group of related columns.  Click the button to toggle the

display of the columns on and off.  If the button is highlighted in orange it is "on" and the

associated columns will be shown in the data grid; if the button is in blue it is "off", and the

associated columns will be hidden in the data grid.  Control-clicking a button will make only

those columns visible, and hide the rest.

The buttons in the Trade Data screen show/hide the following columns:

Imports - All Imports columns, Imports Value, Imports Share, Imports Rank, Imports Qty,

Imports Weight.

Exports - All Exports columns, Exports Value, Exports Share, Exports Rank, Exports Qty,

Exports Weight.

Balance - The Trade Balance column.

Ranks - The rank columns, Imports Rank and Exports Rank.

Shares - The shares columns, Imports Share and Exports Share.

Qtys - The quantity columns, Imports Qty, Exports Qty, Qty Unit Code, Qty Unit Desc, Qty

Estim Code.

Weights - The weight columns, Imports Weight and Exports Weight.

 Trade Data Screen

Related topics:

Loading Data
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Viewing Data

Display Options Panel

Charts

Tables

6.2.2 Services Data

The Services Data screen allows you to view any services data loaded in your project, and then to

create charts and tables from that data.

The procedure for selecting and viewing data is described in the chapter on Viewing Data.

Once the data selection has been made, to Pivot, Sort, Filter, Limit, Sum, and manipulate the data in

the grid, use the controls above the grid in the Display Options Panel.

For more information about the Services Data screen and the meaning of the columns, see the

sections below.

 Services Data Selection

The data selection process for Services Data is the same as for all data screens, (see Viewing

Data).

Service Groups
After selecting the Nomenclature, you will be asked to select the Service Group.  The following

options are available:

All Service Codes - All Service Codes will be shown, for all Digit-Levels.  Because of the way

that EBOPS codes are defined, in this mode, the service codes contain overlapping data, so

the total of all product lines would be more than the true figure for total trade.

EBOPS Services - Only service codes which belong to the group EBOPS Services according

to the EBOPS classification will be shown.

Memorandum Items - Only service codes which belong to the group Memorandum Items

according to the EBOPS classification will be shown.

Supplementary Items - Only service codes which belong to the group Supplementary Items

according to the EBOPS classification will be shown.

Services Digit-Levels
If you select EBOPS Services, you can then additionally select the Digit-Level. For all other

Service Groups, the Digit-Level selection will not be available.  The EBOPS classification has

Service Codes which are always 3-digit numbers, for example "200", and each of these codes

has a related EBOPS Code, in the format "N.N.N", for example "1.2.1".  Since the numerical

Service Codes are always 3-digits, when you make any Digit-Level selection for Services Data,

this refers to the format of the EBOPS Code, not the Service Code.

For Example:

206 = "1.1" = 2-Digit.

208 = "1.2.2" = 3-Digit.
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 Services Data Columns

When the Services Data is first shown, the most common columns will be shown in the data

grid, but there may be more columns available which are initially hidden.  To select which

columns are visible, use the Columns section of the Display Options Panel, as described in

Choosing Columns.  

You can either select the exact columns that you want to be visible from the full list of available

columns by clicking on the Column Selection drop-down control, or you can make use of the

Quick Column Buttons, for easy access to the most common columns.  See the next topic

Services Data Column Buttons for a description of the buttons for Services Data.

The following columns are available in the Services Data screen.  Whether all columns will have

values or not, depends on the data you have loaded.

Reporter - The Reporting country.

Partner - The Partner country.

Year - The Year for which the Services Data is shown.

Period - If the Services Data is not annual, the Period or Month will be shown next to the

Year.

Product - The Service Code that the service trade values are shown for.

EBOPS Code - The EBOPS Code (in the format N.N.N) that the service trade values are shown

for. (See EBOPS Code.)

Product Name - The full descriptive name of the product.
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Imports Value - The Imports Value of the services trade (usually shown in thousands of US

Dollars).

Imports Rank - The Rank of the Imports Value within the products shown, rank 1 being the

highest imports value.

Imports Share - The Share of the product's Imports Value out of the total imports of all

products for the country and year. 

Exports Value - The Exports Value of the services trade (usually shown in thousands of US

Dollars).

Exports Rank - The Rank of the Exports Value within the products shown, rank 1 being the

highest imports value.

Exports Share - The Share of the product's Exports Value out of the total imports of all

products for the country and year. 

Trade Balance - The Trade Balance is calculated as the Exports Value minus the Imports

Value.  

If the Imports Value is greater than the Exports Value, the Trade Balance will be negative and

will be shown in red.

 Services Data Column Buttons

The Quick Column Buttons provide an easy way to show or hide the most common columns in

the data grid.  Each button controls a group of related columns.  Click the button to toggle the

display of the columns on and off.  If the button is highlighted in orange it is "on" and the

associated columns will be shown in the data grid; if the button is in blue it is "off", and the

associated columns will be hidden in the data grid.  Control-clicking a button will make only

those columns visible, and hide the rest.

The buttons in the Services Data screen show/hide the following columns:

Imports - All Imports columns, Imports Value, Imports Share, Imports Rank.

Exports - All Exports columns, Exports Value, Exports Share, Exports Rank.

Balance - The Trade Balance column.

Ranks - The rank columns, Imports Rank and Exports Rank.

Shares - The shares columns, Imports Share and Exports Share.

 Services Data Screen



Viewing Data 201

© InterAnalysis Ltd. 2012

Related topics:

Loading Data

Viewing Data

Display Options Panel

Charts

Tables

6.2.3 Tariff Data

The Tariff Data screen allows you to view any tariff data loaded in your project, and then to create

charts and tables from that data.

The procedure for selecting and viewing data is described in the chapter on Viewing Data.

Once the data selection has been made, to Pivot, Sort, Filter, Limit, Sum, and manipulate the data in

the grid, use the controls above the grid in the Display Options Panel.

For more information about the Tariff Data screen and the meaning of the columns, see the

sections below.

 Tariff Data Selection

The data selection process for Tariff Data is the same as for all data screens, (see Viewing

Data).

Duty Types
After selecting the nomenclature, countries and year, a panel will be displayed showing the

available Duty Types.  Only duty types for which you have data loaded for the selected

countries and years will be shown.  You select which Duty Types you want to see the data for,

by ticking one or more Duty Types in the list.

The following four Duty Types may be available depending on the data you have loaded:

AHS - Effectively applied tariffs which are calculated by taking into account any existing

preferential tariff rates (and using the MFN rate when there is no preferential tariff).
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BND - Bound tariffs which give the average bound rate.

MFN - Applied tariffs which are calculated based only on the MFN applied tariff rate ignoring

any existing preferential tariff rates.

PRF - Applied preferential tariffs which are calculated based only on those tariff lines/

products which have a preferential tariff rate.

 Tariff Data Columns

When the Tariff Data is first shown, the most common columns will be shown in the data grid,

but there may be more columns available which are initially hidden.  To select which columns

are visible, use the Columns section of the Display Options Panel, as described in Choosing

Columns.  

You can either select the exact columns that you want to be visible from the full list of available

columns by clicking on the Column Selection drop-down control, or you can make use of the

Quick Column Buttons, for easy access to the most common columns.  See the next topic Tariff

Data Column Buttons for a description of the buttons for Tariff Data.

The following columns are available in the Tariff Data screen.  Whether all columns will have

values or not, depends on the data you have loaded.

Reporter - The Reporting country.

Partner - The Partner country.

Year - The Year for which the Tariff Data is shown.

Period - If the trade data is not annual, the Period or Month will be shown next to the Year.
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Duty Type - The Duty Type of the Tariff Data. (See Duty Types). Values:

Product - The Product Code that the trade values are shown for.

Product Name - The full descriptive name of the product.

Native Nomen - The native nomenclature that the tariffs were reported in.

Trade Year - The year that the imports value trade figures relate to.

Simple Average - The Simple Average Tariff.

Weighted Average - The Weighted Average Tariff.

Simple Trf Line Avg - 

Standard Deviation - 

Minimum Rate - 

Maximum Rate - 

Domestic Peaks - 

International Peaks - 

Binding Coverage - 

Imports Value - The Imports Value for the trade year.

Imports Rank - The Rank of the Imports Value within the products shown, rank 1 being the

highest imports value.

Imports Share - The Share of the product's Imports Value out of the total imports of all

products for the country and year. 

Tariff Revenue - The Tariff Revenue value.  This may be calculated as the product of Simple

Average column and the Imports Value column, or it may have been loaded if the column was

present in your tariff data file.  (See Loading Tariff Revenue.)

AVE Lines - 

Dutiable Lines - 

Free Lines - 

NA Lines - 

Total Lines - 

 Tariff Data Column Buttons

The Quick Column Buttons provide an easy way to show or hide the most common columns in

the data grid.  Each button controls a group of related columns.  Click the button to toggle the

display of the columns on and off.  If the button is highlighted in orange it is "on" and the

associated columns will be shown in the data grid; if the button is in blue it is "off", and the

associated columns will be hidden in the data grid.  Control-clicking a button will make only

those columns visible, and hide the rest.

The buttons in the Tariff Data screen show/hide the following columns:

Imports - All Imports columns, Imports Value, Imports Share, Imports Rank.

Revenue - The Tariff Revenue column.

Extras - All of the remaining Tariff Data columns.

Ranks - The Imports Rank column.

Shares - The Imports Share column.

Simple - The Simple Average tariff column.
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Weighted - The Weighted Average tariff column.

 Tariff Data Screen

Related topics:

Loading Data

Viewing Data

Display Options Panel

Charts

Tables

6.2.4 GDP Data

The GDP Data screen allows you to view the loaded GDP Data, and then to create charts and

tables from that data.  The GDP Data may be the initial data that comes preloaded in TradeSift, or

your own GDP Data which you have loaded subsequently.  (See Loading GDP Data.)  GDP Data is

not stored per-project, it is available to all projects.

The procedure for selecting and viewing data is described in the chapter on Viewing Data.

Once the data selection has been made, to Pivot, Sort, Filter, Limit, Sum, and manipulate the data in

the grid, use the controls above the grid in the Display Options Panel.

For more information about the GDP Data screen and the meaning of the columns, see the

sections below.

 GDP Data Selection

The data selection process for GDP Data is the same as for all data screens, (see Viewing Data)

.

GDP Type
The first panel of the GDP Data selection process asks you to choose the GDP Type.  You can
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choose to view Current GDP, Constant GDP, or both.

 GDP Data Columns

When the GDP Data is first shown, the most common columns will be shown in the data grid,

but there may be more columns available which are initially hidden.  To select which columns

are visible, use the Columns section of the Display Options Panel, as described in Choosing

Columns.  

You can either select the exact columns that you want to be visible from the full list of available

columns by clicking on the Column Selection drop-down control, or you can make use of the

Quick Column Buttons, for easy access to the most common columns.  See the next topic GDP

Data Column Buttons for a description of the buttons for GDP Data.

The following columns are available in the GDP Data screen.  Whether all columns will have

values or not, depends on the data you have loaded.

Country - The country for which the GDP Data is being shown.

Year - The Year of the GDP Data values.

GDP Type - The Type of GDP Data, Current or Constant.

GDP Value - The GDP Value, (usually in thousands of US Dollars).

Currency - The Currency of the GDP Value shown (usually in US Dollars unless you have

loaded your own GDP Data in an other currency).

Source - The source of the GDP Data.
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 GDP Data Column Buttons

The Quick Column Buttons provide an easy way to show or hide the most common columns in

the data grid.  Each button controls a group of related columns.  Click the button to toggle the

display of the columns on and off.  If the button is highlighted in orange it is "on" and the

associated columns will be shown in the data grid; if the button is in blue it is "off", and the

associated columns will be hidden in the data grid.  Control-clicking a button will make only

those columns visible, and hide the rest.

The buttons in the GDP Data screen show/hide the following columns:

Type - The GDP Type column.

Currency - The Currency column which shows which Currency the GDP figures are in.

Source - The Source column which shows where the GDP data came from.

 GDP Data Screen

Related topics:

Loading Data

Viewing Data

Display Options Panel

Charts

Tables
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6.2.5 WDI Data

The WDI Data screen allows you to view any loaded World Development Indicators, and then to

create charts and tables from that data.  You must have first loaded some WDI Data before you

can view it, the data is freely available from the World Bank.  WDI Data is not stored per-project, it

is available to all projects. (See Loading WDI Data.)

The procedure for selecting and viewing data is described in the chapter on Viewing Data.

Once the data selection has been made, to Pivot, Sort, Filter, Limit, Sum, and manipulate the data in

the grid, use the controls above the grid in the Display Options Panel.

For more information about the WDI Data screen and the meaning of the columns, see the

sections below.

 WDI Data Selection

The data selection process for WDI Data is the same as for all data screens, (see Viewing Data)

.

The first panel in the WDI Data Selection dialog is where you choose which of the World

Development Indicators you want to view the data for.

WDI Indicator
The first panel of the WDI Data selection dialog, requires you to choose which WDI Indicator

you would like to view the data for.  Only WDI Indicators which you have loaded will be listed. 

You can choose one or more WDI Indicators by ticking them.

 WDI Data Columns
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When the WDI Data is first shown, the most common columns will be shown in the data grid,

but there may be more columns available which are initially hidden.  To select which columns

are visible, use the Columns section of the Display Options Panel, as described in Choosing

Columns.  

You can either select the exact columns that you want to be visible from the full list of available

columns by clicking on the Column Selection drop-down control, or you can make use of the

Quick Column Buttons, for easy access to the most common columns.  See the next topic WDI

Data Column Buttons for a description of the buttons for WDI Data.

The following columns are available in the WDI Data screen.  Whether all columns will have

values or not, depends on the data you have loaded.

Year - The Year for which the WDI Data is shown.

Indicator Code - The Code of the WDI Indicator (these code come from the World Bank, for

example ""BG.GSR.NFSV.GD.ZS").

Indicator Name - The full descriptive Name of the WDI Indicator.

Country - The Country for which the WDI Data is shown.

Value - The Value of the particular Indicator selected.  (The units of the values vary

depending on the type of indicator, they may be monetary values, percentages, headcounts,

etc.).

 WDI Data Column Buttons

The Quick Column Buttons provide an easy way to show or hide the most common columns in

the data grid.  Each button controls a group of related columns.  Click the button to toggle the

display of the columns on and off.  If the button is highlighted in orange it is "on" and the

associated columns will be shown in the data grid; if the button is in blue it is "off", and the

associated columns will be hidden in the data grid.  Control-clicking a button will make only

those columns visible, and hide the rest.

The buttons in the WDI Data screen show/hide the following columns:

Ind Code - The Indicator Code column.

Ind Name - The Indicator Name column.

 WDI Data Screen
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Related topics:

Loading Data

Viewing Data

Display Options Panel

Charts

Tables
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6.3 Data Topics

This section explains a number of concepts related to data organisation and selection.

Topics covered:

Aggregation

Aggregate Products

Rest of World

6.3.1 Aggregation

This section explains the concepts of Digit-Levels and Aggregation.

 Digit-Levels

Whenever you request to view data or calculate an indicator in TradeSift, generally after

selecting the Nomenclature, you are required to select the Digit-Level.  The Digit-Level refers

to the level of aggregation of the product code, and generally corresponds to the number of

digits in the Product Code.  The Digit-Levels that you will be offered, depend on the selected

Nomenclature, because each Nomenclature or Classification has its own system of product

codes.  For example, the HS Nomenclature will offer you:

Total Trade

2-Digit

4-Digit

6-Digit

(NOTE: Total Trade is sometimes referred to as "0-Digit".)

Other Nomenclatures such as SITC or BEC, will offer you different Digit-Levels.  If you want to

see which Digit-Levels belong to each Nomenclature, you can use the Nomenclatures screen

in the Reference Data section.

TradeSift can do data aggregation for you, which allows you to view data at a more

aggregated level, than the level at which the data was loaded.  For example, you might load HS

data at the 6-Digit level, which means that for each Reporter/Partner and Year, you will have

approximately 5000 6-Digit product codes.  If you then select to view the data at the 4-Digit

level, TradeSift will aggregate the figures up to 4-Digit product codes.  This means that the

trade values for every single 6-Digit product code which starts with the same 4 numbers, will be

summed to produce a single set of trade figures for each 4-Digit product code.  This will

produce fewer products with figures for broader product categories.  Similarly, you could

aggregate up to the 2-Digit level, which will produce even fewer products for even broader

product categories.  Finally, you could select Total Trade, which will produce a single set of

trade figures for total trade, which would be the sum of all the values of the 6-Digit products.

 Aggregating Data

It is important to understand the difference between loading and viewing data that is already at

an aggregated level, and loading more detailed data and then aggregating the figures in 

TradeSift.  For example, if you want to work with 2-Digit data in HS.  Most common data

sources such as Comtrade, Wits, etc., will offer you the option to download the data at any of

the Digit-Levels.  This means that you could download data which is already aggregated to
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the 2-Digit level.  You could then load this data in to your project for use in TradeSift.  In this

case, you would not be able to view the data at a level more detailed than 2-Digit, because you

have loaded only 2-Digit data, but you could aggregate up to Total Trade.  When you view or

work with this data in TradeSift, you will be working with figures which were aggregated to 2-

Digits by the supplier of the data.

The other possibility, would be to load 6-Digit or 4-Digit data, and after loading it in to your

project, you could request to work with it at the 2-Digit level in TradeSift.  In this case, the

aggregation is done by TradeSift, not by the supplier of your data.  It is important to know that

the 2 approaches, will not necessarily produce exactly the same figures.  The first approach

should be figures that were actually reported and collected at the 2-Digit level, while the

second approach will be an approximation by aggregating reported 6-Digit figures up to the

2-Digit level.

 Aggregation Options

As explained above, data can either be download already aggregated, or it can be aggregated

in TradeSift.  You might load data at different Digit-Levels in to your project, and this means

that you could have situations where there is more than one way that TradeSift could give you

data at the aggregation level that you request.  For example, suppose you load both 2-Digit

and 6-Digit data in to your project, and you then request to view 2-Digit data.  In this situation,

there are 2 ways that TradeSift could show you 2-Digit data:

Fetch and show the actual 2-Digit data that you loaded

Fetch the 6-Digit data that you loaded, and aggregate it up to 2-Digits

If only one way of aggregating the data exists, TradeSift will just aggregate the data for you

and display the data.  If more than one way exists as in the example above, a dialog box will

appear asking you to choose which method you would like TradeSift to use to get the

requested data.
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6.3.2 Aggregate Products

Trade Data is typically organised into Digit-Levels, which refers to the level of aggregation of the

trade figures.  (See Aggregation.)

The Digit-Level for data that you load and view generally relates to the length of the Product

Code in the selected Nomenclature, so the product codes would normally be numeric and fixed

length.  For example 2-Digit product codes in the HS Nomenclature, would be 01, 02, 03, etc.

However, it is also possible to load and work with data for product codes which do not have an

implied Digit-Level, and which have trade figures already aggregated in to broad categories, such

as "Agriculture", "Oil", etc.  In TradeSift, these types of product are referred to as Aggregate

Products.

TradeSift allows you to load data from data files with trade figures for Aggregate Products.  For

example, data is available from Wits already grouped in to "Standard Product Groups".  For this

type of data, the product codes are usually not numerical, and they are variable length.  The

following is an extract from a data file from Wits:

To load this type of data in to TradeSift, you do not have to do anything different, just load the

data files as Trade Data in the normal way.  (See Loading Data from Files.) 

Later when you make your data selections, in the Nomenclature & Digit-Level step in the Data

Selection Wizard, the Digit-Level selection box will offer you the option to select "Aggregate

Products", instead of a specific Digit-Level.  Note that if you have loaded data both for normal

products and Aggregate Products, the Digit-Level selection may show you both the normal Digit-

Levels, AND Aggregate Products.  Depending on which of these you select, you will be accessing

different data.  Selecting a Digit-Level, will access the data that you loaded for normal products,

and may then do aggregation on that data.  Selecting Aggregate Products will access the data you

loaded for already aggregated products as described above.



Viewing Data 213

© InterAnalysis Ltd. 2012

 Note:

Data loaded for Aggregate Products cannot be disaggregated down to a more detailed level,

nor aggregated up to a higher level.

6.3.3 Rest of World

When you select one or more Partner countries when making a data selection (see Data Selection,

Partner Step), you may see a Partner country option in the list called Rest of World.  There is no

actual data loaded for this as a partner, this option is a facility to ask TradeSift to calculate and

show trade figures, which are calculated from the data that you have loaded.  The Rest of World

option will only appear if you have loaded data for World as a partner, because the World data is

required for the calculation.
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To take an example, if you request to view Total Trade data with the UK as the Reporter, and a

number of Partner countries, and you also select Rest of World,  TradeSift will sum the trade

values for all of the selected Partner countries, and then subtract the summed total from the trade

values for the World.  The resulting figures will be shown as the trade values for Rest of World.

RoW = World - (P1 + P2 + P3, etc.)

The calculation is only performed using data for Partner countries that you actually have loaded in

your project, and that you select in your data selection.  TradeSift does actually know what the true

trade figure are for the rest of the world, this data is not loaded.  For this reason, it is important

not to select Partner countries for groups that may overlap, for example EU27 and a EU member

country, as this would double up figures in the Rest of World calculation.
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6.4 Exporting & Printing Data

This section describes how you can Export and Print data (or Charts and Tables, etc.) from within

TradeSift.

Exporting

In all data screens, the data displayed in the data grid can be exported to a file, to common

Office formats or to an image.  The supported file formats are:

Excel (.xls, .xlsx)

Rich Text File (.rtf)

Comma Separated Values (.csv)

HTML (.html)

Web Archive (.mht)

Adobe PDF (.pdf)

To export data from any data screen, click on the Export button on the screen's toolbar. 

An export dialog box will be displayed with various detailed settings to control how the data will

be exported.

Folder - By default, exported documents will be saved in a folder called "Exported", which will

be created as a sub-folder of your project folder.  You can choose a different folder by

clicking the Browse button, and browsing to a different folder.  

File Name - A suggested filename for the file to be exported to will appear in the File Name

box, but you can type over this and enter any name you like.

File Format - Click on the drop down arrow to select the type of file that you want to export

to.

Include Header - Selecting this option will write some extra lines to the top of the exported

file, with a descriptive summary of the data.  The information included is similar to the

summary that appears in the Info Panel of the data screens.

Open In Excel - With this option ticked, the exported file will be opened in Excel for you after

exporting.
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Keep Formatting - Selecting this option will export the file with the colours and formatting of

the data grid preserved.  When this option is not selected, the data will be exported in a

more plain raw format.

Once you have selected the export file format, the panel below will display options specific to

that file format.

Printing

The data in all data screens, charts, tables, documents, etc. can be printed.  The standard

toolbar contains two buttons for printing:

 Print - The print button will print the screen directly without any print preview.  A standard

Windows print dialog will be displayed so that you can choose the printer, etc.

 Print Preview - The print preview button displays a print preview screen before printing

the screen.  The print preview screen allows you to see how the data will fit on the page, and

gives you the option to change margins, the page orientation, paper size, etc. 
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7 Custom Data

This chapter describes how to work with Custom Data in your TradeSift Projects.  The term

Custom Data refers to any non-standard additional data items that you may need to set up.

Topics covered in this chapter

 Custom Data

Custom Data Overview

Custom Countries

Custom Products

Loading Product Names

Loading Product Groups
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7.1 Custom Data Overview

Custom Data

TradeSift generally works with standard definitions of common data items, such as country codes,

product codes, etc.  In some cases, data that you load may contain data items which are not found

in the standard definitions, and in those cases, Custom Data items are automatically created. 

These Custom items can be viewed using the Custom Data screens.

You can access the Custom Data screens via the Main Menu, the Toolbar, or the Navigator.

Main

Menu

ToolBa

r

Navigator

Data Screens Layout

The general layout of the Custom Data screens and the Toolbar functions available in the screens,

is exactly the same as for the Reference Data screens.  For an explanation of the common screen

functionality and the Toolbar functions, see Data Screens Layout.

Custom Data Screens

The remaining sections in this chapter explain each of the Custom Data screens in detail.

Custom Countries

Custom Products
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7.2 Custom Countries

Custom Countries Data Screen

When you load data in to your Project, TradeSift tries to match the Countries in your data file to

standard country codes.  Internally, TradeSift uses the Comtrade system of country numbers.  You

can see a list of all the Countries and associated country codes in the Countries Reference Data

Screen.  The data loading function tries to recognise Countries in the data file by looking for

numerical country codes, or ISO3 alphanumeric codes.  If the Country cannot be identified by using

those country codes, the program will try to recognise the Country by matching the country name.

 In most cases, TradeSift will match the Country, and then use the standard Country Number to

store the loaded data.  TradeSift will also try to recognise standard Country Groups.  For a list of

the Country Groups that can be recognised, see the  Country Groups Reference Data Screen.

In some cases, TradeSift may not be able to identify a Country that is in your data file, if the file

does not contain a standard country code, or if the country name is spelled in a different way.  In

those cases, TradeSift will automatically create a Custom Country, so that the loaded project data

is connected to a Country.  A numerical country code starting from the number 1001 is assigned,

and the country definition is added to the Custom Countries table, using the assigned number,

and the country name found in the data file.  Custom Countries are related to a specific Project.

The Custom Countries Data Screen is only for information purposes, and allows you to view a list

of all the Custom Countries that have been created in your Project.  If you want to know which

data file one of the Countries came from, a column in the grid shows the data file that contained

the unmatched country.
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7.3 Custom Products

Custom Products Data Screen

When you load data in to your Project for standard classifications systems, TradeSift already has

definitions of the Product Codes and Product Names loaded for all the standard Nomenclatures.

 This means that if you load a data file for a standard Nomenclature containing only Product

Codes, but without any product descriptions, when you view the data in TradeSift the standard

product names will still be displayed, because TradeSift has these definitions pre-loaded. 

However, if you load non-standard data, TradeSift will have no knowledge of the product names. 

For example, if you have some country-specific data which belongs to the HS classification, but

which goes down to the 8-Digit level, these product definitions are not standard, and TradeSift

does not have any product names loaded for them.  In this case, when you load the non-standard

data, if the data file contains product names, TradeSift will automatically create Custom Product

records on a special table, using the Product Codes and Product Names found in your data file. 

These product definitions can then be used when you view your loaded data, to display the correct

product descriptions together with the product codes.

The Custom Products Data Screen allows you to see a complete list of all the non-standard

product codes that have been created in your Project.  Note that if you have not loaded any non-

standard data, this screen will be empty.

Filter Products Panel

The Filter Products panel allows you to enter parts of a Product Code or Product Name to filter

the list to show only products that match.

Find by Code - Filter the list of products by any part of the Product Code.

Find by Name - Filter the list of product by any part of the Product Name.

Reset Button - Clear all the filter, Reset the screen, and show all products.
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8 Reference Data

This chapter explains the use of the Reference Data screens.

Topics covered in this chapter

 Reference Data

Reference Data Overview

Data Screens Layout

Countries

Country Groups

Nomenclatures

Products

Product Groups

Concordances

Goods Types

Currencies
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8.1 Reference Data Overview

Reference Data

TradeSift comes pre-loaded with static Reference Data which you can use to look up definitions of

common data items, such as Nomenclatures, Countries, etc.  The Reference Data is held centrally

and is not connected to a specific Project, so it is always available even if a Project is not open.

You can access the Reference Data screens via the Main Menu, the Toolbar, or the Navigator.

Main

Menu

ToolBar Navigator

Reference Data Screens

The remaining sections in this chapter explain each of the Reference Data screens in detail.

Countries

Country Groups

Nomenclatures

Products

Product Groups

Concordances

Goods Types

Currencies
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8.2 Data Screens Layout

Reference Data Screens Layout

All the Reference Data Screens share the same overall layout.  The sections below describe the

common screen layout, and how to make use of the functions on the Toolbar.

Reference Data Screens Common Layout

The Reference Data Screens have a Toolbar for common functions across the top, an Options

or Selection panel where you select which data you want to view, or with additional Find

functions, and a data grid where the reference data will be displayed.  If there is an Options or

Selection panel, it can be collapsed and expanded by using the white triangle button in the

panel header.  

The Options Panel usually has a Reset Button which clears all your selections, and Resets the

screen to default values.

Some Reference Data Screens have two data grids.  In those cases, there is a horizontal

Splitter-Bar which divides the two grids.  You can resize the two grids by grabbing and

dragging the Splitter-Bar up or down.  

If a screen has two data grid, an extra Grid Selection control is displayed on the Toolbar, to

allow you to select which data grid will be used when you make use of the Toolbar functions for



Reference Data 227

© InterAnalysis Ltd. 2012

printing, exporting, filtering, etc.  Before using one of these functions, click on the Grid

Selection dropdown, and select the data grid that you want to make "active".  

 Reference Data Screens Toolbar

All the Reference Data Screen (which include all the Custom Data Screens) have a common

Toolbar at the top with standard functions that you can use in all of the screens.

The Reference Data Screens Toolbar has the following buttons:

Export Document - Exports the current Document to an external Document.  See

Exporting Documents.

Print - Prints the current Document, via a standard Windows print dialog.

Print Preview - Shows a Print Preview window of the Document.

 Select Columns - Allows you to Select which Columns are shown in the data grid.  See

Selecting Columns.

 Group Panel - Displays a Group Panel so that you can group data in the grid by certain

columns by dragging them to the Group Panel.  See Grouping Columns.

 Find - Displays a Find Panel so that you can search for text in the data in the grid.  See

Finding Data.

 Filter - Displays a Filter Panel, so that you can create complex Filter criteria, to filter the

rows shows in the grid.  See Filtering Data.

Selecting Columns

To select which Columns you would like to be visible in the data grid, click on the Columns

Button in the Toolbar.  A dropdown panel will display, showing a list of all the available

Columns.  Tick the Columns that you would like to be shown, and close the panel by clicking on

the OK Button.  The grid will be updated, and only the Columns that you ticked will be shown

in the grid.
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Grouping Columns

The data in the grid is initially displayed as single rows, with one row per data item, but it is

possible to group data together by a column or columns of your choice to display the data in a

more hierarchical manner.  

To group by a column, click the Group Panel button on the Toolbar.  

The grid will display a new area at the top of the grid, usually in dark blue, with text which says

"Drag a column header here to group by that column". To group the grid by a Column, grab

the header for the Column, and drag and drop it on to the Group Panel.

In this example, the Sector Column has been dragged and dropped on to the Group Panel. 

The display of the grid changes, with rows grouped together by the Sector Column.  Each

Sector in the grid can be collapsed or expanded by clicking on the +/- button.
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You can group the grid by more than one column, creating a hierarchy.  Just drag columns over

to the Group Panel, and position them before or after the column headers already there,

depending on the hierarchy that you want.  In the example below, the grid has been grouped by

three columns, creating nested levels.

To undo the grouping, you can either right-click on the Data Header of one of the grouped

columns, and select UnGroup from the context menu, or to clear all groups for all Columns,

right-click in the blue area of the Group Panel, and select Clear Grouping from the context

menu.
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Finding Data

To use the Find function and search for text in the grid, click the Find button on the Toolbar. 

A Find Panel will be displayed above the data grid.  Enter the text you want to search for, and

click the Find Button.  The rows that contain the text you are searching for, will be highlighted

in the grid

To clear the results and search for something else, click the Clear Button, and do another

search.  To close the Find Panel, click on the Find Button on the Toolbar again, or click on the

small x inside the Find Panel.

Filtering Data

To use the Filter function to reduce the number of rows shown in the grid by defining Filter

criteria, click the Filter Button on the Toolbar.  
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Clicking the Filter Button will display the Filter Editor panel, where you can define any number

of Filter criteria.  The panel allows you to join together several filters with Or or And, to create

more complex filters using several columns or using multiple conditions.  You can click on any

part of the Filter criteria, to change parts of the filter condition.  For example, in the example

above, the Filter criteria shows as "[FullName] Contains Standard".  You could click on

"FullName" to change the column that is being filtered, or click on "Contains" to change the type

of condition, or click on "Standard" to change the value being matched.

In the image above, the grid has been filtered on the Full Name column, matching rows which

contain the word "Standard".  Only rows which match the Filter are shown in the grid, the

remaining rows are excluded.  A small panel at the bottom of the grid shows the definition of

the current Filter that is in effect.  You can remove the Filter by click on the x next to the Filter

definition, or by clicking on the Filter Button in the Toolbar to switch the Filter off.  
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8.3 Countries

Countries Reference Data Screen

The Countries Reference Screen provides a list of all countries and the common country codes

that are used by various country classification systems.  If you select a County in the grid by

clicking anywhere on the row of a country, the Country Info panel above will be filled with

information about that country.  In the Country Info panel, you can see detailed information about

the country, for example the language and currency, the continent and region it belongs to, and the

country codes used by other classification systems.

Options Panel

The Options panel has the following controls:

Find Code - Find a country by country Code.  You can enter numerical or ISO3 codes, for

example "826" or "GBR".

Find Name - Find a country by Name.  You can enter partial names, for example "United".

Continent - Select a Continent, and list only the countries that belong to that Continent.

Region - Select a Region, and list only the countries that belong to that Region.

WB Category - Select a World Bank Category, and list only countries that belong to that

Category.

Reset Button - Clear all the selection options, Reset the screen, and show all countries.

The Options panel and the Country Info panel can be collapsed or expanded by using the white

triangle button in the panel header.  
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8.4 Country Groups

Country Groups Reference Data Screen

The Country Groups Reference screen allows you to view the definition of standard Country

Groups.  Data has been loaded for a number grouping systems, for example Comtrade, Wits, the

World Bank, etc.  You can view the Country Groups for a particular system, or for all systems.  If

you click on a Country Group in the top grid, the member Countries for that group will be shown in

the bottom grid.  You can use the horizontal splitter-bar in between the two grids to resize the

relative height of the two grids.

Selection Panel

The Selection Panel has the following controls:

Group System - Select the Country Group System to show Country Groups for.

Country Group - Select the Country Group to see the Country Members for.

Group Type - Select the type of Country Group to see the Country Groups for. 
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8.5 Nomenclatures

Nomenclatures Reference Data Screen

The Nomenclatures Reference Screen provides a list of all the standard Nomenclatures and

product classification systems.  Each row shows one Nomenclature, and in the columns you can

see the full description, the start and end year, and information about the Digit-Levels and

Comtrade availability of the Nomenclature.  If you select a Nomenclature by clicking on it in the

top grid, the bottom grid will list the Digit-Levels that belong to the selected Nomenclature.  You

can use the horizontal splitter-bar in between the two grids to resize the relative height of the two

grids.
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8.6 Products

Products Reference Data Screen

The Products Reference Screen provides a complete list of all the Product Codes or

Commodities for all the standard Nomenclatures.  After selecting a Nomenclature and a Digit-

Level, all the Product Codes that belong to that Nomenclature will be listed in the grid at the

selected Digit-Level.  The columns in the grid show the full Product Description, the Parent Code,

and in some cases the Sector that the product belongs to.

Options Panel

The Options Panel has the following controls:

Nomenclature - Select the Nomenclature for the products you want to view.

Digit Level - Select the Digit-Level for the products you want to view.

Find Code - You can find a specific product code, by entering it into the Find Code box.

Find Name - You can find a product name, by entering part of the name into the Find Name box.

Reset - Use the Reset Button to clear the find filters and to reset the screen.

Products - The number of product rows for the current selection is shown.
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8.7 Product Groups

Product Groups Reference Data Screen

The Product Groups Reference Screen allows you to view definitions of different Product Group

Schemes, and to see the member Products that belong to each Product Group in a scheme. 

Select the Product Scheme in the Selection Panel, and the list of Product Groups for that Scheme

will be displayed in the grid.

You can load your own definitions of Product Groups.  You can either do that from this screen by

clicking the Import Button  on the screen's toolbar, or by using the normal Loading Data option

on the main menu, and then selecting Load Product Groups in the Data Loading Selector dialog.

For more information, see Loading Product Groups.

Options Panel

The Options Panel has the following controls:

Nomen - Select the Nomenclature that you want to list Product Groups for.  You can set this to

All.

Digit-Level - Select the Digit-Level that you want to list Product Groups for.  You can set this

to All.

Group Scheme - Select from the list of Product Group Schemes to show the Product Groups

for.

Delete Group Scheme - If you have a selected a Product Group Scheme that you loaded

yourself, you can use this button to delete it.  The standard Product Group Schemes that come

with TradeSift, cannot be deleted.



Reference Data 237

© InterAnalysis Ltd. 2012

Row Count - Displays the number of Rows in the grid for the selected Product Group Scheme.
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8.8 Concordances

Concordances Reference Data Screen

The Concordances Reference Screen allows you to view the standard Concordances between

Product Codes in different classification systems or Nomenclatures.  You can view a complete list

between two Nomenclatures, or you can search for specific Product Codes in either of the two

Nomenclatures to find the Concordance.

Options Panel

The Options Panel has the following controls:

Source Nomen - Select the Source Nomenclature that you want to see Concordances From.

Target Nomen - Select the Target Nomenclature that you want to see Concordances To.

Find Source Code - Enter a Product Code that you want to Find in the list of Products for the

Source Nomenclature.

Find Target Code - Enter a Product Code that you want to Find in the list of Products for the

Target Nomenclature.

Reset Button - Clear all the Selections and Reset the screen.
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8.9 Goods Types

Goods Types Reference Data Screen

The Goods Types Reference Screen allows you to view the definitions of the Goods Types, which

define broad categories based on the BEC classification, such as "Capital Goods", "Intermediate

Goods", etc.  These Goods Type definitions are used in the Vertical Intra-Industry Specialisation

Indicator (VIIS).  See the section on the VIIS Indicator for more information, or refer to the

Conceptual Manual.  When you select a Goods Type, the grid shows the BEC Product Codes

which make up that Goods Type, (for example "Capital Goods").  

Options Panel

This screen has an extra feature to allows you to see which Product Codes a particular Goods

Type would correspond to in a different Nomenclature, even though the Goods Types are defined

by using BEC Product Codes.  For example, if you select "Capital Goods" as the Goods Type, the

top grid will show which BEC Product Codes have been defined as Capital Goods.  If you then

wanted to know which Product Codes that would encompass in the H3 classification, you could

select H3 in Show Products In, and the bottom grid would show all the H3 Product Codes (using

Concordance tables) which correspond to the BEC Product Codes that belong the selected Goods

Type.

The Options Panel has the following controls:

Goods Type - Select the Goods Type to see a list of the BEC Product Codes that make up that

Goods Type.

Show Products In - See explanation above.

 Note:
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Although this screen uses Concordance tables when the Show Products In option is used,

showing Concordances is not the main purpose of this screen.  To see a full list of

Concordances, use the Concordances Reference Data Screen.
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8.10 Currencies

Currencies Reference Data Screen

The Currencies Reference Screen provide a list of standard international Currency Codes.  The

grid shows a list of all codes, including the full descriptive name, and the currency symbol if

available.

Options Panel

The Options Panel has the following controls:

Find Code - Enter a currency Code to Find.

Find Name - Enter a currency Name to Find.

Reset Button - Clear the Find boxes, Reset the screen, and show all Currencies.
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9 Indicators

This chapter explains how to calculate Indicators in TradeSift.  Refer to the  Conceptual Manual

for guidance on which indicator to use for certain analyses and why.

Topics covered in this chapter

 Indicators

Indicators Overview

List of Indicators

Calculating an Indicator
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9.1 Indicators Overview

Indicators

The previous sections on Project Data describe how to view loaded data, such as trade data and

tariff data.  The normal data screens display data that you have loaded, but Indicators go one step

further - they use your loaded Project Data to calculate Indicators, and they then display the

Indicator results in a data grid.  The results of the Indicator calculations can be saved so that they

can be recalled again later, and all the standard data functions are available, such as sorting,

filtering, pivoting, change and percentage calculations, etc.  The Indicator results can then be used

to form the basis of Charts and Tables, which you can then include in your project Documents.

You can access the Indicators via the Main Menu, the Toolbar, or the Navigator.

Main Menu ToolBar Navigator

Indicator Topics

This section covers:

Data Requirements

Indicator Screens

Other topics in this chapter:

List of Indicators

Calculating an Indicator

To learn about making Charts and Tables from Indicator results, see these topics:

Charts

Tables

Data Requirements

All Indicator calculations use the project data that you have loaded in to your project as the

basis for the calculations.  Typically this will be trade data, GDP data, etc.  This means that

before you can calculate any Indicators, you must first load the required data.  (See the section

on Loading Data.)  You must first make sure that you have the relevant data loaded, for
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whichever countries, partners, years, etc., that you want to calculate Indicators for.  The exact

data that is required varies between Indicators, for example in some cases additional data such

as GDP data is required.  Refer to the List of Indicators section, for details of exactly which data

each Indicator requires.  

In some cases if you try to calculate an Indicator and some of the required data is not present

in the project, warning messages will be displayed saying that the Indicator could not be

calculated.  This is not a program error, this just indicates that the specific data that the 

Indicator needs to do the calculation, is not loaded in your project.  The warning message

should show you exactly which data is required.

You may have data loaded at several different levels of aggregation.  By default, if you ask for

an indicator at the 2-Digit level for example, TradeSift will use your 2-Digit data to calculate this.

 If you only have 6-Digit data loaded, TradeSift will aggregate the data to the 2 and 4 digit

levels, and it will also calculate total trade if that is required by the calculation.  If the program

has to calculate figures by aggregating from a more detailed Digit-Level, the resulting figures

may vary slightly depending on which Digit-Level is used for the aggregation.  This is due to

discrepancies in the Comtrade raw data and categorisation issues (namely of UN special code

products), which causes that the sum of all the product levels at the 2-Digit level may not equal

the respective sum at the 4 or 6-Digit level. 

It should be noted that if you are using your own data in TradeSift, it may not be possible to

calculate some indicators depending on your data.

 Indicator Screens

Every Indicator Screen shares the same overall screen layout, which is also the same as the

layout for normal data screens, as described in the section on Data Screens.  The Indicator

Screens have the same layout containing the following screen sections:

Toolbar

Data Selection Buttons

Info Panel

Display Options Panel

Tabs

Data Grid

Refer to the section on Data Screens for a detailed explanation of how these screen sections

are used.  The only difference between the Data Screens and the Indicator Screens, is that in

the Indicator Screens there is an additional Data Selection Button, used to select the Sub-

Type of Indicator that should be calculated.  This is the first large button on the screen, and

appears before the Nomen button.  The image below shows an example of an Indicator

Screen.  The tabs at the bottom of the screen have two sections for Help and Concepts.  The

Help tab shows the page from the User Manual describing how to calculate an indicator.  The

Concepts tab shows the relevant page from the Conceptual Manual explaining the economics

concepts behind the specific indicator.
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For the procedure to calculate an Indicator, see the section on Calculating an Indicator.
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9.2 List of Indicators

TradeSift can calculate the following Indicators:

OPN - Openness Indicator

RCA - Revealed Comparative Advantage

TCI - Trade Concentration Index

FKI - Finger-Kreinin Index

IIT - Intra-Industry Trade

RMA - Revealed Market Access

RECPI - Relative Export Competitive Pressure Index

TII - Trade Intensity Index

VIIS - Vertical Intra-Industry Specialisation

Each of the basic Indicators may also have several Sub-Types, allowing for variations in the way

the calculations are made.  Refer to the Conceptual Manual for detailed explanations and help on

the economic theory behind each of the Indicators.  See the sections below for a quick explanation

of what each indicator does, and the data that is required to calculate it.

 Indicator Source Data

TradeSift can calculate indicators using different types of source data for the calculation, for

example Trade Data or Services Data.  This is dependent on the data that you have loaded in

your project.  The table below shows which indicators can use which type of data.

Indicator Description Trade Data Service Data

OPN Openness Indicator * *

RCA Revealed Comparative Advantage * *

TCI Trade Concentration Index * *

FKI Finger-Kreinin Index *

IIT Intra-Industry Trade * *

RMA Revealed Market Access * *

RECPI Relative Export Competitive Pressure Index *

TII Trade Intensity Index * *

VIIS Vertical Intra-Industry Specialisation *

OPN - Openness Indicator

Description
The Openness Indicator (OPN) is used to analyse the openness of a country with respect to

the world, or another country.

Sub-Types
The OPN Indicator has 2 Sub-Types:

Standard - To analyse the openness of a country with respect to the world. (Imports +

Exports / GDP).

By Exports - To analyse the openness of a country with respect to the world. (Exports / GDP).

Data Requirements
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The Standard Openness Indicator requires:

The Country's Total Imports from the World.

The Country's Total Exports to the World.

The Country's Current GDP data.

The Openness By Exports Indicator requires:

The Country's Total Exports to the World.

The Country's Current GDP data.

RCA - Revealed Comparative Advantage

Description
The Revealed Comparative Advantage Indicator (RCA) gives an indication of those industries

in which a given country may have a comparative advantage.

Sub-Types
The RCA Indicator has 3 Sub-Types:

Standard RCA (With World) - Provides an indication of a country’s comparative advantage

in particular industries, with respect to the world.

Bilateral RCA-1 (Relative to another country) - Shows the extent to which a country has a

revealed comparative advantage for a given product, in comparison to another country.

Bilateral RCA-2 (In a particular market) - Shows the extent to which a country has a

revealed comparative advantage for a given product in a particular market.

Options
Normalised - Forces the indicator results into the range -1 to +1.

Data Requirements
The RCA Standard Indicator requires:

The Country's Exports to the World.

The World's Exports to the World.

The RCA Bilateral-1 Indicator requires:

The Country's Exports to the Partner country.

The World's Exports to the World.

The RCA Bilateral-2 Indicator requires:

The Country's Exports to the World.

The World's Exports to the World.

TCI - Trade Concentration Index

Description
The Trade Concentration Index Indicator (TCI) assesses the degree of concentration /

diversification of a given country's exports.   

Sub-Types
The TCI Indicator has 2 two Sub-Types:

By Product (On Exports) - Analyses how concentrated the commodity export structure is of a
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given country.  An index equal to 1, means that the country only exports one product.

By Product (On Imports) - Analyses how concentrated the commodity import structure is of

a given country.  An index equal to 1, means that the country only imports one product.

Data Requirements
The TCI By Product On Exports Indicator requires:

The Country's Exports to the Partner country.

The TCI By Product On Imports Indicator requires:

The Country's Imports from the Partner country.

 FKI - Finger-Kreinin Index

Description
The Finger-Kreinin Index Indicator (FKI) provides a way of comparing the similarity between

either the structure of imports or exports, or the structure of production between any two

countries. 

Sub-Types
The FKI Indicator has 2 Sub-Types:

By Common Source - One reporter into two or more partners:

To compare the degree of similarity in the Exports of one country into two separate markets.

(e.g. The similarity of UK's Exports to Japan and Korea.)

By Common Destination - Two or more reporters into one partner:

To compare the degree of similarity in the Exports of two countries into one particular market.

(e.g. The similarity of UK's and Korea's Exports to the World.)

Data Requirements
The FKI By Common Source Indicator requires:

The Country's Exports to every Partner country.

The FKI By Common Destination Indicator requires:

Every Reporter Country's Exports to every Partner country.

 IIT - Intra-Industry Trade

Description
The Intra-Industry Trade Indicator (IIT) measures the overlap of imports and exports at a

given aggregation level.  That is, the extent to which two countries are simultaneously trading

the same product category.

Sub-Types
The IIT Indicator has 1 Sub-Type:

Standard

Data Requirements
The IIT Indicator requires:

The Country's Exports to the Partner country.

The Country's Imports from the Partner country.
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RMA - Revealed Market Access

Description
The Revealed Market Access Indicator (RMA) compares the level of market access into a given

economy with the level of access into a comparator economy.

Sub-Types
The RMA Indicator has 2 Sub-Types:

Normalised by GDP - The RMA measure is normalised by the GDP of the receiving countries,

 thereby accounting for the size of the receiving economies.

Normalised by Imports - The RMA measure is normalised by the total imports of the

receiving countries, thereby accounting for the size of the receiving economies.

Data Requirements
The RMA Normalised by GDP Indicator requires:

The Country's Exports to the first Partner.

The Country's Exports to the second Partner.

The first Partner's Exports to the World.

The second Partner's Exports to the World.

The RMA Normalised by GDP Imports requires:

The Country's Exports to the first Partner.

The Country's Exports to the second Partner.

The first Partner's Current GDP data.

The second Partner's Current GDP data.

RECPI - Relative Export Competitive Pressure Index

Description
The Relative Export Competive Pressure Index Indicator (RECPI) is designed to show the

average degree of competition country C faces in country A's market from country B.

Sub-Types
The IIT Indicator has 1 Sub-Type:

Standard

Data Requirements
The RECPI Indicator requires:

The first Country's Exports to the Partner country.

The second Country's Exports to the Partner country.

TII - Trade Intensity Index

Description
The Trade Intensity Index Indicator (TII) identifies the extent to which a given country's value

of trade is more concentrated with respect to a particular partner country or region, in

comparison to its trade with the rest of the world.
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Sub-Types
The TII Indicator has 1 Sub-Type:

Standard

Data Requirements
The TII Indicator requires:

The Country's Exports to the Partner country.

The Country's Exports to the World.

The World's Exports to the Partner country.

The World's Exports to the World.

 VIIS - Vertical Intra-Industry Specialisation

Description
The Vertical Intra-Industry Specialisation Indicator (VIIS) is provides the means to analyse

the relationship between a given countries imports of goods and exports of goods at different

levels of processing.

Sub-Types
The VIIS Indicator has 3 Sub-Types:

VIIS-1 (Simple)

VIIS-2 (Real)

VIIS-3 (-1 to +1)

Data Requirements
The VIIS Indicator requires:

The Country's selected 'Trade Flow 1' with the first Partner.

The Country's selected 'Trade Flow 2' with the second Partner.
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9.3 Calculating an Indicator

This section describes how to calculate an Indicator.  The basic procedure is the same for all

Indicators.

For a general introduction to the subject of Indicators, see the Indicators Overview.

For a list of the available Indicators and a short description of each together with its data

requirements, see the List of Indicators.

To calculate an Indicator, follow the steps described below.

 1.  Selecting the Indicator

To calculate an Indicator, first select the required Indicator Screen via the Main Menu, the

Indicators Toolbar, or the Indicators Group in the Navigator Panel on the left.  If you are

using the Start Page, once data has been loaded in your project the Start Page will also show a

list of Indicators, and clicking on the blue link will open the Indicator Screen.

2.  Indicator Help and Concepts

When the Indicator Screen is first opened, only two of the Tabs are displayed, which are the

Help Tab and the Concepts Tab.  This is to provide some general help information about the

Indicator.

Help Tab - Displays help from the User Manual, with information about how to calculate an

Indicator.

Concepts Tab - Displays help from the Conceptual Manual, with information about the

purpose of the particular Indicator.
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3.  Choosing the Indicator Sub-Type

Using the Indicators screens works in much the same way as selecting data via the Data

Wizard.  (See Data Selection.)   When you open the required Indicator screen, a row of large

Data Selection Buttons will be displayed, and only the first button will initially be enabled.  The

first button is used to select the specific Sub-Type of indicator to calculate, and it is labeled with

the short name of the indicator, for example "RCA".  Click this Indicator Type button to get

started.

The Data Selection Wizard dialog will be displayed, which works in exactly the same way as for

all normal data selections, the only difference is that it has one additional step in the selection

sequence, which is the first Indicator Type step.  The image below shows the first step of the

Data Selection Wizard for the RCA Indicator as an example:
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This first step of every Indicator Selection requires that you choose the Sub-Type of Indicator

to be calculated.  A small panel at the top lists the Sub-Types of Indicator that you can choose

from.  Click on the Sub-Type that would like to calculate.  As you click each type, the info panel

below displays some brief information about the selected indicator type.  (Note that some 

Indicators may only have one Sub-Type at present, but the options panel is still displayed for

the sake of consistency, and to allow for other Sub-Types of the Indicator to be added in the

future.  In those cases you do not need to select anything.)

Some Indicators may have some extra options, which will be displayed below the Sub-Type

panel.  (For example, in the above image of the RCA Wizard, you can see there is a Normalised

option.)

After selecting the required Indicator Sub-Type, click the Next button to proceed to the next

step.

 4.  Making the Indicator Selection

After you have selected the Indicator Sub-Type in the first step and clicked the Next Button,

you can proceed with the rest of the Indicator Selection, which involves choosing the

Nomenclature and Digit-Level, the Countries and Partners, and the Years and Industries.  

If your project has different types of data loaded which are suitable for use as the basis for the

indicator calculation, you will be given the option to choose which data to use for the

calculation, for example Trade Data or Services Data.  See the next topic Choosing Indicator

Source Data.
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From this point on, using the Data Selection Wizard follows the exact same procedure as when

making a normal data selection.  (See the section about the Data Selection Wizard.)  Proceed

through all of the selection steps until you have completed the selection.

 5. Choosing Indicator Source Data

Indicators can use different types of source data for the indicator calculation, for example Trade

Data or Services Data, depending on the data that you have loaded.  If you have more than

one of these data types loaded in to your project, the Nomen/Level step of the indicator

wizard will let you choose which data to use for the calculation in the Type of Data selection

box.

For a list of which indicators can use which data, see the List of Indicators and Source Data.

 6.  Starting the Indicator Calculation

When you have reached the end of the Indicator Selection, the final step in the Data Selection

Wizard will show an informational panel with a summary of your Indicator Selection.  You can

return to any of the previous steps if you want to amend your selection.  A button at the the

bottom of the dialog will become enabled and its label will change to Calculate (instead of

Show which is displayed in Data Screens).  Click the Calculate Button to start the Indicator

Calculation.
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Force Recalculation
Beneath the selection summary panel, there is an option called Force Recalculation.  Normally

you should leave this option unticked.  If you have calculated an Indicator, and saved the results

to be recalled later, and you then perform the exact same indicator calculation again, to save

time the program will not actually make the calculation a second time, it will recall the previously

saved results.  If you want to force the program to ignore the saved results and to recalculate

the indicator again, you can tick the Force Recalculation option.  This might be required for

example if you reloaded or updated some of the source data that was used for the calculation

(for example trade data), and you want to force the Indicator to recalculate using the new data.

7. Indicator Calculation Progress

After you have clicked the Calculate Button, the selection dialog will close, and the calculation

process will start.  Depending on the complexity of the Indicator, the Digit-Level you selected,

and the number of Countries and Years you selected, the calculation may take some time. 

While the Indicator is being calculated, a dialog will be display the progress of the calculation.



TradeSift User Manual258

© InterAnalysis Ltd. 2012

 8.  Indicator Results

Data Grid
When the Indicator calculation has finished, the results will be displayed in the data grid. 

Depending on the specific Indicator, the results may be a value per product, or a single

summary value per country.  In the example below, the RCA Indicator has been calculated for 3

countries, and the grid has been pivoted by country, to show the indicator results in 3 parallel

columns for the 3 countries.

Info Panel
The Info Panel will shows a summary of your Data Selection for the Indicator calculation, and

also extra information such as the currency and units of the source data used, and the method

of data aggregation.  For example if you request Indicator results at the 2-Digit level, but the
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data loaded in your project is 6-Digit, the program will aggregate the 6-Digit data up to 2

digits, and then perform the indicator calculation on the aggregated 2-Digit data.  This is

indicated in the Info Panel in the line that says: "Data Method: Aggregated from 6-Digit data." 

The final section in the Info Panel tells you the number of rows in the calculated results, and it

may also display a warning message.  In this example, the warning message is telling you that

the total trade figures required for the calculation were not taken from actual loaded total trade

data, but they were aggregated from 6-Digit data.

Display Options
When the Indicator results are calculated and displayed in the grid, you have access to all the

usual functions in the Display Options panel for manipulating the data.  (See the section on

Display Options.)  In particular, the Quick Limit button will be set to show you the top 10

indicator results.  If you calculated an RCA for example, the Quick Limit's button label will be

"Top RCA", and clicking on this button will limit the data grid to show only the highest 10 RCA

values.

 9.  Log and Warnings

After the Indicator has been calculated, the Log and Warnings tabs next to the Indicator

Results tab, show additional information about the calculation process.  The Log tab shows a

chronological log of the calculation, which data was fetched for the calculation, and from where,

the number of rows returned, etc.  The log can be useful if you need to look into any problems

that occurred during the calculation.  
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The Warnings tab shows a summary of specific problems or warning messages from the

calculation.  For example if you requested an Indictor to be calculated for 10 countries, and the

required data was not present in your project for some of those countries, you can use the 

Warnings tab to find out precisely which data was missing.

 10.  Saving Indicator Results

You can optionally Save the Indicator Results so that they can be recalled later.  The procedure

for saving Indicator Results is the same as for saving any project item - use the small SaveAs

button in the indicator screen's toolbar:   See the section about Saving Project Items for more

details.  The save dialog will suggest a name based on the data selection, but you can type over

this and choose your own name.
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When the Indicator Results have been saved, the saved Indicator will be added to the relevant

group in the Project Explorer.  The Indicator can be recalled in the future by double-clicking on

the item in the explorer list.  For more details, see the section about the Project Explorer.

11.  Indicator Charts and Tables

You can create Charts and Tables from the calculated Indicator Results.  You must first

calculate the Indicator, and arrange the results as you need them in the data grid.  It may be

useful to use the Limit Function to home in on the top results in the grid.  You can then use the

large Chart and Table buttons at the top of the screen, to create the Chart or Table.

For full details on creating Charts and Tables, see the following sections:

Charts

Tables





Part

X
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10 Charts

This chapter describes how to work with Charts in TradeSift.

Topics covered in this chapter

 Charts

Charts Overview

Creating Charts

Chart Options

Saving and Recalling Charts
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10.1 Charts Overview

Charts

TradeSift can create Charts or graphs from all the Project Data that you have loaded in to your

Project, for example Trade Data, Tariff Data, GDP data, etc.  You can also make Charts from the

results of any calculations that the program makes, for example Indicators.  Any Charts that you

make can be saved so that they can be quickly recalled later.  All saved Charts can be included in

your Project Documents.

The procedure for creating a Chart is the same, regardless of the type of data, as described in the

steps below.

1. Open the Data Screen

To create a Chart, you must always start first with the data screen for the type of data that you

want to create the Chart for.  In the data screen you make your data selection to fetch and

display the required data.  (See the section on making a Data Selection.)

2. Arrange the Data Grid

If required, you can then apply functions to the data in the data grid, for example pivoting,

sorting, limiting, etc.  (See Display Options.)

3. Click the Chart Button

When you have arranged the data that you need for the Chart, you click the large Chart Button

to create the Chart from the data that is in the grid.  A new window will open displaying the

created Chart.

4. Use the Chart Options Dialog

Once the Chart has been created, there are many options for changing the type of Chart, and

the visual settings and labels of the Chart.  The Chart Options Dialog contains all the settings

for modifying the Chart.  This is described in more detail in the section about Chart Options.

5. Save the Chart

You can Save the Chart so that it can be recalled later, or included in one of your Project

Documents.  Use the small SaveAs Button on the chart screen’s toobar to Save the Chart. 

(See Saving Project Items.)

6. Print/Export the Chart

From the Chart Screen, you can also Print or Export the Chart, using buttons on the Chart

Screen’s toolbar.  (See Exporting & Printing.)

For a detailed example of exactly how to create a Chart, see the section on Creating Charts.

To learn how to modify a chart and to see a description of all Chart Options, see the section on

Chart Options.

Chart Topics

This chapter covers the following topics:

Charts Overview

Creating Charts

Chart Options

Saving and Recalling Charts
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10.2 Creating Charts

The basic steps to create a Chart are described in the Charts Overview.  This section gives detailed

walk-through of how to create a Chart, using the example of creating a Chart created from Trade

Data.  The same process can be used for any Project Data or Indicator Results.

 Generating a Chart

To create a Chart, you must always start first with the data screen that you want to create the

Chart for.  In this example, the Trade Data screen is used to fetch the UK's trade with the World

in the year 2005, at the 2-Digit product level.  (See Data Selection.)  This displays nearly 100

rows of data in the grid, which would make a very crowded graph.  The Top Exports button has

been clicked to limit the rows to 10, to show the Top 10 Exports. (See Data Limiting.)  After

using this Top N function, note that the Exports Value column has been highlighted in orange.

Once you have arranged or limited the data grid to prepare the data that you want to chart,

click the large Chart Button to generate the chart.  The chart needs to know which column or

data field to plot on the chart's Y-Axis.  If none of the columns on the data grid is highlighted,

the program will take the first column in the grid's data area, and use that for the Y-Axis.  If you

want to choose exactly which column should be used for the Y-Axis, click on the column header

of the data field you want to plot before clicking the Chart Button.  In the example above, the

Top 10 function was used, which automatically highlighted the Exports Value column, so when

the Chart Button is clicked, the Exports Value column will be plotted on the Chart's Y-Axis.

The chart generation also need to know which data column to use for the X-Axis and for the

Chart Series.  The program will try to choose these values for you based on how the data grid

is arranged, however once the chart has been generated, you can change these values or

reconfigure the chart according to your requirements.  In the current example, there is only one

partner country and only one year, but there are multiple products, so in this case the program

would choose the Product field for the X-Axis and the Chart Series fields.
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The Chart Screen

After clicking the Chart Button, the chart will be generated and it will be displayed in a new

window.  In the image below you can see the screen tab for the original Trade Data Screen,

and next to it the new window tab for the Chart Screen.  The Chart Screen displays the

generated chart based on initial default values.  From the Chart Screen you can work further

with the Chart, by using functions on the Chart Screen Toolbar, which is explained in the next

section.

The Chart Toolbar

The top of the Chart Screen has a toolbar with buttons for working with the chart.  

The Chart Toolbar has the following buttons:

 Open - Open a previously saved chart.

 Save - Save changes to an already saved chart.

 Save As - Save the current chart, supplying a name.  (See Saving Charts.)

 Export - Export the data/item to a file.

 Print - Print the current data/item directly.

 Print Preview - Print the current data/item via a print preview dialog.

 Return To Data - Return to the original data screen that was used to generate the chart. 

(See Returning to Chart's Source Data.)

 Find Data Screen - Find the data screen that generated the chart, and highlight the tab

window.

 Refresh Data - Refresh the chart with new data, if the original data screen has changed

the data selection.  (See Refreshing the Chart.)

 Chart Options - Open the Chart Options Dialog.  (See Modifying the Chart and Chart
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Options.)

 Zoom In - Zoom in on the chart.

 Zoom Out - Zoom the chart out.

 Zoom Reset - Reset the zoom so that the whole chart is visible.

 Help - Open the User Manual for Help about Charts.

 Maximise Screen - Maximise the chart screen so that it fills the screen and only the chart

screen is visible.

Modifying the Chart

The most important button the Chart Toolbar is the Chart Options Button.    

This button opens the Chart Options Dialog, which gives you full control over the settings and

appearance of the Chart. 

For a full explanation of all the options for modifying a chart, see the section on Chart Options.

Refreshing the Chart with New Data

After creating the Chart, the Chart Screen is still linked back to the Data Screen that the chart

was created from.  You can go back to the data screen either by clicking on the data screen's

window tab, or by using the Return To Data button on the Chart Toolbar.  
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If you then change the data selection in the Data Screen, the chart will not automatically be

updated to reflect the change, because you may want the chart to stay as it is.  However if you

do want the chart to be updated with the change in the source data, click on the Refresh Data

button on the Chart Toolbar. 

You can generate multiple charts from the same Data Screen.  You could click the Chart Button

to create the first chart, return to the data screen, change the data selection, click the Chart

Button again which will create a second chart in a new window, and so on.  You can repeat this

process to generate multiple chart from the same data screen.
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10.3 Chart Options

After creating a Chart from a data screen, the chart is initially created with default settings and

TradeSift attempts to choose the best settings for the axes and chart series based on the type of

data used.  You can then modify the chart settings to get exactly the chart you want, and to change

the appearance.  There are many options for changing the chart, you can choose from many

different chart types, change which data fields are assigned to the axes, change the titles, labels,

colours, and so on.  There are also options for showing/hiding individual series on the chart,

limiting the data values shown, and adding point labels to show data values.

All the chart settings are available via the Chart Options Dialog, which can be opened by clicking

on the Chart Options Button on the toolbar.  

The Chart Options Dialog is organised into a set of Options Pages, similar to the Wizard style

dialogs used elsewhere in the program, however unlike the data selection wizards, it is not

necessary to go through the options pages in any particular order.  Each Options Page is listed in

the panel on the left and relates to a related group of chart settings.  You can move between the

pages just by clicking on the name of the Options Page in the list on the left, or by using the Back

and Next buttons at the bottom of the dialog screen.  After opening the Chart Options Dialog,

you can go straight to the Options Page that interests you, and modify the settings on that page. 

You can then either close the dialog, or move to another page to continue changing settings.

The Chart Options Dialog has the following buttons at the bottom of the screen:

Help - To open the User Manual and get context-sensitive Help about the Chart Options

Dialog.

Back - To move Back to the previous Options Page.

Next - To move forward to the Next Options Page.

Apply - To Apply the current settings to the Chart so that the Chart will be redrawn and you can

see the affect of your changes, but without closing the dialog.

OK - To apply the current settings to the Chart and close the dialog.

Cancel - To Cancel any changes you made to the settings, and restore the chart to its previous

settings.

As you change settings in the Chart Options Dialog, the settings are not immediately applied to

the Chart.  You can change several settings, and then to see the effect of the new settings on the

Chart, click the Apply Button.  The Chart Options Wizard stays open so that you can continue to

change further settings, but you will see that the Chart in the screen behind will change.  You can

continue to experiment with changing settings, and click Apply each time you want to see the

changes in the chart.  When you have finished, click OK to close the dialog, which also applies all

current settings.  To close the dialog without applying the settings and to restore the Chart to its

previous state, click the Cancel Button.

The following sections describe each of the chart options pages in detail, with an explanation of the

function of all of the controls on each page.

Chart Type

The Chart Type options page is where you select the type of chart or diagram that is used to

represent the data.  There are two ways to select the Chart Type, you can either use the

dropdown list at the top of the panel, which contains a complete list of all the possible Chart

Types.  Or, you can use the gallery below, which is organised into broad groups of Chart

Types, with a row of icons in each group representing the different types.  Just click on the icon

for the Chart Type that you want to use.
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Chart Setup

The Chart Setup options page is where you define how the chart is plotted, by setting which

data fields are used for the axes and series.  The three key fields which completely control how

the chart is drawn, are the X-Axis field, Y-Axis field, and the Series By field.  The values that

you can select in each of these three controls come from the data columns that were present in

your data screen when you generated the Chart.  By changing the data columns that are

assigned to these three areas of the chart, you can change what the chart is plotting and how

the chart is arranged.
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Chart Setup Options
X-Axis Field - The data column assigned to the X-Axis field determines which data will be

plotted along the bottom X-Axis of the chart.

Y-Axis Field - The data column assigned to the Y-Axis field determines which data will be

plotted to left Y-Axis of the chart, and therefore it controls what all the data points in the

main chart area represent.

Series By - If the chart data has multiple sets of values, the chart can be organised in to

several Series.  The data column assigned to the Series By field determines which data field is

used to separate the Series.

Add Field Button - The Add Field button with the Plus symbol is used to create an

additional Y-Axis field.  You can plot more than one data field on the Y-Axis, for example

Imports and Exports.  To do this, click the Add Field button, and select another field to be

plotted to the Y-Axis.  When additional fields have been added, a new button labelled

Remove Field will appear next to the new Y-Axis field.  Use this button if you want to remove

the Y-Axis field from the chart.  (Note: the affect in the chart will not be visible until you click

the Chart Option Dialog's Apply button.)

Data Fields

The Data Fields options page is where you change settings for the data fields that are assigned

to the chart. The term Data Field refers to which types of data you have assigned to the y-plane
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of the chart, (for example Import, Exports, etc.).  A list to the left shows the Data Fields that are

currently in use on the chart.  You can add or remove Data Fields by using the two buttons

below the list, Add Data Field, and Remove Data Field.  (The Add Data Field button is just a

shortcut that takes you to the Chart Setup page which is where you normally add and remove

data fields for the Y-Axis.  For more information, see Chart Setup.)  The controls on the right

show the settings for the currently selected Data Field.  You must first select a Data Field from

the list on the left, so view or change its settings. The most important control is the first one, 

Assign to Y-Axis.  This is how you control which of the two Y-Axes (left or right) the selected

Data Field is assigned to.  Select Y1 or Y2 to assign the field to an axis.

Data Field Options
Assign to Y-Axis - Select Y1 or Y2, to assign the current Data Field to the first (left) Y-Axis

or second (right) Y-Axis.

Y-Axis Options Button - Shortcut that takes you to the Y-Axis options page for the currently

selected Y-Axis.

Chart Type - Sets the Chart Type for the Data Field.  This means that you could have for

example one Data Field as a Bar Chart, and another Series as a Line Chart.

Style Options Button - The Style Options Button opens the Chart Type Style Dialog where

you can set visual settings for the current chart type for the series, for example colours, fill

styles, gradients, etc.

Show Point Labels - Controls whether Point Labels are shown for each Data Point,

displaying the data value of the point.
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As Percentage - Sets the Point Labels to show a Percentage value instead of the absolute

value.

Decimal Places - Sets how many Decimal Places are shown in the Point Labels.

Label Spacing - Sets the distance between adjacent point labels.

Label Position - Sets the position of point labels. (Mainly applies to Pie Charts or similar

chart types.)

Overlapping Mode - Sets the mode for how overlapping point labels should be handled.

(Mainly applies to Pie Charts or similar chart types.)

Point Labels Style - Sets the format of the information that should be displayed in the Point

Labels.  You can choose from the following values: X-Axis, Values, X-Axis & Values, Series

Name, Series & Values.

Point Labels Font Button - Opens a text properties dialog that allows you to set the

appearance of the point labels, colours, fonts, etc.

Point Marker Style - Some Chart Types display a marker for each Data Point, for example

Line Charts.  The Point Marker Style selects the type of marker to use for the Data Points.

X-Axis

The X-Axis options page is where you can change all the settings related to the X-Axis of the

Chart.  The selection of which data field is plotted to the X-Axis is done in the Chart Setup

page, this page deals with other settings for the X-Axis.
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X-Axis Options
X-Axis Title - The checkbox controls whether the X-Axis Title is visible, and in the box next

to it you can type in the text to be used for the axis title. 

Show X-Axis - Controls the visibility of the X-Axis.  If this is not ticked, the X-Axis will not be

visible.

X-Axis Title Font Button - Clicking the Font Button to the right of the X-Axis Title displays

a Text Properties Dialog where you can choose settings for the font, size, colour,

background, etc.

Side Margin - If the Side Margin option is on, the chart leaves some blank space between

the chart elements and the X-Axis.  If this option is off, the chart elements are butted right up

to the edges of the X-Axis.

Grid Lines - Controls whether the background to the chart area shows vertical Grid Lines.

Show X-Axis Labels - Sets whether the labels for each of the X-Axis tick marks should be

shown.  Unticking this option will switch the X-Axis labels off.

Stepped Labels - If the X-Axis labels do not fit well on the axis, the Stepped Labels option

will "stagger" alternating labels on different lines so that more of the label cam be seen.

Label Lines - Controls how many Lines of text are used for each of the X-Axis labels.  For

example if you set this to 5, the X-Axis labels can wrap over on up to 5 lines.

Label Width - Controls the maximum Width of each of the X-Axis labels.  This is used in

conjunction with the Label Lines option to format the X-Axis labels.

Label Interval - Sets how often the X-Axis tick marks should display a label.  A value of 5

would mean that only every 5th label will be displayed.
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Labels Font - The Labels Font Button allows you to set the font characteristics of the X-Axis

labels.

Labels Angle - You can slant the X-Axis labels at an angle which in some cases can make

them fit better.  The Labels Angle setting controls the angle of the slant.  You can set the

angle by moving the slider control to the left or right, or by entering a numerical value in the

box to the right of the slider.

Labels Angle Reset Button - Resets the Labels Angle slider to the middle position and the

angle to zero.

Data Point Sorting - Determines how the Data Points are sorted within each Series.  You

can choose from X-Axis or Y-Value.  X-Axis will sort the Data Points based on the

corresponding X-Axis value of the point.  Y-Value will sort the Data Points based on their Y-

Axis data values.

Data Point Order - Determines if the Data Points are sorted in Ascending or Descending

order.

Y-Axis

The Y-Axis options page is where you can change all the settings related to the Y-Axis of the

Chart.  The selection of which data field is plotted to the Y-Axis is done in the Chart Setup

page, this page deals with other settings for the Y-Axis.

A chart can have up to two Y-Axes, one on the left and another on the right.  To have more than

one Y-Axis, you must first have more than one Data Field added to the chart.  To add extra

Data Fields to the Y-plane of the chart, go to the Chart Setup page and use the Add Field

button.  Then go to the Data Fields page, and assign one of the Data Fields to the second Y-

Axis.  In the Y-Axis Options page, options can be set independently for the 2 Y-Axes.  The

Select Y-Axis control at the top of the page allows you to select which of the two Y-Axes you

are viewing/changing the settings before.  If you click the radio-button for Y-Axis 1, the options

below will show for the first Y-Axis on the left of the chart.  If you clock the radio-button for Y-

Axis 2, the options below will shoe for the second Y-Axis on the right of the chart.  To change

any options for either axis, you must first select which axis you want to change using the Select

Y-Axis radio buttons at the top of the options page.
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Y-Axis Options

Select Y-Axis - These 2 radio-buttons select which of the Y-Axes you are viewing/changing

the options for (explained above).

Show Y-Axis - Controls the visibility of the Y-Axis.  If this is not ticked, the Y-Axis will not be

visible.  The info label to the right shows you which Data Fields are currently assigned to the

Y-Axis.

Y-Axis Title - The checkbox controls whether the Y-Axis Title is visible, and in the box next

to it you can type in the text to be used for the axis title.  

Y-Axis Title Font Button - Clicking the Font Button to the right of the Y-Axis Title displays

a Font Dialog where you can choose settings for the font, size, colour, background, etc.

Y-Axis Units - Allows you to set the Number Units for the Y-Axis labels, from Thousands,

Millions, and Billions.

Y-Axis Decimals - Controls how many Decimal Places are used for the number values

displayed on the Y-Axis scale.

Y-Axis Range - Allows you to limit the range of values displayed on the Y-Axis.  If this option

is on, the Y-Axis will only show the range of values specified by the Min and Max boxes.

Y-Axis Range Min - Set the Minimum value of the Y-Axis Range.

Y-Axis Range Max - Set the Maximum value of the Y-Axis Range.

Show Scale Breaks - If some of the data values on the chart are much larger than the rest, it

can sometimes be difficult to see the smaller values.  The Scale Breaks option breaks up the

higher values with a wavy line, and redraws the chart, so that the smaller values can be seen.

Scale Breaks Number - If the Scale Breaks option has been enabled, this option sets how
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many breaks should be used.

Side Margin - If the Side Margin option is on, the chart leaves some blank space between

the chart elements and the Y-Axis.  If this option is off, the chart elements are butted right up

to the edges of the Y-Axis.

Grid Lines - Controls whether the background to the chart area shows horizontal Grid Lines.

Show Y-Axis Labels - Sets whether the labels for each of the Y-Axis tick marks should be

shown.  Unticking this option will switch the Y-Axis labels off.

Stepped Labels - If the Y-Axis labels do not fit well on the axis, the Stepped Labels option

will "stagger" alternating labels on different lines so that more of the label can be seen.

Label Interval - Sets how often the Y-Axis tick marks should display a label.  A value of 5

would mean that only every 5th label will be displayed.

Labels Font Button - The Labels Font Button allows you to set the font characteristics of

the Y-Axis labels.

Labels Angle - You can slant the Y-Axis labels at an angle which in some cases can make

them fit better.  The Labels Angle setting controls the angle of the slant.  You can set the

angle by moving the slider control to the left or right, or by entering a numerical value in the

box to the right of the slider.

Labels Angle Reset Button - Resets the Labels Angle slider to the middle position and the

angle to zero.

Series

The Chart Series options page allows you to set various settings for each Series in the Chart. 

The selection of which data field controls the splitting of the Chart into different Series is done

in the Chart Setup page, this page deals with other settings for each Series.  The left-hand panel

shows a list of all the Series in the Chart, and to help identify them more easily, the background

colour of each Series in the list is the same as the colour of the Series element drawn on the

Chart.  (In the screen image below, each Series is a 2-Digit Product code.)  The controls on the

right are all the attributes of a single Series that you can change.  To change the settings for a

Series, you must first click on the Series name in the list on the left, and the controls to the right

will show the current settings for the selected Series.  You can then modify the settings, which

will only affect the currently selected Series.  The name of the Series that is currently selected

and which the controls will apply to, is shown in brackets next to the Show Series option (In the

example below, it shows "(22)", meaning the Series for Product 22.)
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Series Options
Show Series - Controls whether the Series is visible.  You can hide a series without having to

remove it from the data, by unticking this option.

Chart Type - Sets the Chart Type for the Series.  This means that you could have for example

one Series as a Bar Chart, and another Series as a Line Chart.

Style Options Button - The Style Options Button opens the Chart Type Style Dialog where

you can set visual settings for the current chart type for the series, for example colours, fill

styles, gradients, etc.

Colour Each - For Chart configurations where every chart element (for example every bar) is

the same colour because it belongs to the same Series, setting the Colour Each option will

set each element (bar) to a distinct colour.

Series Sorting – This option applies to the whole chart and determines the order

the series are displayed in both the chart and series legend.  Series Number is the

default and sorts the chart by the original series labels (before any translations are

applied).   Series Name will sort by the displayed series labels and Series Value

will sort by the series values being charted.  If there are multiple Y-Axis fields, the

Y-Fields Order option will sort the series in the same order as the Y-Axis fields

appear in the list of Data Fields. (When the Chart Type is set to one of the Stacked

Bar types, the Series Sorting can be used to control the order of the "bricks" in the

stack.)

Series Order - The Series Order option changes the sorting order from Ascending
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or Descending.

Sort By Type - If this option is ticked, the sorting will be done according to the

setting in Series Sorting, but ALSO by the Chart Type (Bar, Line, etc).  This is useful

if you have multiple Data Fields and you want to control which ones appear "on

top".

 Note:

There is some overlap between the visual appearance settings on this options page, and the

settings on the Data Fields page.  The difference is that any options set on the Series page,

apply only to the specific series that you have selected.  Options set on the Data Fields page,

will apply to all the series that belong to the particular data field.

Titles & Labels

The Titles & Labels options page has settings which control the visibility, text, and font settings,

of all the main Titles and Labels in the Chart.  Note that some of the Titles can also be set on

other pages in the Chart Options Dialog, but they are all grouped together on this page, so

that you can easily edit all the Titles in one place.
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Titles/Labels Options
For each of the Titles shown on the options page, the checkbox controls whether the title is

visible or not, the main box is where you enter the text of the title, and the Font Button to the

right is used to display the Font Options Dialog, where you can choose the text properties,

such as the font and style, size, colour, background, etc.

Chart Title - The Chart's main Title.

Sub Title - The Chart's Sub-Title, below the main title.

X-Axis Title - The Title for the X-Axis.

Y-Axis Title - The Title for the Y-Axis.

Y-Axis-2 Title - The Title for the second Y-Axis. (If a second Y-Axis is in use.)

Legend - The font settings for the Chart's Legend panel.

Data Source - The settings for the Chart's Data Source label which is shown in the bottom

left corner of the Chart.

Adjust Sizes - A slider control which can be used to globally adjust the font size of all of the

titles.  For example if you slide this to the right to a value of +4, the font size of all of the

chart's titles will be made 4 point sizes larger.

Reset Defaults Button - The Defaults Button will return all the font and size and

appearance settings of all the Chart Titles back to their original default values.

Legend

The Legend options page allows you to modify the appearance of the Chart Legend.  

The Legend is the panel showing the key to all the Chart Series, usually in the top right corner

of the chart (see example image above).
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Legend Options
Show Legend - Sets whether the chart's Legend panel is visible or not.

Legend Style - Set the format of the information shown for each Series in the Legend.  You

can choose from the following values: X-Axis, Values, X-Axis & Values, Series Name, Series

& Values.

Horizontal Alignment - Controls where the Legend panel is shown Horizontally on the

chart in relation to the main chart area.  The Inside checkbox sets whether the legend panel is

shown inside or outside the main chart pane.

Vertical Alignment - Controls where the Legend panel is shown Vertically on the chart in

relation to the main chart area.  The Inside checkbox sets whether the legend panel is shown

inside or outside the main chart pane.

Direction - Sets the Direction of the flow of the items inside the Legend panel.

Max Width - Sets the Maximum Width of the Legend panel as a percentage of the overall

width of the chart.  If this is set to 20%, this allows the Legend panel width to occupy 20% of

the overall width of the chart.

Max Height - Sets the Maximum Height of the Legend panel as a percentage of the overall

height of the chart.  If this is set to 80%, this allows the Legend panel height to occupy 80% of

the overall height of the chart.

Font & Size - The Legend Font button opens the Font Dialog, which allows you to set all

the Font settings for the text in the Legend panel.
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 Annotations

A chart Annotation is a way of marking a significant point on a chart with a text note.  You can

add as many Annotations as you want to a chart.  To add an Annotation, right-click anywhere

on the chart where you would like to add the note, and select Add Annotation.  A popup box

will let you type in some text.  You can then freely move around or resize the Annotation by

dragging using the mouse.

The Annotations page of the Chart Options Dialog, lists all the chart's Annotations in a panel

on the left.  Select the Annotation from the list on the left, and then use the controls on the

right to modify it.
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Delete Annotation - Use the Delete Annotation Button to remove the currently selected

Annotation.

Edit Appearance - Click the Edit Appearance button for a dialog which allows you to change

the colours and fonts and appearance of the Annotation.

Annotation - Edit the text in the box to change the text of the Annotation.

Appearance

The Chart Appearance options page has settings for the colours and styles used for the visual

appearance of the Chart.  Some of these settings also appear on the Series Options page,

however the settings on this page are applied to the whole chart, to all Series, whereas the

Series Options page allows you to set individual settings separately for each Series.
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Appearance Options
Colour Palette - Sets the Colour Palette that controls the colours used for chart elements

drawn on the chart, for example the colour of each bar in a Bar Chart.

Chart Appearance - There are a number of pre-configured Appearance schemes that you

can choose from.

Rotate Chart -If this option is ticked, the chart will be rotated through 90 degrees, the

position of the axes will be reversed, and the chart will be displayed horizontally instead of

vertically.

Interlaced Background - You can set the chart background to be "interlaced", which displays

alternating coloured stripes aligned to the Y-Axis.  You can either switch this off, or choose

for the stripes to be aligned with the left Y-Axis, the right Y-Axis, or both Y-Axes.

Chart Area Bkg - The checkbox controls whether the Chart Area Background (the central

chart pane) displays a Background.  The 2 colour boxes set the colours of the background, if

2 different colours are set, a gradient effect is produced.

Chart Background - The checkbox controls whether the entire chart displays a Background,

and the colour box sets the background colour.

Chart Border - Sets whether a thin Border is drawn around the outside edges of the chart. 

(The border may not be very visible in the Chart Screen, but it will be visible when you insert

Charts in to Documents.)

Show Logo - Sets whether the TradeSift logo is displayed in the corner of the chart.
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Country Display - Sets how Countries should be displayed in Charts, whether to show

country codes, country names, or a combination.

Product Display - Sets how Products are displayed in Charts, whether to show product

codes, product names, or a combination.

Product Length - Where Product Names are displayed in Charts, you can use this option to

limit the maximum length of the product names that are shown.

 Chart Templates

The Templates options page allows you to store all your Chart Options as a Chart Template,

which can be recalled later and applied to other Charts.

Template Options
Chart Template - If any settings have previously been saved as Templates, this dropdown

list will allow you to recall a Chart Template.

Delete Chart Template - If a Chart Template has been selected, you can delete it by using

the Delete Chart Template button.

Save Template As - To save the current Chart Options as a Template, enter the name you

would like to save as in the Save Template As box.

Save Settings As Template - After entering a name for the Template, click the Save Settings

As Template button to save the settings as a Chart Template.
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Save Settings As Default - This button will save the current chart settings as the default

template, which means that newly created charts in the future will use these settings as the

default.

10.3.1 Chart Type Style Dialog

The Chart Type Style dialog is reached from the Data Fields or Series pages of the Chart Options

Dialog, by clicking the Style Options button.

This dialog allows you to change various appearance settings for the current Chart Type.  The

options that will be displayed may be different depending on the Chart Type.

Series/Data Field - This selection box allows you to change which Data Field or Series you are

viewing or changing the style settings for.

Chart Type - Sets the the type of Chart (Line, Bar, Area, etc.) for the current Series of Data Field.

Fill Style - Sets the Fill Style to be used to fill Series which have solid areas of colour, such as

Bars or Areas.  You can choose from Solid, Gradient, or Hatch.

Gradient Style - If the Fill Style is set to Gradient, this option sets the style and direction of the

Gradient Style.

Line Style - For Chart Types that display Lines, the Line Style sets whether the line is solid,

dotted, etc.
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Hatch Style - If the Fill Style is set to Hatch, this option sets pattern of the Hatch Style.

Colour - Sets the main Colour of the Series.  If the Fill Style is set to Hatch Style, this option

changes to Hatch Colour, and controls the colour of the Hatch pattern.

Colour 2 - For Fill Styles that use 2 colours, for example gradients, this sets the second Colour

to be used.  If the Fill Style is set to Hatch Style, this option changes to Base Colour, and

controls the underlying base colour under the Hatch pattern.

Opacity % - The Opacity Percentage is used when Series are overlapping each other.  An

Opacity value of 100% means that it is a solid colour with no transparency.  As you reduce the

Opacity Percentage, the colour becomes more transparent, and elements of both overlapping

Series can be seen.

Show Border - The checkbox controls whether the Border is shown. 

Border Colour - Sets the Colour of the Border.

Border Size - Sets the Width of the Border.

Show Shadow - The checkbox controls whether the Shadow is shown.

Shadow Colour - Sets the Colour of the Shadow.

Shadow Size - Sets the Size of the Shadow.

Apply - To Apply the current settings to the Chart so that the Chart will be redrawn and you can

see the affect of your changes, but without closing the dialog.

OK - To apply the current settings to the Chart and close the dialog.

Cancel - To Cancel any changes you made to the settings, and restore the chart to its previous

settings.
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10.4 Saving and Recalling Charts

This section describes how to Save and Recall Charts, and how to work with saved Charts.

 Saving Charts

When you have created a Chart and adjusted the display and settings to create the type of

Chart you want, you can save the finished Chart so that it can easily be recalled again later, or

included in one of your Project Documents.  To save the Chart, click on the Save As button on

the Chart Toolbar.  

A Save Dialog will ask you to choose a name to save the Chart as, and a name will be

suggested which you can change.  Click the Save Button, and the Chart will be saved and

added to the Project Explorer.

For more details about saving project items, see Saving Project Items.

For an explanation of the use of the Project Explorer, see Project Explorer.

 Recalling Charts

To recall a Chart that you saved previously, there are three possible methods.  You can either

use the Project Explorer, or the Open Chart Button on the main program screen's Toolbar, or

the Open Button on the toolbar in a Chart Screen.

Project Explorer
To open a chart using the Project Explorer, find the required Chart in the explorer's list inside

the Charts Group.  Double-click on the chart name in the list, or right-click on the chart name

and select Open from the popup menu.  The Chart will be recalled, a new Chart Screen will be

opened, and the chart will be displayed with all the settings as they were when you save the

chart.

Main Toolbar

To open a Chart from the main Toolbar, click the Open Chart button.  

The Open Chart Dialog will be displayed, with a dropdown list of all the saved Charts.  Select

the Chart you want from the dropdown list, and click the Open Button.
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Chart Toolbar
If you already have a Chart Screen open, you can open a different Chart in that screen by using

the Open Button on the Chart Toolbar.  

The same Open Chart Dialog as described above will be displayed.

Changing a Saved Chart

The first step in changing a saved Chart is to re-open the Chart by using one of the methods

described in Recalling Charts.  Once you have recalled a Chart, you may want to change some

of the chart settings.  You can use the Chart Options Dialog and modify any of the chart

settings in the usual way. (See Chart Options.)  

After you have changed the chart, the Save Button on the Chart Toolbar will appear.  

Note that the Save As Button will also be present.  

The difference between the two buttons, is that the Save Button is to save changes you have

made to the existing Chart that you recalled, so this button is only ever visible after recalling a

saved item.  The Save As Button is so that you can save a new copy of the Chart using a

different name.

To give an example, imagine you created and saved a chart called Chart1.  You recall that chart

and make some changes to it.  You could then use the Save Button which would re-save and

update the saved Chart.  You would still only have one chart called Chart1, and it would include

the recent changes you made.  If instead you clicked Save As Button, and gave the name

Chart2, you would end up with two charts.  Chart1 would be the original unchanged chart. 

Chart2 would the new chart that you created by modifying Chart1.  What this means is that you

can create variations of charts by recalling existing charts, modifying them, and saving them with

a new name.  In some cases this may be easier than starting from the beginning with a data

selection to create a new chart.

In the above example, only the Chart Options were changed, but the source data which forms

the basis of the chart was not changed.  It is also possible to return to the source data and

modify the data selection, and then update the Chart with the new data.  You could then re-save

the Chart, or save a new copy of the Chart, as described above.  See the next section Returning

to the Chart's Source Data.

 Returning to the Chart's Source Data

After recalling a saved Chart, it is possible to not only modify the Chart Options, but also to
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return to the Chart's source data, and make a change to the Data Selection, and then update

the Chart with the new data.  To do this, use the following procedure:

1. Recall a saved Chart.  (See Recalling Charts.)

2. Click the Return To Data Button on the Chart Toolbar.  

3. The original Data Screen will opened in a new window.  For example, if the Chart was based

on trade data, clicking the Return To Data button will open the Trade Data Screen, and

recall the exact Data Selection that was used to create the Chart.

4. Switch to the Data Screen, and modify anything you like, you can completely change the Data

Selection and fetch new data, or adjust the Display Options to change the data grid.

5. Switch back to the Chart Screen, and the Refresh Data Button on the Chart Toolbar will

have become enabled.  Click the Refresh Data Button.  

6. A dialog box will ask you to confirm that you want to Refresh the chart with the changes to

the Data Screen.  Click OK.

7. The Chart will be refreshed and redrawn based on the new or modified data from the Data

Screen.

8. If you want to save the changes to this Chart, or save this as a new Chart, use the Save

Button or Save As Button.  (See Changing a Saved Chart.)

 Inserting Charts in Documents

Saving Charts has two main purposes, the first is simply so that you can recall them to view

them again, and the second is so that you can include the chart images in your Project

Documents.  For a Chart to be included in a Document, it must be saved first.  (See Saving

Charts.)  The Report Writer and Project Documents and are explained in full in the chapter

about the Report Writer.

For a detailed explanation of how to insert a Chart in a Document, see Inserting Charts &

Tables in Documents.
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11 Tables

This chapter describes how to work with Tables in TradeSift.

Topics covered in this chapter

 Tables

Tables Overview

Creating Tables

Table Options

Saving and Recalling Tables
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11.1 Tables Overview

Tables

TradeSift can create Tables of data from all the Project Data that you have loaded in to your

Project, for example Trade Data, Tariff Data, GDP data, etc.  You can also make Tables from the

results of any calculations that the program makes, for example Indicators.  Any Tables that you

make can be saved so that they can be quickly recalled later.  All saved Tables can be included in

your Project Documents.

The procedure for creating a Table is the same, regardless of the type of data, and it is the same

as the procedure for producing Charts.  To create a Table, follow the steps below.

1. Open the Data Screen

To create a Table, you must always start first with the data screen for the type of data that you

want to create the Table for.  In the data screen you make your data selection to fetch and

display the required data.  (See the section on making a Data Selection.)

2. Arrange the Data Grid

If required, you can then apply functions to that data in the data grid, for example pivoting,

sorting, limiting, etc.  (See Display Options).

3. Click the Table Button

When you have arranged the data that you need for the Table, you click the large Table Button

to create the Table from the data that is in the grid.  A new window will open displaying the

created Table.

4. Use the Table Options Dialog

Once the Table has been created, there are many options for changing the type of Table, and

the visual settings and labels of the Table.  The Table Options Dialog contains all the settings

for modifying the Table.  This is described in more detail in the section about Table Options.

5. Save the Table

You can Save the Table so that it can be recalled later, or included in one of your Project

Documents.  Use the small SaveAs Button on the table screen’s toobar to Save the Table. 

(See Saving Project Items.)

6. Print/Export the Table

From the Table Screen, you can also Print or Export the Table, using buttons on the Table

Screen’s toolbar.  (See Exporting & Printing.)

For a detailed example of exactly how to create a Table, see the section on Creating Tables.

To learn how to modify a Table and to see a description of all Table Options, see the section on

Table Options.

Table Topics

This chapter covers the following topics:

Tables Overview

Creating Tables

Table Options

Saving and Recalling Tables
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11.2 Creating Tables

The basic steps to create a Table are described in the Tables Overview.  This section gives detailed

walk-through of how to create a Table, using the example of creating a Table created from Trade

Data.  The same process can be used for any Project Data or Indicator Results.

 Generating a Table

To create a Table, you must always start first with the data screen that you want to create the

Table for.  In this example, the Trade Data screen is used to fetch the UK's trade with the World

in the year 2000, at the 2-Digit product level.  (See Data Selection.)  The Top Exports button has

been clicked to limit the rows to 10, to show the Top 10 Exports. (See Data Limiting.)  After

using this Top N function, note that the Exports Value column has been highlighted in orange.

Once you have arranged or limited the data grid click the large Table Button to generate the

Table.  All of the columns which are currently visible in the grid will be included in the Table. 

Although you can later hide columns from the Table using the Table Options Dialog, you can

control which columns are initially included in the table by first adjusting the grid to show only

the columns that you want.  (See Choosing Columns.)

The Table Screen

After clicking the Table Button, the table will be generated and it will be displayed in a new

window.  In the image below you can see the screen tab for the original Trade Data Screen,

and next to it the new window tab for the Table Screen.  The Table Screen displays the

generated table based on initial default values.  From the Table Screen you can work further

with the Table, by using functions on the Table Screen Toolbar, which is explained in the next

section.
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The Table Toolbar

The top of the Table Screen has a toolbar with buttons for working with the table.  

The Table Toolbar has the following buttons:

 Open - Open a previously saved table.

 Save - Save changes to an already saved table.

 Save As - Save the current table, supplying a name.  (See Saving Tables.)

 Export - Export the data/item to a file.

 Print - Print the current data/item directly.

 Print Preview - Print the current data/item via a print preview dialog.

 Return To Data - Return to the original data screen that was used to generate the table. 

(See Returning to Table's Source Data.)

 Find Data Screen - Find the data screen that generated the table, and highlight the tab

window.

 Refresh Data - Refresh the table with new data, if the original data screen has changed

the data selection.  (See Refreshing the Table.)

 Table Options - Open the Table Options Dialog.  (See Modifying the Table and Table

Options.)
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 Page Settings - Open a dialog to set the page orientation and page margins.

  Page Scale - Set the scaling of the table to control how it fits on the page.

 Find - Find text in the contents of the table.

 Mutiple Pages - Set if the screen should show single or multiple pages.

 Zoom In - Zoom in on the table.

 Zoom Out - Zoom the table out.

 Help - Open the User Manual for Help about Tables.

 Maximise Screen - Maximise the table screen so that it fills the screen and only the table

screen is visible.

Modifying the Table

The most important button on the Table Toolbar is the Table Options Button.  

This button opens the Table Options Dialog, which gives you full control over the settings and

appearance of the Table. 

For a full explanation of all the options for modifying a table, see the section on Table Options.

Refreshing the Table with New Data

After creating the Table, the Table Screen is still linked back to the Data Screen that the table

was created from.  You can go back to the data screen either by clicking on the data screen's

window tab, or by using the Return To Data button on the Table Toolbar.  
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If you then change the data selection in the Data Screen, the table will not automatically be

updated to reflect the change, because you may want the table to stay as it is.  However if you

do want the table to be updated with the change in the source data, click on the Refresh Data

button on the Table Toolbar. 

You can generate multiple tables from the same Data Screen.  You could click the Table Button

to create the first table, return to the data screen, change the data selection, click the Table

Button again which will create a second table in a new window, and so on.  You can repeat this

process to generate multiple table from the same data screen.
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11.3 Table Options

After creating a Table from a data screen, the table is initially created with default settings and

TradeSift attempts to choose the best settings for the table.  You can then modify the table settings

to get exactly the table you want, and to change the appearance.  There are many options for

changing the layout of table, you can choose to show or hide certain columns, you can change the

sizes, spacing, titles, fonts, colours, and so on. 

All the table settings are available via the Table Options Dialog, which can be opened by clicking

on the Table Options Button on the toolbar.  

The Table Options Dialog is organised into a set of Options Pages, similar to the Wizard style

dialogs used elsewhere in the program, however unlike the data selection wizards, it is not

necessary to go through the options pages in any particular order.  Each Options Page is listed in

the panel on the left and relates to a related group of table settings.  You can move between the

pages just by clicking on the name of the Options Page in the list on the left, or by using the Back

and Next buttons at the bottom of the dialog screen.  After opening the Table Options Dialog,

you can go straight to the Options Page that interests you, and modify the settings on that page. 

You can then either close the dialog, or move to another page to continue changing settings.

The Table Options Dialog has the following buttons at the bottom of the screen:

Help - To open the User Manual and get context-sensitive Help about the Table Options

Dialog.

Back - To move Back to the previous Options Page.

Next - To move forward to the Next Options Page.

Apply - To Apply the current settings to the Table so that the Table will be redrawn and you can

see the affect of your changes, but without closing the dialog.

OK - To apply the current settings to the Table and close the dialog.

Cancel - To Cancel any changes you made to the settings, and restore the table to its previous

settings.

As you change settings in the Table Options Dialog, the settings are not immediately applied to

the Table.  You can change several settings, and then to see the effect of the new settings on the

Table, click the Apply Button.  The Table Options Wizard stays open so that you can continue to

change further settings, but you will see that the Table in the screen behind will change.  You can

continue to experiment with changing settings, and click Apply each time you want to see the

changes in the Table.  When you have finished, click OK to close the dialog, which also applies all

current settings.  To close the dialog without applying the settings and to restore the Table to its

previous state, click the Cancel Button.

The following sections describe each of the table options pages in detail, with an explanation of the

function of all of the controls on each page.

Titles

The Titles options page is where you can set the text and font properties of the Table's Titles.

 The Table can have two Titles and two Footers.  
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Titles Options
For each of the Titles shown on the options page, the checkbox controls whether the title is

visible or not, the main box is where you enter the text of the title, and the Font Button to the

right is used to display the Font Options Dialog, where you can choose the text properties,

such as the font and style, size, colour, background, etc.

Table Title - Sets the visibility, text, and font properties of the Table Title.

Sub Title - Sets the visibility, text, and font properties of the Table Sub-Title.

Table Footer - Sets the visibility, text, and font properties of the Table Footer.

Sub Footer - Sets the visibility, text, and font properties of the Table Sub-Footer.

Adjust Sizes - A slider control which can be used to globally adjust the font size of all of the

titles.  For example if you slide this to the right to a value of +4, the font size of all of the

tables's titles will be made 4 point sizes larger.

Defaults Button - The Defaults Button will return all the font and size and appearance

settings of all the Table Titles back to their original default values.
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Table Columns

The Table Columns options page allows you to choose which data columns are included in the

Table, and to set the attributes of each Table Column.  The left-hand panel shows a list of all

the Columns in the Table.  The controls on the right are all the attributes of a single Column

that you can change.  To change the settings for a Column, you must first click on the Column

name in the list on the left, and the controls to the right will show the current settings for the

selected Column.  You can then modify the settings, which will only affect the currently selected

Column.
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Table Columns Options
Show Column - Controls whether the Table Column is shown in the Table.  Untick this

option to remove a Column from the Table.

Column Header - Allows you to change the text of the Column Header in the Table.  This

defaults to the column name, you can use this option to create your own column

headings.  When the Column Header is set to the default Column Name,

TradeSift will space out words and may apply other translated values to the

column heading (for example ImportsRank will appear as “Imports Rank”).  If you

change the column heading TradeSift will only add line breaks between words to

keep the heading within the column width.

Column Width - Sets the Width of the Column in the Table. If Apply to all Columns is

ticked the selected column width will be applied to all columns not just the

selected column.  

Size All Columns Equally - If this option is ticked, the Column Width setting is

applied to all columns not just the selected column.  When you select this option

you are asked to confirm that you do actually want to apply the width to all

columns.
Precision - Sets the numerical precision (number of decimal places) of the selected Column.

Apply To Similar Columns - If this option is ticked, the Precision setting is applied to
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all similar columns not just the selected column.  For example if the column 2004

Imports Share was selected the precision would also be applied to the “Imports

Share” columns.  When you select this option you are asked to confirm that you do

actually want to apply the precision to other columns.

 Table Cells

The Table Cells options page contains settings for visual aspects of the Cells in the Table.

Table Cells Options
Cell Headers - Sets the Font Options for the Cell Headers.

Cell Details - Sets the Font Options for the Cell Details.

Even Row Colour - Sets the background colour of the Even numbered rows.

Odd Row Colour - Sets the background colour of the Odd numbered rows.
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 Page Settings

The Page Settings options page contains settings for the size, layout, and margins, of the Page

that the Table is displayed on.
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Page Settings Options
Page Orientation - Sets the Table's Page orientation to Portrait or Landscape.

Paper Size - Sets the Table's Paper Size.

Page Scaling - Allows you to Scale the size of page by a percentage, so that more of the

table will fit on a page.

Scale To Fit Page - Ticking the Scale To Fit Page option will resize the Table so that it can fit

on a single page.

Top Margin - Sets the Table Page's Top Margin in millimeters.

Bottom Margin - Sets the Table Page's Bottom Margin in millimeters.

Left Margin - Sets the Table Page's Left Margin in millimeters.

Right Margin - Sets the Table Page's Right Margin in millimeters.

Page Colour - Sets the Table Page's background Colour.

Display Options

The Display options page allows you to change various settings for the display of Numbers,

Countries, and Products, in the Table.
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Display Options
Number Units - Sets the Number Units for the display of currency values in the Table.  (For

example Thousands, Millions, Billions, etc.)

Precision - Sets the numerical Precision (number of decimal places) of the currency values in

the Table.

The Number Units and Precision settings only apply to the basic trade and currency values

such as Imports and Exports, etc.  To set the precision of other columns, use the Column

Options page.

Country Display - Sets how Countries should be displayed in Tables, whether to show

country codes, country names, or a combination.

Product Display - Sets how Products are displayed in Tables, whether to show product

codes, product names, or a combination.

Product Length - Where Product Names are displayed in Tables, you can use this option to

limit the maximum length of the product names that are shown.

 Table Templates

The Templates options page allows you to store all your Table Options as a Table Template,

which can be recalled later and applied to other Tables.
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Template Options
Table Template - If any settings have previously been saved as Templates, this dropdown

list will allow you to recall a Table Template.

Delete Table Template - If a Table Template has been selected, you can delete it by using

the Delete Table Template button.

Save Template As - To save the current Table Options as a Template, enter the name you

would like to save as in the Save Template As box.

Save Settings As Template - After entering a name for the Template, click the Save Settings

As Template button to save the settings as a Table Template.

Save Settings As Default - This button will save the current table settings as the default

template, which means that newly created tables in the future will use these settings as the

default.
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11.4 Saving and Recalling Tables

This section describes how to Save and Recall Tables, and how to work with saved Tables.

 Saving Tables

When you have created a Table and adjusted the display and settings to create the type of

Table you want, you can save the finished Table so that it can easily be recalled again later, or

included in one of your Project Documents.  To save the Table, click on the Save As button on

the Table Toolbar.  

A Save Dialog will ask you to choose a name to save the Table as, and a name will be

suggested which you can change.  Click the Save Button, and the Table will be saved and

added to the Project Explorer.

For more details about saving project items, see Saving Project Items.

For an explanation of the use of the Project Explorer, see Project Explorer.

 Recalling Tables

To recall a Table that you saved previously, there are three possible methods.  You can either

use the Project Explorer, or the Open Table Button on the main program screen's Toolbar, or

the Open Button on the toolbar in a Table Screen.

Project Explorer
To open a Table using the Project Explorer, find the required Table in the explorer's list inside

the Tables Group.  Double-click on the Table name in the list, or right-click on the Table name

and select Open from the popup menu.  The Table will be recalled, a new Table Screen will be

opened, and the Table will be displayed with all the settings as they were when you save the

Table.

Main Toolbar

To open a Table from the main Toolbar, click the Open Table button.  

The Open Table Dialog will be displayed, with a dropdown list of all the saved Tables.  Select

the Table you want from the dropdown list, and click the Open Button.
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Table Toolbar
If you already have a Table Screen open, you can open a different Table in that screen by using

the Open Button on the Table Toolbar.  

The same Open Table Dialog as described above will be displayed.

Changing a Saved Table

The first step in changing a saved Table is to re-open the Table by using one of the methods

described in Recalling Tables.  Once you have recalled a Table, you may want to change some

of the Table settings.  You can use the Table Options Dialog and modify any of the Table

settings in the usual way. (See Table Options.)  

After you have changed the Table, the Save Button on the Table Toolbar will appear.  

Note that the Save As Button will also be present.  

The difference between the two buttons, is that the Save Button is to save changes you have

made to the existing Table that you recalled, so this button is only ever visible after recalling a

saved item.  The Save As Button is so that you can save a new copy of the Table using a

different name.

To give an example, imagine you created and saved a table called Table1.  You recall that table

and make some changes to it.  You could then use the Save Button which would re-save and

update the saved Table.  You would still only have one table called Table1, and it would include

the recent changes you made.  If instead you clicked Save As Button, and gave the name

Table2, you would end up with two tables.  Table1 would be the original unchanged table. 

Table2 would the new table that you created by modifying Table1.  What this means is that you

can create variations of tables by recalling existing tables, modifying them, and saving them with

a new name.  In some cases this may be easier than starting from the beginning with a data

selection to create a new table.

In the above example, only the Table Options were changed, but the source data which forms

the basis of the table was not changed.  It is also possible to return to the source data and

modify the data selection, and then update the Table with the new data.  You could then re-save

the table, or save a new copy of the table, as described above.  See the next section Returning

to the Table's Source Data.

 Returning to the Table's Source Data

After recalling a saved Table, it is possible to not only modify the Table Options, but also to
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return to the Table's source data, and make a change to the Data Selection, and then update

the Table with the new data.  To do this, use the following procedure:

1. Recall a saved Table.  (See Recalling Tables.)

2. Click the Return To Data Button on the Table Toolbar.  

3. The original Data Screen will opened in a new window.  For example, if the Table was based

on trade data, clicking the Return To Data button will open the Trade Data Screen, and

recall the exact Data Selection that was used to create the Table.

4. Switch to the Data Screen, and modify anything you like, you can completely change the Data

Selection and fetch new data, or adjust the Display Options to change the data grid.

5. Switch back to the Table Screen, and the Refresh Data Button on the Table Toolbar will

have become enabled.  Click the Refresh Data Button.  

6. A dialog box will ask you to confirm that you want to Refresh the Table with the changes to

the Data Screen.  Click OK.

7. The Table will be refreshed and redrawn based on the new or modified data from the Data

Screen.

8. If you want to save the changes to this Table, or save this as a new Table, use the Save

Button or Save As Button.  (See Changing a Saved Table.)

 Inserting Tables in Documents

Saving Tables has two main purposes, the first is simply so that you can recall them to view

them again, and the second is so that you can include the tables in your Project Documents. 

For a Table to be included in a Document, it must be saved first.  (See Saving Tables.)  Project

Documents and the Report Writer are explained in full in the chapter about the Report Writer.

For a detailed explanation of how to insert a Table in a Document, see Inserting Charts &

Tables in Documents.





Part

XII



TradeSift User Manual314

© InterAnalysis Ltd. 2012

12 Report Writer

This chapter describes TradeSift's integrated Report Writer, and how to work with Documents.

Topics covered in this chapter

 Report Writer

Report Writer Overview

Report Writer Screen

Importing/Exporting Documents
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12.1 Report Writer Overview

Report Writer

TradeSift includes an integrated Report Writer, which allows you to write and edit Documents

directly in the program, without the need to use an external word-processing program.  This 

means that you can simultaneously use the program to carry out your analysis, and at the same

time edit a Document and write up your results and findings.  You can flip easily between any of

TradeSift's screens and your Document, which appears in another window inside the program.

The integration of the Report Writer in the program allows you to easily include in your Document

any outputs that you have created in TradeSift, for example Charts and Tables.  You can also

include external images in your Document.

When your Report/Document is complete, it can be exported to all common file formats, for

example Microsoft Word.

Report Writer Topics

This chapter covers the following topics:

Report Writer Screen

Importing/Exporting Documents



TradeSift User Manual316

© InterAnalysis Ltd. 2012

12.2 Report Writer Screen

This section describes how to create, edit, and save Documents, using TradeSift's integrated

Report Writer.

 Creating a New Document

To create a new empty Document in TradeSift, you can use any one of the following methods:

On the program's Main Menu, select Project > New Document.

On the main Toolbar, click the New Document button.  

In the Navigator on the left, select New Document inside the Project panel.

If the Project Explorer is open, right-click on the Documents group, and from the popup

menu, select New Document.

Whichever method you use, a new window will open up with a new empty Document displayed

as a blank page.

 Report Writer Screen

The Report Writer screen is similar to any normal word-processing program.  The Document

page is displayed in the center of the screen, and the top of screen has a set of toolbars with

buttons for all the typical word-processing functions.  If you hover the cursor over any of the

toolbar buttons, a tooltip will be displayed to explain the function of the button.  The top

toolbar used for the main Document functions like Saving and Printing is fixed, but the

remaining editor toolbars can be grabbed by the dotted grab-bar on the left, and dragged and

repositioned to suit your preference.
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 Report Writer Toolbar

The Report Writer screen has a main Toolbar, with buttons for the main functions for working

with Documents.

The Report Writer Toolbar has the following buttons:

New Document - Creates a new empty Document.

Save - Saves any change to the current Document.  This button only appears if the

Document has previously been saved.

Save As - Allows you to choose a name for the Document and Save it.

Import Document - Imports an external Document in to the Report Writer.  See

Importing Documents.

Export Document - Exports the current Document to an external Document.  See

Exporting Documents.

Print - Prints the current Document, via a standard Windows print dialog.

Print Preview - Shows a Print Preview window of the Document.

Page Settings - Displays a Page Settings dialog that allows you to set the page size,

orientation, and margins.

Undo - Undoes the most recent change to the Document.

Redo - Redoes the most recent change to the Document.

Help - Opens the Help Manual to show help about the Report Writer.

Maximise - Maximises the Report Writer screen to fill the entire screen.

 Saving Documents

When you create a new Document it is not initially saved until you either close it, or you

specifically choose to save it.  Until you assign it a name and save the Document, it remains in

an unsaved state, so as you are working on the Document and editing it, make sure that you
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save it so that you do not lose work.  To Save a Document, click on the Save As button on the

Document window's toolbar.    You will be prompted to choose a name for the Document,

and when you confirm the name, the Document will be saved, and you will see that it will be

added to the Project Explorer list inside the Documents group.  

As you continue to work on the Document, it is a good idea to frequently click the Save button

to save your most recent changes.  

 Note:

When you save Documents, they are saved embedded inside the TradeSift Project file, they

are not saved as separate files.  To learn how to import and export external document files,

see Importing/Exporting Documents.

 Inserting Charts and Tables

To insert any Charts and Tables that you have created in TradeSift in to your Document, you

must have previously saved the Chart or Table.  (See Saving Charts and Saving Tables.)  The

item that you want to insert in your Document must be visible in the Project Explorer on the

right.  To insert the Chart or Table in to your current Document, first position the caret on

your Document to the location where you want the item inserted.  Then just drag the Chart/

Table from the Project Explorer over to your Document, and drop it on to the page.  The

Chart/Table will be inserted at the location where the caret was.  You can also insert an item by

right-clicking on it in the Project Explorer, and selecting one of the Insert options from popup

menu.
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It is also possible to insert a Chart/Table in to the Document page sideways, in other words,

landscape.  To do this, hold down the Control Key when you are doing the drag and drop.  Or,

right-click on the item in the Project Explorer, and select Insert in Doc (Landscape) from the

popup menu.

 Tip:

Note that the location were you drop the document (or let go of the mouse button) is not

relevant, the chart will always be inserted at the current caret position in the Document, so it is

important that you position the caret before doing the drag and drop.  

 Importing Images

You can insert external Images in to your Documents.  If you have already imported some

images in to the Images group of the Project Explorer, (see Importing Images), you can just

drag and drop them on to the page of your open Document, in the same way as for Charts

and Tables.  (See Inserting Charts & Tables.)

You can also insert an Image directly in to a Document, even if it is not in the Project Explorer.

 Click on the Picture button on the Document's toolbar.  A file browser will allow you to select

the image file.
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12.3 Importing/Exporting Documents

The Report Writer saves your Documents inside the TradeSift project file.  When you open a

Project that you worked on previously, any Documents that you created in that Project will be

accessible via the Project Explorer, and they can be opened and edited inside TradeSift.  The

Documents do not exist as separate files outside of TradeSift.  However, you may sometimes want

to work with external document files.  The sections below describe how to import from and export

to, external documents.

 Importing Documents

If you have an external document that was created in another program such as Word, you can

import this document in to TradeSift so that it can be edited inside the Report Writer ,  and

then saved as a Project Document.  However, it is very important to understand that only a

complete document can be imported which will replace the currently open document, you

cannot "insert" the external document inside an already existing document.  This means that

importing external documents can only be used as starting point for editing, but it cannot be

merged with an existing document.

To import an external document, click the Import button on the Report Writer's toolbar.  

A standard Windows file browser dialog will allow you to select the external file to be loaded.

After loading the external file, you can edit it inside the Report Writer, and save it as a Project

Document, which will be added to the Project Explorer.

 Exporting Documents

When you have finished working on a Document using the Report Writer, you may want to

Export it to an external file.  Note that this is not necessary in order to continue editing and

working with the file in TradeSift, as the Document is saved inside the Project.  Exporting the

Document is entirely optional, if you want the Document as an external file in a different

format.

To Export a Document to an external file, click the Export button on the Report Writer's

toolbar.  

A Windows Save dialog will allow you to select the file format, the file name, and the location to

export to.  

After clicking Save in the dialog, the Document will be exported.

 External Document File Formats

The following file formats are supported for Importing and Exporting external documents.

Rich Text Format (.rtf)

Text Files (.txt)

HyperText MArkup Language Format (*.htm; *.html)

Web Archive (.mht)

Word 2007 Document (*.docx)

OpenDocument Text Document (*.odt)
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Word XML Document (*.xml)

Electronic Publication (*.epub)

Microsoft Word Document (*.doc)
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13 Tools

This chapter describes the functions in the Tools section, for Program Settings and checking for

updates to the program.

Topics covered in this chapter

 Tools

Program Settings

TradeSift Updates

Configure Updates
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13.1 Program Settings

You can access the Program Settings via the Main Menu, under Tools > Program Settings, or in

the Tools group of the Navigator panel.  This screen is where you can set various general settings

and preferences for the way that TradeSift functions.  There are five pages in the dialog:

Folders

Display

Options

Comtrade

Proxy Server

Language

You can access any one of the pages by clicking on the name of the settings group in the list on the

left, or you can move backwards and forwards between the pages by using the Back and Next

buttons.  The exact settings and options in each page are explained below.

Folders

The Folders settings page allows you to set the default folders that TradeSift uses.

Projects Folder - The default folder locations where TradeSift will store your Projects.

Packed Projects Folder - The default folder locations where TradeSift will store your Packed

Projects.
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Display

The Display settings page lets you customize settings for the format that TradeSift uses to

display common fields.

Country Display 

You can select the country format from the options shown below.  County Code refers to the

alphanumeric ISO3 country code, (for example "GBR"), Country Number refers to the standard

numerical country number code as used by Comtrade (for example "826"), and Country Name

refers to the full descriptive country name (for example "United Kingdom").

Number Units 

This setting controls the default number units that are used when displaying trade values, for

example Thousand, Millions, etc.  Note that this only applies to monetary values, such as

Imports, Exports, Trade Balance, etc.
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Decimal Places 

This setting determines the number of decimal places that are shown in data grids for numbers.

 Note that this only applies to monetary values, such as Imports, Exports, Trade Balance, etc.  It

does not apply to other fields like weights, quantities, indicators, etc.  The decimal places for

other fields can be set independently in the data grid, by right-clicking on any data cell and

selecting options for precision from the popup context menu.

Product Name Length 

This setting allows you to set a limit for the default length of product names that should be

displayed in data grids.  Some classifications schemes can have product names which are very

long.  If you set this setting to 50 for example, data grids will show the first 50 characters of the

product name, followed by "...".  However, note that this is only the initial default - if you drag

the column divider to widen the product name field in the data grid, the length of the product

name will expand to fill the available space.

 Tip:

You can always reveal the full product name in the data grids, by hovering the mouse over the

Product Code or Product Name columns, and the product name will be displayed in a tooltip.

Options

The Options settings page contains general preferences for actions the program

takes when it starts, and for project backups.
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Prompt for action when the program loads - Controls whether the initial dialog is displayed

when the program first starts, asking you what you want to do.  See Startup Dialog.

Use Project Defaults - Sets whether Data Selection Wizards will fill in selections based on

default values.  See Default Values.

Use Start Page - Controls whether the program displays the Start Page when it starts.  See

Start Page.

Max Selection Size - Sets the Maximum number of rows that a Data Selection can return

without displaying a warning message.  See Data Volumes.

Enable Backups - Sets whether TradeSift should make periodic automatic Backups of your

Project.

Backup Frequency - The number of minutes between running project backups.  (See below).

Max Backups - The maximum number of backup copies to keep.

The Backup Frequency setting controls the number of minutes between running project

backups.  For example a value of 5 will mean that a project backup is made every 5 minutes. 

When the project backup runs if there are changes to saved project items, a new backup file is

created.  If there have not been any changes to saved project items since the last automatic

backup, the backup is saved to a file named "[Project Name]AutoSave.bak", overwriting the

previous copy.

It is recommended that you keep the default values of Enable Backups selected with a Backup

Frequency of 5 minutes as TradeSift also uses the backup settings to control the backing up of

unsaved project items used in the auto recover option to restore your work should your

computer crash.  The TradeSift backups include all the project items that are shown in the

Project Explorer.  The backups do not include any underlying project data that these items use. 

The main purpose of the backups are to allow you to rollback any changes to charts, tables,
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documents etc. that you may have inadvertently saved.  Only the whole project can be restored

so the project restore option should be used with care.

Comtrade

If you have a Comtrade subscription and you want to use TradeSift's function to access

Comtrade over the internet and load data directly in to your Project, you need to set up your

Comtrade authorisation here.  Paste your Comtrade authorisation code in the box provided. 

You only need to do this once, thereafter TradeSift will use this code whenever you use the

Comtrade direct download function.  See Loading Data from Comtrade.

The authorisation code is described in more detail in this section: Comtrade

Authorisation Code.

Proxy Server

If your IT department requires that the Internet is only accessed through a Proxy Server,

TradeSift will not be able use various services on the Internet, including registering TradeSift

and direct Comtrade downloads (subscription required).  
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Use a Proxy Server - Enable use of a Proxy Server.

Use IE Proxy Settings - It is recommended that the Use IE Proxy Settings option is checked,

as it is likely that your IT department has already setup the necessary configuration settings to

allow Internet Explorer to access the Internet.

Proxy Server Address - If you do not have Internet Explorer configured on your computer,

you will have to leave the Use IE Proxy Settings option unchecked and enter the proxy server

address and port number into the Proxy Server Address box in the format required by your

IT department.

 Language

This option allows you to change the display language for TradeSift.
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User Interface
Use the system language - With the box ticked TradeSift will attempt to use the

operating systems base language for user interface elements and the help

manuals.  If the language is not supported TradeSift will default to using English.

Language - If Use the system language is not ticked you can select one of the

supported languages for the user interface elements and help manuals to be

displayed in.

Product Names
Use default product names - With the box ticked TradeSift will display product

names in English.  This checkbox will only be enabled if product names have

already been loaded for other languages.  The product names language does not

have to match the UI language being used.

Language - If Use default product names is not ticked you can select from the

list of languages associated with products already loaded.  If a specific product

does not have a name in the selected language the English name will be used.
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13.2 TradeSift Updates

The TradeSift Updates option makes an online check to see if there is a newer version of TradeSift

available.  This option is the same as selecting Check for Updates in the program's main Help

menu.  Checking for updates is described in more detail in the Installation chapter in the section

on Program Updates.
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13.3 Configure Updates

The Configure Updates option in the Tools section allows you to change how and when TradeSift

checks if there are updates available to the program.  This option is the same as selecting

Configure Updates in the program's main Help menu.  Configuring updates is described in more

detail in the Installation chapter, in the section Configuring the Updates.
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14 Messages & Warnings

This chapter describes various common messages or warnings that the program may display, and

their meanings.  

Topics covered in this chapter

 Messages & Warnings

Message Links

Warning Messages
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14.1 Message Links

All of the data screens and indicator screens, have an Info Panel which displays a summary of your

data selection.

In some situations, an Info or Warning messages may be displayed at the bottom of the panel.

The message is a link-label which can be clicked on to take you to a section in the User Manual

which will give you a more detailed explanation of the information or warning.

The message text will be blue for Info Messages, and red for Warning Messages.

Just click on the text of the message, and the User Manual will open in another window, with the

relevant message and its detailed explanation displayed.
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14.2 Warning Messages

The following are some of the most common info or warning messages that may be displayed in

the program.

 The data could not be found

The requested data could not be found. See the Log tab for further details.

This info message means that the data you requested in a data selection could not be

found in your project.

The Log tab of the data screen should list more precise details about exactly which data

could not be found.

Switch to the Log tab to see further details.

 Some of the requested data could not be found

Some of the requested data could not be found. See the Log tab for further details.

This info message means that you requested data for multiples countries or years, and

some of the data is not present in the project.

In this case, TradeSift will fetch all of the data that is loaded for your selection, and

display what it can, but there may be gaps in the data.

For example, if you requested trade data for UK with EU27 and WLD for 2000-2010, it

may be that data is not loaded for both country

pairs for all years.  TradeSift will fetch and display the data that is present.

This message is just to alert you to the fact that not all of the data was found.

 Total Trade Aggregated from N-Digit data

Warning: Total Trade aggregated from N-digit data!

This warning message is shown when you requested to see data for Total Trade, but no

actual data for Total Trade is loaded in your project.

If some other more disaggregated data is available, (for example 2-Digit, 4-Digit, 6-

Digit), TradeSift will use that data and sum up the values 

for all products to produce a figure for Total Trade.  However this figure may not be

exactly the same as if you had downloaded actual data 

for Total Trade, and so the warning message is shown just to inform you of possible

differences.

The message may also be displayed when you do an indicator calculation that requires

total trade data.

 Total Trade summed from aggregate product groups

Please note that for this indicator calculation, the Total Trade figures required were

calculated by summing from aggregate product group data, which in some cases may not

be correct.
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This warning message is displayed of you are calculating an indicator using aggregate

products.

"Aggregate Products" are products that you have loaded for broad categories such as

"Agriculture", "Oil", etc.

It is impossible for TradeSift to know whether the figures for the data you loaded

contains overlapping data, or whether the sum of the products

produces an accurate figure for total trade.

This message is displayed to alert you to the fact that the indicator results may not be

correct, if the indicator uses shares or total trade

for its calculation.

 Some required data was missing

Some of the required data was missing. See the Warnings tab for further details.

This warning is displayed when you did an indicator calculation, and some of the data

that is needed for the calculation was not found in the project.

When you make your initial data selection for an indicator, TradeSift displays the basic

countries and years that are loaded in the project, but it does

not at this stage check if every single bit of extra data that the indicator might require is

available for the selected countries.

For example, some indicators may require World-World trade data, or GDP Data.  If it

is found during the indicator calculation that some of this

data is not present in the project, this warning message will be displayed.

TradeSift will skip the indicators that it could not calculate because of the missing data,

but it will still calculate the rest.

Switch to the Warnings tab to see precise details about which required data was not

found.

 The indicator could not be calculated

The Indicator could not be calculated! See the Log tab for further details.

If this warning message is displayed, it means a serious error has occurred and the

indicator calculation failed.

This message would not be displayed just because of missing data.

Please see the Log tab for details of the error.

 Indicator Calculation Cancelled

Indicator Calculation Cancelled

This message is displayed if an indicator calculation was in progress, and you cancelled

the calculation before it was complete,
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by closing the progress dialog box.  In this case, there may not be indicator results or

they may be incomplete, so it would be

best to repeat the indicator calculation.

 All Service Codes

Warning: When 'All Service Codes' are shown, the sum of all services is more than total tr

ade. Some of the service codes overlap.

This warning is shown if you are viewing Service Data, and in the Service Group

selection, you select "All Service Codes".

With this selection, the grid will show data for every single service code, and associated

EBOPS code.

Because of the way the EBOPS classification is organised, some service codes have

trade values which overlap with other codes.

This means that the sum of the values for all the codes shown, will not be equal to the

true value for total trade (service code 200).

As a result, ranks and shares may not make sense in this mode.






